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1 Short Description 

itd Advanced Resource Planning is an add-on tightly integrated with Clarity PPM for planning hours 

and costs on individual investments or across multiple investments and managing resource pools. 

Additionally, the application offers basic project planning and a number of productivity features. 

 

Main Features 
> Plan based on investments or based on resources, roles and teams. 

> Plan for a single investment or across multiple investments. 

> Plan for custom investment types and investment hierarchies. 

> Edit allocations, hard allocations and assignments. 

> Enter workloads per resource, role and team for investments and tasks. 

> View workload sums per investment, phase, task, resource, role and team. 

> View and edit investments and team entries, projects with phases, tasks, milestones and  

dependencies as well as assignments in the interactive Gantt chart. 

> The global overview of resource, role and team utilization and capacity in color-coded numbers or 

as a graphical histogram highlights over- and underbookings. 

> The tree view displays your selection of standard fields and any custom fields per data record. 

> Filters for standard and custom fields enable you to quickly and precisely select investments, 

resources, roles, teams, team entries, tasks and assignments. 

> Edit scenario data and roadmap scenarios in the allocations modes. 

> Edit investment hierarchies. 
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2 View Modes 

itd Advanced Resource Planning supports four modes, listed in the View menu under System Views. 

 

The selected view mode determines whether allocations or assignments are displayed, and whether 

they are grouped by investments or by resources, roles and teams. 

You can customize these views, save them as custom views and share them with other users. The 

order of views in the menu is also customizable. See chapter “3 Views” on page 22 for details. 

2.1 Allocations by Investment 
The Allocations by Investment mode groups team entries of allocated resources, roles and teams 

and their allocations by associated investments. The utilization and capacity of resources, roles and 

teams are displayed in a separate view in color-coded numbers or as graphical histograms. 

 

2.1.1 Displayed Data 

In Allocations by Investment mode, the following data will be displayed: 

> Investments (custom types included) 

> Resources, roles and teams with team entries for displayed investments 

> Associated team entries and allocations or hard allocations 

> List of all resources, roles and teams, optionally with utilization and capacity (separate view) 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25). 

Displaying investment hierarchies is optional. You can toggle it in the General tab of the Preferences 

(also see "4.8.2 Selecting Investment Hierarchies in by Investment Modes" on page 30). 

See section "5.1 Displayed Data" on page 40 for details. 
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2.1.2 Displayed and Editable Values per Period 

In the Layout tab of the Preferences, you can select up to two values that will be displayed per period 

for team entries (see "Cell Configuration" on page 67). 

> Optional read-only value (small blue number at the left edge of the cell): Allocation, Hard 

Allocation, ETC, Actuals, Actuals + ETC, Requested or Capacity 

> Editable value (larger number at the right edge of the cell): Allocation or Hard Allocation; base of 

utilization and capacity (see "2.1.10 Utilization and Capacity" on page 14) 

The configured values will be displayed when hovering over the allocation grid with the associated 

preferences setting (see "9.12.7 Show Grid Hints for by Investment Views" on page 162). 

2.1.3 Displaying Trend Arrows 

Via the Visualization menu, you can toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "5.3 Displaying Trend Arrows" on page 41. 

2.1.4 Allocation, Hard Allocation and Actuals 

In the Columns tab of the Preferences, you can display or hide the Allocation, Hard Allocation and 

Actuals fields in the left hand side list (see "5.15.3 Columns" on page 61). 

See section "5.4 Allocation, Hard Allocation and Actuals" on page 127 for details. 

2.1.5 Editing Allocations 

In the upper right grid, you can see and edit the allocations for the displayed team entries. 

See section "5.5 Editing Allocations" on page 41 for details. 

2.1.6 Editing List Fields 

You can edit most fields displayed in the list. 

See section "5.6 Editing List Fields" on page 42 for details. 

2.1.7 Context Menu for Investments and Team Entries 

Hover over an investment or a team entry for a resource, role or team and click on the three dots that 

are displayed to open the associated context menu. 

> Open properties: investments and team entries (resources, roles and teams) 

> Create Requisition: team entries (resources, roles and teams) 

> Allocate From Estimates: investments and team entries (resources, roles and teams) 

> Commit Allocation: investments and team entries (resources, roles and teams) 

> Accept Hard Allocation: investments and team entries (resources, roles and teams) 

> Delete: team entries (resources, roles and teams) without actuals and associated allocations 

> Unstaff to Effective Role: team entries (resources and teams) without actuals 

> Remove lock: projects locked due to changes made in itd Advanced Resource Planning 

> Expand all: display all team entries of an investment 

> Rename: investments 

> Show candidates (by Role, OBS and Skills): team entries (roles) 

> Show Investment Team: filter resource list by investment 

See section "5.7 Context Menu for Displayed Objects" on page 44 for details. 
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2.1.8 Conversations 

The standard MUX conversations for team entries are available in itd Advanced Resources Planning 

in the Allocations by Investment and Allocations by Resource views. 

See section "5.8 Conversations" on page 46 for details. 

2.1.9 Interactive Gantt Bars 

In Allocations by Investment mode, you can toggle the display of interactive Gantt bars separately 

for investments and team entries via the Visualization menu in the toolbar. 

You can shift and resize investments and team entries via drag and drop of their Gantt bars. 

See section "5.9 Interactive Gantt Bars" on page 47 for details. 

2.1.10 Utilization and Capacity 

The lower view section displays all resources, roles and teams for which you have access rights by 

default. Roles are listed at the bottom of the list. You can filter this view to display less items. 

Optionally, the utilization and total or remaining capacity of resources, roles and teams are also 

displayed per period. 

See section "5.10 Capacity and Utilization" on page 48 for details. 

2.1.11 Allocating Resources, roles and teams via Drag-and-Drop 

Drag resources, roles or teams from the utilization view to investments or team entries to create new 

team entries or to fully or partially replace allocated resources, roles and teams. 

For roles, you can create multiple allocations in the same investment. 

See the following sections for details about these features: 

> 5.10.8 Allocating a Resource, Role or Team via Drag-and-Drop (page 49) 

> 5.10.9 Replacing a Resource, Role or Team via Drag-and-Drop (page 50) 

> 5.10.10 Creating Multi-Role Allocations (page 50) 

2.1.12 Scenario Comparison 

In the Allocations modes, the Scenario menu will be available in the toolbar if you have the Scenario 

– Navigate right and if the menu hasn't been hidden by a Clarity PPM application administrator (see 

"9.12.2 Hide Toolbar Buttons" on page 160). 

See section "5.11 Scenario Comparison" on page 52 for details. 

2.1.13 Roadmap Scenario Mode 

The roadmap scenario mode is available on roadmaps in the Modern UX. 

This view compares the current schedule of investments with the schedule of their linked edit items 

and gives you access to the In Plan property of roadmap items. Changes you make in this mode are 

partially synchronized back to the roadmap view in Clarity PPM. 

See section "5.12 Roadmap Scenario Mode" on page 55 for details. 

2.1.14 Hierarchy Mode 

The hierarchy mode is available on hierarchies in the Modern UX. 

This view lists investments in the hierarchy with their respective hierarchy levels. 

See section “5.13 Hierarchy Mode on page 56 for details. 
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2.2 Allocations by Resource 
The Allocations by Resource mode groups team entries for investments and associated allocations 

by the allocated resources, roles and teams. 

Their utilization and capacity are displayed directly in the right hand side allocation grid view. 

 

2.2.1 Displayed Data 

In Allocations by Resource mode, the following data will be displayed: 

> Resources, roles and teams 

> Investments (custom types included) with team entries of displayed resources, roles and teams  

> Associated team entries and allocations or hard allocations 

> You can limit the selection of data records via filter conditions (see"4 Filters" on page 25). 

See section "6.1 Displayed Data" on page 68 for details. 

2.2.2 Displayed and Editable Values per Period 

In the Layout tab of the Preferences, you can select up to two values that will be displayed per period 

for team entries (see "Cell Configuration" on page 89). 

> Optional read-only value (small blue number at the left edge of the cell): Allocation, Hard 

Allocation, ETC, Actuals, Actuals + ETC, Requested or Capacity 

> Editable value (larger number at the right edge of the cell): Allocation or Hard Allocation; base of 

utilization and capacity (see "2.2.10 Utilization and Capacity" on page 15) 

The configured values will be displayed when hovering over the allocation grid with the associated 

preferences setting (see "9.12.8 Show Grid Hints for by Resource Views" on page 162). 

2.2.3 Displaying Trend Arrows 

Via the Visualization menu, you can toggle the display of trend arrows for deviations of the left cell 

value from the right one, see , see "6.3 Displaying Trend Arrows" on page 69. 

2.2.4 Allocation, Hard Allocation and Actuals 

In the Columns tab of the Preferences, you can display or hide the Allocation, Hard Allocation and 

Actuals fields in the left hand side list (see "6.15.3 Columns" on page 85). 

See section "6.4 Allocation, Hard Allocation and Actuals" on page 69 for details. 

2.2.5 Editing Allocations 

In the right hand side grid, you can see and edit the allocations for the displayed team entries. 

See section "6.5 Editing Allocations" on page 69 for details. 
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2.2.6 Editing List Fields 

You can edit most fields displayed in the list. 

See section "6.6 Editing List Fields" on page 70 for details. 

2.2.7 Context Menu for Resources/Roles/Teams and Team Entries 

Hover over a resource, role or team or over a team entry for an investment and click on the three 

dots that are displayed to open the associated context menu. 

> Open properties: resources/roles/teams and team entries (investments) 

> Create Requisition: team entries (investments) 

> Allocate From Estimates: team entries (investments) 

> Commit Allocation: team entries (investments) 

> Accept Hard Allocation: team entries (investments) 

> Delete: team entries (investments) without actuals and associated allocations 

> Expand all: display all team entries of a resource, role or team 

See section "6.7 Context Menu for Displayed Objects” on page 71 for details. 

2.2.8 Conversations 

The standard MUX conversations for team entries are available in itd Advanced Resources Planning 

in the Allocations by Investment and Allocations by Resource views. 

See section "6.8 Conversations" on page 72 for details. 

2.2.9 Interactive Gantt Bars 

In Allocations by Resource mode, you can toggle the display of interactive Gantt bars for team 

entries only via the Visualization menu in the toolbar. 

You can shift and resize team entries via drag and drop of their Gantt bars. 

See section "6.9 Interactive Gantt Bars" on page 73 for details. 

2.2.10 Utilization and Capacity 

With Show Utilization in the General tab of your Preferences, the Allocation and/or Hard Allocation 

and/or the total or remaining capacity (based on the editable value Allocation or Hard Allocation) 

are displayed per period for each resource, role and team in color coded numbers.  

See section "6.10 Utilization and Capacity" on page 74 for details. 

2.2.11 Scenario Comparison and Roadmap Scenario Mode 

The scenario comparison and roadmap scenario mode are available in Allocations by Resource 

mode as well (see "2.1.12 Scenario Comparison" and "2.1.13 Roadmap Scenario Mode" on page 14). 

See sections "6.11 Scenario Comparison" on page 76 and "6.12 Roadmap Scenario Mode" on page 

79 for details. 

2.2.12 Hierarchy Mode 

The hierarchy mode is available on hierarchies in the Modern UX. 

This view lists investments in the hierarchy with their respective hierarchy levels. 

See section "6.13 Hierarchy Mode” on page 80 for details. 
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2.3 Assignments by Investment 
The Assignments by Investment mode groups resource, role and team assignments by associated 

investments. Project or custom investment phases, tasks and milestones are also displayed. 

The utilization and capacity of resources, roles and teams are displayed in a separate view in color-

coded numbers or as graphical histograms. 

This mode supports editing of project structures in an interactive Gantt chart. 

 

2.3.1 Displayed Data 

In Assignments by Investment mode, the following data will always be displayed: 

> Investments (custom types included) 

> Tasks of displayed projects and custom investment types 

> Assignments of resources, roles and teams 

> List of all resources, roles and teams, optionally with utilization and capacity (separate view) 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25) 

Displaying of phases and milestones as well as of investment hierarchies can be toggled for each in 

the General tab of the Preferences (for investment hierarchies, also see "4.8.2 Selecting Investment 

Hierarchies in by Investment Modes" on page 30). 

You can hide assignments via the Visualization menu to speed up loading of the view. 

See section "7.1 Displayed Data" on page 91 for details. 

2.3.2 Displayed and Editable Values per Period 

In the Layout tab of the Preferences, you can select an optional display value for assignments per 

period (see "Field to Display on the Left Part of the Cell" on page 124). 

> Field to Display on the Left Part of the Cell (optional): Empty (no field), ETC, Actuals, Capacity or 

a custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

> Field Displayed on the Right Part of the Cell (Assignment): In Assignments by Resource mode, 

the assignment value is always displayed on the right. This is also the base of the displayed 

utilization and capacity (see "2.3.10 Utilization and Capacity" on page 19). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.7 Show Grid Hints for by Investment Views" on page 162). 

2.3.3 Displaying Trend Arrows 

Via the Visualization menu, you can toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "7.3 Displaying Trend Arrows" on page 92. 
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2.3.4 Estimated Effort, Actuals and Total Effort 

In the Columns tab of the Preferences, you can display or hide the Estimated Effort, Actuals and 

Total Effort (Estimated + Actuals) fields in the left hand side list (see "7.15.3 Columns" on page 119). 

See section "7.5 Estimated Effort, Actuals and Total Effort" on page 93 for details. 

2.3.5 Editing Assignments and Monetary Values 

In the upper right grid, you can see and edit the Estimated Effort or a custom time scaled monetary 

value per period. See sections "7.6 Editing Assignments" on page 93 and "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95 for details. 

2.3.6 Editing List Fields 

You can edit most fields displayed in the list. 

See section "7.8 Editing List Fields" on page 96 for details. 

2.3.7 Context Menu for Displayed Objects 

Hover over an investment, phase, task, milestone or assignment and click on the three dots that are 

displayed to open the associated context menu. 

> Open properties: for investments, phases, tasks, milestones and assignments 

> Create Task: for projects, phases and tasks without any assignments  

> Autoschedule: projects  

> Allocate From Estimates: for investments and task assignments of resources, roles and teams 

> Remove lock: for projects locked due to changes made in itd Advanced Resource Planning 

> Indent Task: tasks, milestones and phases 

> Outdent Task: indented tasks, milestones and phases  

> Delete: tasks and assignments without actuals and milestones 

> Unassign to Effective Role: assignments (resources and teams) without actuals 

> Task Dependencies: for tasks and milestones of projects 

> Expand all: display full sub-structures of investments and phases 

> Rename: investments, phases, tasks and milestones 

> Show candidates (by Role, OBS and Skills): for role assignments 

> Show Investment Team: filter resource list by investment 

See section "7.9 Context Menu for Displayed Objects" on page 99 for details. 

2.3.8 Moving and Copying Tasks, Milestones and Phases 

You can change the order and hierarchy of tasks, milestones and phases via drag-and-drop. Changes 

will be directly applied without further confirmation. Hold the [Ctrl] key while executing the following 

steps to copy the selected object instead of moving it. See section "7.10.4 Moving and Copying 

Tasks, Milestones and Phases" on page 103 for details. 
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2.3.9 Interactive Gantt Bars 

In Assignments by Investment mode, you can toggle the display of interactive Gantt bars separately 

for investments, tasks, phases and milestones as well as assignments via the Visualization menu in 

the toolbar.When Gantt bars for tasks and milestones are turned on, their dependencies will also be 

displayed. Additionally, you can highlight critical paths for projects via the Visualization menu. 

Via drag-and-drop of Gantt bars, you can shift and resize non-project investments, phases, tasks and 

assignments and move milestones. You can also drag a task or milestone on another one to create a 

depedency or double-click on a dependency's arrow to edit it. 

See section "7.11 Interactive Gantt Bars" on page 105 for details. 

2.3.10 Utilization and Capacity 

The lower section of the view displays all resources, roles and teams for which you have access 

rights by default. Roles are listed at the bottom of the list. You can filter the list to display less items. 

Optionally, the total utilization and remaining capacity of these resources, roles and teams are also 

displayed per period.  

See section "7.12 Utilization and Capacity" on page 108 for details about this view. 

2.3.11 Assigning Resources, roles and teams via Drag-and-Drop 

Drag resources, roles or teams from the utilization view to tasks, non-project investments or 

assignments to assign them or to replace assigned resources, roles and teams. 

For roles, you can create multiple assignments in the same task or non-project investment. 

See the following sections for details about these features: 

> 7.12.7 Assigning a Resource, Role or Team via Drag-and-Drop (page 109) 

> 7.12.8 Replacing a Resource, Role or Team via Drag-and-Drop (page 110) 

> 7.12.9 Copying Assignments (page 110) 

> 7.12.10 Creating Multi-Role Assignments (page 111) 

2.3.12 Assignments and Allocations in Single Investment Mode 

In single investment mode, you can graphically compare assignments with the allocation or hard 

allocation of associated team entries in the histogram instead of ETC and capacity. 

See section "7.12.11 Assignments and Allocations in Single Investment Mode" on page 111 for 

details about this feature. 

See "Histogram Comparison (Single Investment Mode Only)" on page 124 for details about the 

Preferences for this feature. 

2.3.13 Hierarchy Mode 

The hierarchy mode is available on hierarchies in the Modern UX. 

This view lists investments in the hierarchy with their respective hierarchy levels. 

See section "7.13 Hierarchy Mode” on page 113 for details. 
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2.4 Assignments by Resource 
The Assignments by Resource mode groups investments, tasks and assignments by the assigned 

resources, roles and teams. 

Their utilization and capacity are displayed directly in the right hand side assignment grid view. 

Editing project structures isn't possible in this mode. 

 

2.4.1 Displayed Data 

In Assignments by Resource mode, the following data will always be displayed: 

> Resources, roles and teams 

> Investments (custom types included) with team entries for displayed resources, roles and teams 

> Associated tasks and assignments 

> Team entries without assignments 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25). 

Displaying phases and parent investment hierarchies is optional and can be toggled for each in the 

General tab of the Preferences. See section "8.1 Displayed Data" on page 126 for details. 

2.4.2 Displayed and Editable Values per Period 

In the Layout tab of the Preferences, you can select an optional display value for assignments per 

period (see "Field to Display on the Left Part of the Cell" on page 144). 

> Field to Display on the Left Part of the Cell (optional): Empty (no field), ETC, Actuals, Capacity or 

a custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

> Field Displayed on the Right Part of the Cell (Assignment): In Assignments by Resource mode, 

the assignment value is always displayed on the right. This is also the base of the displayed 

utilization and capacity (see "2.4.9 Utilization and Capacity" on page 21). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.8 Show Grid Hints for by Resource Views" on page 162). 

2.4.3 Displaying Trend Arrows 

Via the Visualization menu, you can toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "8.3 Displaying Trend Arrows" on page 127. 
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2.4.4 Estimated Effort, Actuals and Total Effort 

In the Columns tab of the Preferences, you can display or hide the Estimated Effort, Actuals and 

Total Effort (Estimated + Actuals) fields in the left hand side list (see "8.14.3 Columns" on page 141). 

See section "8.5 Estimated Effort, Actuals and Total Effort" on page 128 for details. 

2.4.5 Editing Assignments and Monetary Values 

In the right hand side grid, you can see and edit the Estimated Effort or a custom time scaled 

monetary value per period. See sections "8.6 Editing Assignments" on page 129 and 7.7 Editing 

Custom Time Scaled Monetary Values" on page 95 for details. 

2.4.6 Editing List Fields 

You can edit most fields displayed in the list. 

See section "8.8 Editing List Fields" on page 130 for details. 

2.4.7 Context Menu for Displayed Objects 

Hover over a resource, role, team, investment or task and click on the three dots that are displayed to 

open the associated context menu. 

> Open properties: resources/roles/teams investments and task 

> Add Assignment: resources/roles/teams for project tasks 

> Allocate From Estimates: resource/role/team project task assignments 

> Delete: assignments without actuals 

> Remove lock: projects locked due to changes made in itd Advanced Resource Planning 

> Expand all: display full sub-structures of roles, resources and phases 

See section "8.9 Context Menu for Displayed Objects" on page 132 for details. 

2.4.8 Interactive Gantt Bars 

In Assignments by Resource mode, you can toggle the display of interactive Gantt bars separately 

for investments, phases and assignments via the Visualization menu in the toolbar. 

In this mode, you can only shift and resize assignments via drag and drop of their Gantt bars. 

Critical paths for projects aren't available in this mode. 

Via drag-and-drop of Gantt bars, you can shift and resize assignments. 

See section "8.10 Interactive Gantt Bars" on page 133 for details. 

2.4.9 Utilization and Capacity 

With Show Utilization in the General tab of your Preferences, the utilization from assignments (with 

Calculate sums set to Filtered only from displayed assignments, else from all assignments) and the 

remaining capacity based on all assignments are displayed per period for each resource, role and 

team in color-coded numbers in the associated header row. 

See section "8.11 Utilization and Capacity" on 134 page for details. 

2.4.10 Hierarchy Mode 

The hierarchy mode is available on hierarchies in the Modern UX. 

This view lists investments in the hierarchy with their respective hierarchy levels. 

See section "8.12 Hierarchy Mode” on page 135 for details. 
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3 Views 

You can create any number of custom views based on one of the four basic system view modes 

described in the previous chapter, and share them with other users. Administrators may also save 

changes to system views and recommend views, setting them as default views for new users. 

3.1 Saved Custom View Settings 
A custom view stores all changes you make to the view, such as allocation or assignment filters, 

resource filters, the time period, most other settings in the toolbar and your Preferences. 

3.2 Filters Saved with Previous Versions 
From version 11.0.0 you can no longer save and load filter settings for the allocation, assignment 

and resource filters. These settings are now stored in custom views along with all other settings. 

When first starting itd Advanced Resource Planning 11.0.0 or a more recent version, if filters have 

been saved with an older version, they will be migrated to custom views. 

You can find these in the View menu, under the heading of the system view they are based on, with 

the previous filter's name. The view will initially be shared with all users the filter was shared with. 

For Investment views, saved allocations or assignment filters will be combined with the application’s 

default resource filter and vice versa in the associated custom views that are created. 

3.3 Views and Planning Modes 
Individual sets of views are stored for each mode available for itd Advanced Resource Planning. 

This depends on from where you open the application: 

> Global Multiple Investment Mode (global channel) 

> Single Investment Mode (investment channel) 

> Roadmap Scenario Mode (roadmap channel) 

> Hierarchy Mode (hierarchy channel) 

See section “9.7 Planning Modes” on page 152 for details about configuring the individual modes. 

3.4 Selecting a View 
You can find the following sections in the View menu, in this order. 
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> Your Favorites are always displayed on top of the list in alphabetical order. 

> Views Recommended by members of the ARP Admin group are listed next, or on top of the list if 

you have no favorites. The first recommended view is the default for new users. When you open 

itd Advanced Resource Planning again, it will load the last view you were using. 

> The default System Views are listed next, or on top of the list if you have no favorites and there 

are no recommended views. System views that you've selected as favorites or that have been 

recommended will appear in the respective list instead. 

> Any other custom views created by you or shared with you are listed next, under the heading of 

the system view they are based on. 

The icons indicate the respective view mode, as listed under System Views. 

3.5 Saving a View 
If you have made any changes to a view that can be saved, the view’s name in the View menu will 

appear in italics to indicate this, and a Save View button will appear next to the View menu. 

If you don't save the changes you have made to an unsaved view, all view settings will still be 

retained until you select another view, even if you log out and log on again. 

The Save View button will only be enabled if you have the rights to change the view: 

> Saving changes to a view is only allowed if you have created the view yourself. 

> System views may only be changed by members of the ARP Admin group. 

If you don’t have the right to change a view you want to save, open the View menu and click on the 

Save As button. 

This will open the Save View dialog. 

 

Name the new view here and select the sharing mode. 

The Specific Groups or Users option lets you select groups and/or users to share the view with. 
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3.6 Managing Views 
Click on the Manage button in the View menu to open the Manage Views dialog. 

 

Views you have created are listed under Mine. 

> Click on the star icon to add a view to the favorites or to remove it from there. 

> Click in the Name column to rename the view. 

> The Shared column shows if and with whom you have shared the view, with icons and numbers 

representing specific groups and/or users. Hover over the icon to display a list. 

> Members of the ARP Admin group may Recommend views they have created as well as views 

shared with them and system views (see below), putting them on top of the View list. 

The topmost recommended view will be the default view for new users. After the first start, the 

last used view will be selected when opening itd Advanced Resource Planning. 

> Click on the pen icon to select the sharing mode and/or groups and users to share the view with. 

> Click on the share icon to copy a link to the view into the clipboard. 

> To delete the view, click on the wastebasket icon and then confirm by clicking on the checkmark. 

Views shared with you and the four system views are listed under Shared. 

> Click on the star icon to add a view to the favorites or to remove it from there. 

> Members of the ARP Admin group may Recommend views they have created (see above) as well 

as views shared with them and system views, putting them on top of the View list. 

The topmost recommended view will be the default view for new users. After the first start, the 

last used view will be selected when opening itd Advanced Resource Planning. 

> For any views shared with them, members of the ARP Admin group can change the access 

settings via the pen icon or delete them via the wastebasket icon. 

> The four system views are always public and can't be deleted. 
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4 Filters 

This chapter describes the filter settings for the main view of itd Advanced Resource Planning. 

> 4.1 Displayed Data (page 25) 

> 4.2 Access Rights and Query Limits (page 26) 

> 4.3 Filtering the Main View (page 26) 

> 4.4 Filtering the Resource, Role and Team List (page 27) 

> 4.5 Filter, Clear and Configure (page 27) 

> 4.6 Clarity PPM Lookups (page 28) 

> 4.7 Default Investment Filters (page 28) 

> 4.8 Default Filter Fields for the Main View (page 28) 

> 4.9 Default Filter Fields for the Utilization View (page 35) 

> 4.10 Utilization and Capacity Filters (page 37) 

4.1 Displayed Data 
Depending on your view mode, the following data will be loaded and displayed without a filter: 

> Allocations by Investment 

• Any investments to which you have access (custom types included), optionally with 

investment hierarchies (see "5.1.2 Displaying Investment Hierarchies" on page 40) 

• Resources, roles and teams with team entries for displayed investments 

• Associated team entries and allocations or hard allocations 

• In the utilization view, any resources, roles and teams to which you have access 

> Allocations by Resource 

• Any resources, roles and teams with team entries for investments to which you have access 

(custom types included), optionally any resources, roles and teams to which you have access 

instead, with no investment rights required (see page 164) 

• Investments with team entries of displayed resources, roles and teams  

• Associated team entries and allocations or hard allocations 

• Team allocations of resources (allocated percentage of resource capacity) 

> Assignments by Investment 

• Any investments to which you have access (custom types included). 

• Associated tasks and optionally phases, milestones and investment hierarchies (see "7.1.1 

Displaying Phases, Milestones and Investment Hierarchies" on page 91) 

• Optionally assignments under tasks and assigned resources, roles and teams (see "7.1.2 

Displaying Assignments" on page 91) 

• In the utilization view, any resources, roles and teams to which you have access 

> Assignments by Resource 

• Any resources, roles and teams with team entries for investments to which you have access 

(custom types included), optionally only resources, roles and teams to which you have access 

instead, still requiring access rights for associated investments (see page 166) 

• Assignments under resources, roles and teams, investments, tasks, optionally phases and 

parent investment hierarchies (see "8.1.5 Displaying Phases and Parent Investment 

Hierarchies" on page 126) 

• Team entries without assignments under associated investments 
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4.2 Access Rights and Query Limits 
The amount of data that will actually be loaded is limited by your access rights and by the query 

limits entered for itd Advanced Resource Planning by an administrator via the governors lookup: 

> Access Rights: data records to which you have no access in Clarity PPM will not be displayed in 

the itd Advanced Resource Planning application either (see "9.5 User Access Rights" on page 

148). 

> Query Limits: limits for the number of resources/roles/teams, investments and assignments to 

load at the same time, entered by an administrator via the governors lookup (see "9.14.1 Query 

Limits" on page 173). If data records aren't displayed due to query limits, this will be indicated. 

4.3 Filtering the Main View 
The filter area for the main view is always displayed at the top. You can display or hide the filter area 

by clicking the little arrow button in the upper left corner of the view. 

Enter filter conditions and click on Filter to filter the view by investment, resource, role, team, team 

entry, task and assignment properties. 

 

Which filter fields are available in what order is defined per user and view in the Preferences. 

You can open the selection of available filter fields directly by clicking the Configure button on the 

filter panel. 

By default, the filter fields listed in section "4.8 Default Filter Fields for the Main View" on page 28 will 

be available for the main view. 

Members of the ARP Admin group may add other fields available for investments, investment sub-

types, resources/roles/teams, team entries, tasks and assignments to the selection of filter fields 

(see "9.11 Configuring List and Filter Fields" on page 156). Most Clarity PPM standard fields may be 

added, as well as most custom fields defined for these objects. 
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4.4 Filtering the Resource, Role and Team List 
In the by Investment modes, the Resources view is displayed below the main view, listing available 

resources, roles and teams. Click on the little arrow button in the upper left corner of this view to 

display or hide the associated filter area. 

Please note that filters entered for the main view have no effect on the Resources view. Likewise, 

filter conditions entered here have no effect on the main view. 

Without filters, the list will display any resources, roles and teams to which you have access. 

Enter filter conditions and click on Filter to flter the view. 

 

Which filter fields are available in what order is defined per user and view mode in the Preferences.  

You can open the selection of available filter fields in the Preferences directly by clicking the 

Configure button on the filter panel. 

By default, the filter fields listed in section "4.9 Default Filter Fields for the Utilization View" on page 

35 will be available for the resource, role and team list. 

Members of the ARP Admin group may add other fields available for resources, roles and teams to 

the selection of filter fields (see "9.11 Configuring List and Filter Fields" on page 156). Most Clarity 

PPM standard fields may be added, as well as most custom fields defined for these objects. 

4.4.1 Quick Filter by Investment 

Via the context menu for an investment, you can also apply a quick filter to the list, such that it only 

displays team members of that investment. 

To do this, hover over the investment's tree view item in the upper view, click on the three dots next 

to the investment name to open the context menu and select its Show Investment Team item. 

4.5 Filter, Clear and Configure 
Use the buttons at the lower left of the filter panel to apply or reset filters and configure filter fields. 

> Click on Filter to apply and hide the filter settings. 

> Click on Clear to delete all filter conditions. 

> Click on Configure to change the selection of available filter fields. 

Please note that you can no longer save filters separately, as they are now saved along with all other 

view settings. See chapter “3 Views” on page 22 for details. 
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4.6 Clarity PPM Lookups 
Some filter fields are backed by a Clarity PPM lookup. 

 This icon is available for fields that support entering a Clarity PPM user. 

Click on this to enter the "Current User" placeholder. It will be replaced by the currently logged-on 

Clarity PPM user when the filter is applied. 

 Click on the magnifier icon to access the lookup browse window for a field and select values. 

 Click on the trashcan icon to empty a field. If you only want to delete some items, click on the 

field first, select the items to remove and then click on the trashcan icon. 

All lookup filters are multi-valued and will display a second empty list box when selected. This is 

where selected values go. Investments or resources/roles/teams matching any selected value will 

be displayed. 

 

As with all lookups, a list of suggested values will be displayed when typing in the text box.  

 
Select a suggestion by clicking on it or via the arrow keys and [RETURN]. 

4.7 Default Investment Filters 
By default, the following kinds of investments will be filtered out in all view modes: 

> Project templates 

> Investments from the past 

> Inactive investments 

This applies when the associated filter fields are not displayed and is indicated in the filter panel. 

Hover over the "?" icon to display the active default filters that apply. 

4.8 Default Filter Fields for the Main View 
The following sections list and describe the filter fields available for the main view area by default. 

Please note that not all filter fields are available in all view modes and some work differently 

depending on your view mode. See the following sections for details. 

4.8.1 Default Filter Fields for Investments 

The following investment filter fields are available by default. 

How exactly these filter fields work depends on your view mode: 

> In the Allocations by Investment and Assignments by Investment modes, any investments 

selected via filters will be displayed on the top level. 

> In Allocations by Resource mode, any investments selected via filters that have team entries for 

displayed resources, roles and teams will be displayed under the resources, roles and teams they 

belong to. 
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> In Assignments by Resource mode, any investments selected via filters that have assignments 

or team entries for displayed resources, roles and teams will be displayed under the resources, 

roles and teams they belong to. 

Sub-Types: You can also filter investments by fields of investment sub-types. If you do, only 

investments of that sub-type which match the filter will be displayed. 

Hierarchies: If applicable, investment hierachies will also be displayed (see "4.8.2 Selecting 

Investment Hierarchies in by Investment Modes" on page 30). 

> Investment – Investments: select one or more investments to display. 

This is a multi-valued lookup filter. If you make a selection here, only selected investments and 

associated investment hierarchies, if applicable, will be displayed. 

 The lookup browse window lets you filter the selection of available investments by name, 

investment ID, investment type and status ("active?"). 

 Click here to remove selected values or to clear the field, if no value is selected. 

> Investment – Investment Name: enter a search term which occurs in the investment name. Use 

the asterisk character "*" as a placeholder for an arbitrary number of characters. Search terms will 

be treated as if ending with "*". (e.g., "*CRM" will find investment names containing "CRM" , while 

"CRM", without the asterisk, will find only investment names starting with "CRM"). 

> Investment – Investment ID: enter a search term which occurs in the investment id. Use the 

asterisk ("*") as a placeholder for an arbitrary number of characters. Search terms will be treated 

as if ending with "*".(e.g., "*007" will find any investment whose id contains "007", while "007", 

without the asterisk, will find only investments whose ids begin with "007"). 

> Investment – Investment Manager: filter investments by manager. This is a multi-valued lookup 

filter. If you make a selection here, only investments of selected managers will be displayed.  

 Click on this icon to enter the "Current User" placeholder. It will be replaced by the currently 

logged-on Clarity PPM user when the filter is applied. 

 The lookup browse window lets you filter the selection of available investment managers by 

last name, first name, user name, resource ID, type and status. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Investment – Investment OBS Unit: filter investments by OBS unit. 

This is a multi-valued lookup filter. If you make a selection here, only investments belonging to a 

selected OBS unit or to a sub unit of a selected OBS unit will be displayed. 

 The lookup browse window lets you select the desired OBS top level, sub levels and units. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Investment – Investment Type: filter investments by type (Application, Asset, Idea, Other Work, 

Product, Project, Service or custom investment types). 

This is a multi-valued lookup filter. If you make a selection here, only investments of selected 

types will be displayed. 

 The lookup browse window lets you filter the selection of investment types. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Investment – Investment Status: filter investments by status. This is a multi-valued lookup filter. 

If you make a selection here, only investments with selected status values will be displayed. 

 The lookup browse window lets you filter the selection of investment status values. 

 Click here to remove selected values or to clear the field, if no value is selected.  
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> Investment – Hierarchy: filter investments by hierarchy. 

This is a multi-valued lookup filter. If you make a selection here, only investments of selected 

hierarchies will be displayed. 

 The lookup browse window lets you filter the hierarchy selection by name and ID. 

 Click here to remove selected items or to clear the field, if no value is selected. 

> Investment – Roadmap: filter investments by roadmap. 

This is a multi-valued lookup filter. If you make a selection here, only investments of selected 

hierarchies will be displayed. 

 The lookup browse window lets you filter the roadmap selection by name and ID. 

 Click here to remove selected items or to clear the field, if no value is selected. 

> Investment – Hide Investments from the Past: when this filter field is displayed, select this to 

hide investments ending before the start of the previous month. 

When the filter field isn’t displayed, investments from the past won’t be displayed (as when the 

filtering option is displayed and selected). This will then be indicated by a note in the filter panel. 

> Investment – Inactive Investments (allocation filter only): in the Allocations modes, use this to 

determine whether investments deactivated via Properties - Settings – General – Active should 

be displayed. When this filter field isn’t displayed, inactive investments won’t be displayed (as 

when Hide is selected, which is also the default setting when this filter field is displayed). 

In the Assignments modes, inactive investments will never be displayed.  

Whenever this filter field isn't available or displayed, a note in the filter panel will indicate that 

inactive investments aren’t displayed. 

When the filter field is displayed, select one of the following options: 

• With the default setting Hide, inactive investments won't be displayed. 

• Select Show to display inactive investments. 

• Select Show if relevant to display inactive investments only if they have team entries that are 

partly or completely in the selected time period. 

> Project – Project Templates: determine whether to display project templates (for which 

Properties - Settings – General – Template has been selected).  

When this filter field isn’t displayed, project templates won’t be displayed (as when Hide Project 

Templates is selected, which is also the default setting when this filter field is displayed). 

This will be indicated by a note in the filter panel in this case. 

When the filter field is displayed, select one of the following options: 

• With the default setting Hide Project Templates, project templates won't be displayed. 

• Select Show All to display any investments, including project templates. 

• Select Show Only Project Templates to display only project templates and no other 

investments. 

4.8.2 Selecting Investment Hierarchies in by Investment Modes 

In the Allocations by Investment, Assignments by Investment and Assignments by Resource 

modes, you may choose to Show investment hierarchy in the General tab of the Preferences. 

This will always display parent hierarchies of any investments selected via filters. 

In the Allocations by Investment and Assignments by Investment modes, Show investment 

hierarchy will also display sub-hierarchies of selected investments and their parent investments if 

you use no other investment filters but Investments, Investment Name and Investment ID. 
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In this case, all of the following investments will be loaded and displayed: 

> Investments explicitly selected via a filter 

> Any parent investments of explicitly selected investments 

> Any sub-investments of displayed investments 

4.8.3 Default Filter Fields for Resources, roles and teams 

How exactly resource, role and team filters work depends on your view mode: 

> In Allocations by Investment mode, any resources, roles and teams selected via filters that have 

team entries for displayed investments will be displayed under the investments they belong to.  

Investments without team entries of selected resources, roles and teams will not be displayed.  

> In Assignments by Investment mode, any resources, roles and teams selected via filters that 

have assignments for displayed investments will be displayed under the investments, phases and 

tasks they belong to. 

Investments without assignments of selected resources, roles and teams will not be displayed.  

> In the Assignments by Resource and Allocations by Resource modes, any resources, roles and 

teams selected via filters will be displayed. 

By default, you can use the following fields to filter resources, roles and teams: 

> Resource – Role/Resource: only display selected resources, roles and teams.  

 The lookup browse window lets you filter the selection of available available resources, roles 

and teams by last name, first name and resource ID. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Is Role: display only roles or only resources and teams. 

With the default setting All, this filter doesn't apply 

Select Yes to only display roles. 

Select No to only display resources and teams. 

> Resource – Is Team: display only teams or only resources and roles. 

With the default setting All, this filter doesn't apply. 

Select Yes to only display teams. 

Select No to only display resources and roles. 

> Resource – Resource Name: filter by resource, role or team name. Use the asterisk ("*") to 

replace with any number of characters (e.g., "*son" will find "Harrison" and "Jackson"). Search 

terms will be treated as if ending with "*" (e.g. "Jack” will also find "Jackson”).  

> Resource – Resource Manager: filter resources and teams by resource manager. 

Roles have no resource manager and will therefore not be displayed with this filter.  

With this filter, only resources and teams of selected resource managers will be displayed. 

 Click on this icon to enter the "Current User" placeholder. It will be replaced by the currently 

logged-on Clarity PPM user when the filter is applied. 

 The lookup browse window lets you filter the selection of available resource managers by last 

name, first name, full name, resource ID and employment type. 

 Click here to remove selected values or to clear the field, if no value is selected.  
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> Resource – Booking Manager: filter roles and resources by booking manager. 

Teams have no booking manager and will therefore not be displayed with this filter.  

With this filter, only roles and resources of selected booking managers will be displayed. 

 Click on this icon to enter the "Current User" placeholder. It will be replaced by the currently 

logged-on Clarity PPM user when the filter is applied. 

 The lookup browse window lets you filter the selection of available booking managers by last 

name, first name and resource ID. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Resource OBS Unit: filter roles, resources and treams by OBS unit. 

With this filter, only investments with allocations or assignments of resources, roles and teams 

belonging to a selected OBS unit or to a sub unit of a selected OBS unit will be displayed.  

 The lookup browse window lets you select the desired OBS top level, sub levels and units. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Resource Type: filter resources, roles and teams by resource type (Equipment, 

Expense, Labor or Material). 

With this filter, only investments with allocations or assignments of resources, roles and teams of 

the selected resource types will be displayed.  

 The lookup browse window lets you select the desired resource types. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Primary Role: filter roles and resources by role, primary role and/or parent role. 

Teams have no primary role and will therefore not be displayed with this filter. 

With this filter, only investments with allocations or assignments of the following resources and 

roles will be displayed: 

• Resource Primary Role: all resources having any of the selected roles as their primary roles.  

• Role: all selected roles.  

• Role Parent Role: all roles having any of the selected roles as their parent roles.  

 The lookup browse window lets you filter the selection of available roles by role name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Skills: filter resources, roles and teams by skills. 

By default, all resources, roles and teams with at least one selected skill will be displayed. 

Alternatively, you can set the filter to require all skills to match via the Skill Matching field. 

> Resource – Skill Matching: here, you determine the mode for the skill filter, Match at least one 

skill or Match all skills. Without this filter field, the Match at least one skill mode will be used, 

such that resources, roles and teams with any selected skill will be displayed. 

> Resource – Is External: filter resources, roles and teams by the External property of resources 

(selected via Properties – General – Resource Management – External). 

• With the default setting All, any resources, roles and teams will be displayed.  

• Select Yes to display only external resources. With this setting, roles and teams won’t be be 

displayed.  

• Select No to display only roles, internal resources and teams.  

> Resource – In Assignment (assignment filter only): see following section. 

> Resource – In Task (assignment filter only): see following section. 
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4.8.4 Selecting Resources, roles and teams (Assignments by Investment) 

In Assignments by Investment mode, resources, roles and teams that are selected via the Role/ 

Resource, Is Role and Is Team filter fields and have assignments for displayed investments will be 

displayed under the investments, phases and tasks they belong to. 

If you don't filter resources, roles and teams by other fields, other phases, tasks and milestones of 

displayed investments as well as other resources, roles and teams assigned to any displayed task or 

NPIO will also be displayed. 

Investments without assignments of selected resources, roles and teams won't be displayed. 

The In Task filter will display only tasks to which resources, roles and teams selected via the Role/ 

Resource, Is Role and Is Team filters are assigned. 

The In Assignment filter will display only assignments of resources, roles and teams selected via the 

Role/Resource, Is Role and Is Team filters. 

4.8.5 Default Filter Fields for Team Entries 

The following team entry filter fields are available by default. 

> Team – Booking Status: filter team entries by booking status. This is a multi-valued lookup filter. 

If you make a selection here, only team entries with a selected booking status will be displayed.  

 The lookup browse window lets you filter the selection by booking status name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Team – Request Status: filter team entries by request status. This is a multi-valued lookup filter. 

If you make a selection here, only team entries with a selected request status will be displayed.  

 The lookup browse window lets you filter the selection by request status name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Team – Staff OBS Unit: filter team entries by staff OBS unit. This is a multi-valued lookup filter. If 

you make a selection here, only team entries belonging to any selected OBS unit or to a sub unit 

of a selected OBS unit will be displayed. 

 The lookup browse window lets you select the desired OBS top level, sub levels and units. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Team – Team Has Allocation (allocation filter only): display only team entries with planned 

and/or hard allocation in the selected time period: 

• All: don’t filter. 

• Team Has Allocation: only display team entries that have allocation. 

• Team Has Hard Allocation: only display team entries that have hard allocation. 

• Team Has Both Allocation AND Hard Allocation: only display team entries that have both 

allocation and hard allocation. 

• Team Has Allocation OR Hard Allocation: only display team entries that have either allocation 

or hard allocation. 

This filter requires Calculate Sums to be set to On or Filtered or, in Allocations by Resource only, 

Show Utilization to be selected (see "Calculate Sums" on page 83). 

In Allocations by Resource mode, an active utilization filter will be applied to this filter with 

Calculate Sums set to On or Off. Team entries with hidden utilization will then be treated as if 

they had no allocations (see "4.10 Utilization and Capacity Filters" on page 37). 
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4.8.6 Default Filter Fields for Tasks (Assignment Filter Only) 

The following task filter fields are available by default. 

> Task – Task Name: enter all or part of a task name to filter tasks. The asterisk character "*" may 

be used as a placeholder. 

> Task – Task Status: filter tasks by status. This is a multi-valued lookup filter. If you make a 

selection here, only tasks with a selected task status will be displayed. 

 The lookup browse window lets you filter the selection by task status name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

4.8.7 Default Filter Fields for Assignments (Assignment Filter Only) 

The following assignment filter fields are available by default. 

> Assignment – Assignment Role: filter assignments by assignment role. 

This is a multi-valued lookup filter. If you make a selection here, only assignments with a selected 

assignment role will be displayed. 

 The lookup browse window lets you filter the selection by assignment role name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

Please note that a resource may be assigned to a task in another than its primary role.  

> Assignment – Assignment Status: filter assignments by status. 

This is a multi-valued lookup filter. If you make a selection here, only assignments with a selected 

assignment status will be displayed. 

 The lookup browse window lets you filter the selection by assignment status name. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Assignment – Assignment Has ETC: display only assignments that have remaining ETC 

(remaining hours of work to be done) in the selected time period. 

> Assignment – Assignment Has Actuals: display only assignments for which actuals have been 

entered in the selected time period. 
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4.9 Default Filter Fields for the Utilization View 
For the resource, role and team list displayed in the by Investment modes, the same default filter 

fields are available as for filtering resources, roles and teams in the main view. 

> Resource – Role/Resource: select one or more roles, resources and/or teams to display. 

With this filter, only selected resources, roles and teams will be displayed.  

 The lookup browse window lets you filter the selection of available available resources, roles 

and teams by last name, first name and resource ID. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Is Role: display only roles or only resources and teams. 

With the default setting All, this filter doesn't apply. 

Select Yes to display only roles. Select No to display only resources and teams. 

> Resource – Is Team: display only teams or only resources and roles. 

With the default setting All, this filter doesn't apply. 

Select Yes to display only teams. Select No to display only resources and roles. 

> Resource – Resource Name: enter a search term occurring in the resource, role or team name. 

Use the asterisk ("*") to replace with any number of characters (e.g., "*son" will find "Harrison" and 

"Jackson"). Search terms will be treated as if ending with "*" (e.g. "Jack” will also find "Jackson”).  

> Resource – Resource Manager: filter resources and teams by resource manager. With this filter, 

only resources and teams of selected resource managers will be displayed. Roles have no 

resource manager and will therefore not be displayed with this filter.  

 Click on this icon to enter the "Current User" placeholder. It will be replaced by the currently 

logged-on Clarity PPM user when the filter is applied. 

 The lookup browse window lets you filter the selection of available resource managers by last 

name, first name, full name, resource ID and employment type. 

 Click on the trashcan icon to remove selected values or to clear the field, if no value is 

selected.  

> Resource – Booking Manager: filter roles and resources by booking manager. With this filter, only 

resources and roles of selected booking managers will be displayed. Teams have no booking 

manager and will therefore not be displayed with this filter.  

 Click on this icon to enter the "Current User" placeholder. It will be replaced by the currently 

logged-on Clarity PPM user when the filter is applied. 

 The lookup browse window lets you filter the selection of available booking managers by last 

name, first name and resource ID. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Resource OBS Unit: filter resources, roles and teams by OBS unit. 

With this filter, only resources, roles and teams belonging to any selected OBS unit or to a sub unit 

of a selected OBS unit will be displayed.  

 The lookup browse window lets you select the desired OBS top level, sub levels and units. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Resource Type: filter resources, roles and teams by resource type (Equipment, 

Expense, Labor or Material). 

With this filter, only resources , roles and teams of the selected resource types will be displayed.  
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 The lookup browse window lets you select the desired resource types. 

 Click here to remove selected values or to clear the field, if no value is selected.  

> Resource – Primary Role: filter roles and resources by role, primary role and/or parent role. 

Teams have no primary role and will therefore not be displayed with this filter. 

With this filter, the following resources and roles will be displayed: 

• Resource Primary Role: all resources having any of the selected roles as their primary roles. 

• Role: all selected roles. 

• Role Parent Role: all roles having any of the selected roles as their parent roles.  

 The lookup browse window lets you filter the selection of available roles by role name. 

 Click here to remove selected values or to clear the field, if no value is selected. 

> Resource – Skills: filter resources, roles and teams by skills. 

By default, all resources, roles and teams with at least one selected skill will be displayed. 

Alternatively, you can set the filter to require all skills to match via the Skill Matching field. 

> Resource – Skill Matching: here, you determine the mode for the skill filter, Match at least one 

skill or Match all skills. Without this filter field, the Match at least one skill mode will be used, 

such that resources, roles and teams with any selected skill will be displayed. 

> Resource – Is External: filter resources, roles and teams by the External resource property 

(selected via Properties – General – Resource Management – External). 

With the default setting All, any resources, roles and teams will be displayed. 

Select Yes to display only external resources. With this setting, roles and teams won’t be be 

displayed. Select No to display only roles, internal resources and teams. 

> Resource – Investment Team: filter resources, roles and teams by team entries for investments.  

Only resources, roles and teams with a team entry for a selected investment will be displayed. 

 The lookup browse window lets you filter the selection of available investments by name, 

investment ID, investment type and status ("active?"). 

 Click here to remove selected values or to clear the field, if no value is selected. 

> Ressource – Only Hierarchy Team (Allocations by Investment in Hierarchy Mode only): 

filter resources, roles and teams by team entries for investments. Only resources, roles and 

teams with team entries for investments in the hierarchy will be displayed. 

> Resource – Only with Capacity (Allocations by Investment only): When a capacity filter is active 

in Allocations by Investment mode, you can hide resources, roles and teams for which no 

availabilty is displayed with the Only with Capacity filter (see "Capacity Filter" on page 87). 

> Team – Show Team Only (single investment mode only): display only resources, roles and 

teams with team entries in the current investment. 
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4.10 Utilization and Capacity Filters 
In both Allocations modes, you can filter the utilization and capacity displayed for resources, roles 

and teams. 

4.10.1 Utilization Filter Settings 

Via the left button above the resource filter, you can switch between the utilization filter (Show 

Utilization Filter) and the regular resource filter (Show Data Filter). 

> In Allocations by Investment mode, you can find these setings in the filter panel for the utilization 

view at the bottom. 

 

> In Allocations by Resource mode, the settings are located above the filter panel for the main view 

at the top. 

 

By default, you can filter the displayed utilization by the following fields. 

> The Staff OBS filter displays utilization only for team entries with a selected Staff OBS. 

> The Investment Status filter displays utilization only for team entries belonging to investments 

with a selected Investment Status. 

Members of the ARP Admin group may add other Lookup and Boolean fields available for 

investments and team entries. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

See section "9.11 Configuring List and Filter Fields" on page 156 for details. 
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4.10.2 Capacity Filter Settings 

Click on the Utilization Settings button above the resource list to open the Utilization tab of the 

Preferences. 

Here you can enter an capacity filter by Staff OBS. This setting is independent from the utilization 

filter by the same field. With this filter, capacity will only be displayed for resources and teams with a 

selected Department OBS. This also affects associated roles. 

 

4.10.3 Effects of the Utilization and Capacity Filters 

The utilization and capacity displayed for roles include only team entries and resources matching the 

selected utilization and capacity filters. 

The remaining capacity displayed for resources, roles and teams is also based on the filtered 

utilization as displayed according to the selected utilization filter. 

The utilization and capacity filters only affect the utilization, capacity and remaining capacity 

displayed for resources, roles and teams. Resources, roles and teams not matching the utilization 

filter as well as associated team entries and allocations will still be displayed. 

4.10.4 Hiding Roles, Resources and Teams 

In Allocations by Investment mode, with an active capacity filter, you can hide resources, roles and 

teams for which no capacity is displayed using the Only with Capacity resource filter field (see "Only 

with Capacity" on page 36). 

In Allocations by Resource mode, the utilization filter will be applied to the Team Has Allocation 

filter for team entries with Calculate Sums set to On or Off. This way, you can hide resources, roles 

and teams for which no utilization is displayed (see "Team – Team Has Allocation" on page 33). 
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4.10.5 Utilization and Capacity Filter Example 

The global view shows 170 hours of allocation and an overallocation of 208 hours: 

 

The filtered view shows the allocation and capacity for the selected department and for approved 

investments only. The role is no longer overallocated: 

 

Note that no more capacity or utilization are displayed for Gillian, Erin because she doesn't belong to 

the selected department. 

In Allocations by Investment mode, with an active capacity filter, you can hide resources, roles and 

teams for which no capacity is displayed using the Only with Capacity resource filter field (see "Only 

with Capacity" on page 36). 
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5 Allocations by Investment 

The Allocations by Investment mode groups team entries of allocated resources, roles and teams 

and their allocations by associated investments. The utilization and capacity of resources, roles and 

teams are displayed in a separate view in color-coded numbers or as graphical histograms. 

 

5.1 Displayed Data 
In Allocations by Investment mode, the following data will be displayed: 

> Investments (custom investment types included) 

> Resources, roles and teams with team entries for displayed investments 

> Associated team entries and allocations or hard allocations 

> List of all resources, roles and teams, optionally with utilization and capacity (see "5.10 Capacity 

and Utilization" on page 48). 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25). 

5.1.1 Team Entry Data 

In this mode, displayed resources, roles and teams represent team entries. 

5.1.2 Displaying Investment Hierarchies 

Displaying investment hierarchies is optional and can be toggled in the General tab of the 

Preferences (see "4.8.2 Selecting Investment Hierarchies in by Investment Modes" on page 30). 

5.2 Displayed and Editable Values per Period 
In the Layout tab of the Preferences, you can select up to two values that will be displayed per period 

for team entries (see "Cell Configuration" on page 67). 

> Optional read-only value (small blue number at the left edge of the cell): Allocation, Hard 

Allocation, ETC, Actuals, Actuals + ETC, Requested or Capacity 

> Editable value (larger number at the right edge of the cell): Allocation or Hard Allocation; base of 

displayed utilization (see "5.10 Capacity and Utilization" on page 48) 

The configured values will be displayed when hovering over the allocation grid with the associated 

preferences setting (see "9.12.7 Show Grid Hints for by Investment Views" on page 162). 
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5.3 Displaying Trend Arrows 
Via the Visualization menu, you can display trend arrows comparing the left and right cell values, see 

"  Visualization > Cell" on page 58. 

 

For instance, this can help you to easily compare actuals with the originally planned values. 

Wherever both values are present and different, a little arrow at the left cell edge visualizes a negative 

or positive deviation of the left cell value from the right cell value. 

In the Layout tab of the Preferences, you can set a threshold percentage for the minimal deviation to 

visualize via arrows, see "Tolerance of Deviation" on page 67. 

5.4 Allocation, Hard Allocation and Actuals 
In the Columns tab of the Preferences, you can display or hide the Allocation, Hard Allocation and 

Actuals fields in the left hand side list (see "5.15.3 Columns" on page 61). 

The fields display the respective values for each team entry. 

With Calculate Sums enabled in the General tab of the Preferences, aggregated sums will also be 

calculated and displayed per investment. 

Depending on the Calculate Sums setting, global sums (On) or Filtered sums will be displayed, 

according to your allocation filter (see "Calculate Sums" on page 59). 

5.5 Editing Allocations 
In the right half of the allocations view, you can see and edit team entries for resources, roles and 

teams, grouped by the associated investments or by the allocated resources, roles and teams. 

Without selection of the Show Gantt Bars for Team Members option in the Visualization menu in 

the toolbar, you can enter the desired allocation values in the right hand side grid. Extending a team 

entry by entering values in grid cells outside the duration of the associated investment will also 

extend the investment such that the duration of the investment includes the team entry. 

 Changes made in the allocation grid will only be applied when you save them via the toolbar. You 

can easily identify unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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5.6 Editing List Fields 
In the left hand side hierarchic list, you can edit the Name, Investment Status, Start and Finish fields 

of investments. You can also edit the Start, Finish and Staff OBS Unit fields of team entries here. 

Most additional fields may also be made editable by members of the ARP Admin group (see "5.6.6 

Editing Additional Fields" on page 43). 

 Changes will only be applied when you save them via the toolbar. You can easily identify unsaved 

changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

5.6.1 Renaming Investments 

To rename an investment, click in the associated Name field and press [F2] or [Return]. Enter the 

desired name. Press [Return] to confirm or [Esc] to cancel. Alternatively, you can rename investments 

via the context menu. 

5.6.2 Editing the Investment Status 

You can edit the Investment Status of investments. Click in the field to select a value. 

5.6.3 Editing the Start and Finish of Investments 

You can change the duration of investments via the the Start and Finish list fields. 

If applicable, this will also change the duration of all associated team entries proportionally (e.g., 

changing the total duration from 8 to 6 weeks will reduce a team entry spanning 4 weeks to 3 

weeks). For each team entry that is changed in the process, associated planned and hard allocations 

will also be redistributed over the new duration with the same proportions as before the change. 

Therefore, shortening a team entry will raise the allocation per period while extending will lower it. 

5.6.4 Editing the Start and Finish of Team Entries 

You can change the duration of team entries via the Start and Finish list fields. 

This will redistribute associated planned and hard allocations over the new duration with the same 

proportions as before the change. Therefore, shortening a team entry will raise the allocation per 

period while extending will lower it. 

Extending a team entry beyond the associated investment's Start or Finish will also extend the 

investment, such that it includes that team entry. 

Reducing the durations of team entries won't reduce the investment's duration. 

Team entries without a Start or Finish will adopt these values from the associated investment. 

5.6.5 Editing the Staff OBS Unit of Team Entries 

You can edit the Staff OBS Unit field of team entries in the list. To do this, click in the field. 

Click on the magnifier icon to select an OBS unit or the trashcan icon to clear the field. 
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5.6.6 Editing Additional Fields 

You can also edit any additional list fields that have been made editable by members of the ARP 

Admin group (see "9.11 Configuring List and Filter Fields" on page 156). 

5.6.7 Copying List Fields 

You can copy editable field values up or down via drag-and-drop. This feature supports lookup fields 

and respects restrictions on column values. 

Copying field values this way requires the start and target row to be of the same type, i.e., investment 

or team entry. 

For investments, the investment type must also be the same, e.g., project or idea. All custom 

investment types are considered to be the same type for this feature. 
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5.7 Context Menu for Displayed Objects 
Hover over an investment or team entry to open the associated context menu. 

The following sections describe the default options available here. 

Members of the ARP Admin group can hide default options and add additional custom options (see 

"9.10 Defining Actions" on page 154). 

5.7.1 Open Properties 

The Open properties option is available in the context menu for investments and team entries. Here 

you open the associated Clarity PPM detail view. 

> Investment properties open in a new browser tab. 

> Team entry properties open on top of itd Advanced Resource Planning. 

5.7.2 Create Requisition 

The Create Requisition option is available in the context menu for team entries. Here you create a 

new requisition for the allocation of a team entry. 

This action will be directly applied without further confirmation. 

5.7.3 Allocate From Estimates 

The Allocate From Estimates option is available in the context menu for team entries. 

In Allocations by Investment mode, it is also available in the context menu for investments. 

For the selected team entry, or for all team entries of the selected investment, the estimated effort of 

associated assignments will be entered as allocation.  

This action will be directly applied without further confirmation. 

5.7.4 Commit Allocation 

The Commit Allocation option is is available in the context menu for team entries. 

In Allocations by Investment mode, it is also available in the context menu for investments. 

For the selected team entry, or for all team entries of the selected investment, the allocation will be 

entered as hard allocation. 

This action will be directly applied without further confirmation. 

5.7.5 Accept Hard Allocation 

The Accept Hard Allocation option is is available in the context menu for team entries. 

In Allocations by Investment mode, it is also available in the context menu for investments. 

For the selected team entry, or for all team entries of the selected investment, the hard allocation will 

be entered as allocation. 

This action will be directly applied without further confirmation. 

5.7.6 Delete 

The Delete option is available in the context menu for team entries without actuals. Once you select 

the Delete option, the selected team entry will instantly be deleted without further confirmation. 

5.7.7 Unstaff to Effective Role 

The Unstaff to Effective Role option is available for team entries of resources and teams without 

actuals. The team entry will be reset to its effective role. If that role already as a team entry in the 

investment, a new team entry will be created for a copy of the role. 
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5.7.8 Remove Lock 

The Remove lock option is available in the context menu of projects locked due to changes made by 

users in itd Advanced Resource Planning. 

Every user may unlock projects via the context menu that were locked due to their own changes 

made in itd Advanced Resource Planning. 

Members of the ARP Admin group may unlock any projects via the context menu that were locked 

due to changes made by any user in itd Advanced Resource Planning. 

Projects locked due to changes made outside of itd Advanced Resource Planning can only be 

unlocked via the associated button in the project's properties.  

5.7.9 Expand All 

The Expand all option is available in the context menu for investments. 

Select this to expand all associated team entries. 

5.7.10 Rename 

The Rename option is available in the context menu for investments. Press [Return] to confirm or  

[Esc] to cancel. The change will only be applied when saving via the toolbar. Refresh without saving 

to undo. 

5.7.11 Show candidates (by Role, OBS and Skills) 

The Show candidates (by Role, OBS and Skills) option is available for role team entries. 

This will apply the following filters to the Resources list, adding missing filter fields automatically: 

> Primary Role will be selected role. 

> Resource OBS Unit will be the Staff OBS Unit of the associated team entry, if selected. 

> Skills will be the skills selected for the associated team entry, if any. 

> Skill Matching will require to match all skills (alternatively, you can require to match at least one). 

5.7.12 Show Investment Team 

The Show Investment Team option is available for investments in Allocations by Investment mode.  

This filters the resource list by the selected investment, such that only that investment's team 

members are displayed. 
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5.8 Conversations 
The standard MUX conversations for team entries are available in itd Advanced Resources Planning 

in the Allocations by Investment and Allocations by Resource views. 

Clicking on a team entry in either of the Allocations by Investment or Allocations by Resource views 

adds a small Details button at the top right side of the view. 

 

This button opens a conversation panel for this team entry only. 
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5.9 Interactive Gantt Bars 
In Allocations by Investment mode, you can toggle the display of Interactive Gantt bars separately 

for investments and team entries via the Visualization menu in the toolbar. 

5.9.1 Gantt Bars for Investments 

Gantt bars for investments will be displayed when selecting Show Gantt Bars for Investments in the 

Visualization menu in the toolbar. 

When Gantt bars for investments are displayed, you can shift or resize them via drag-and-drop. 

Changes made to investments will also be applied to all associated team entries, even if they aren't 

displayed. Shifting an investment will shift all associated team entries accordingly. Resizing an 

investment will resize all associated team entries proportionally (e.g., reducing an investment's 

duration from 8 to 6 weeks will reduce an associated team entry from 4 weeks to 3 weeks). 

This will also redistribute the allocation values displayed per period for associated team entries, 

planned or hard, over the capacity of the respective resource, role or team during the new duration 

with the same proportions as before the change. 

5.9.2 Gantt Bars for Team Entries 

Gantt bars for team entries will be displayed when selecting Show Gantt Bars for Team Members in 

the Visualization menu in the toolbar. 

While Gantt bars are displayed for team entries, you can't edit the planned or hard allocation values 

displayed per period directly. 

You can shift and resize team entries via drag and drop of their Gantt bars. 

This will redistribute the allocation values displayed per period for the respective team entry, planned 

or hard, over the capacity of the respective resource, role or team during the new duration with the 

same proportions as before the change. 

Shifting or extending a team entry beyond the associated investment's Start or Finish will also 

extend the investment, such that it includes the team entry. 

Reducing the durations of team entries won't reduce the investment's duration. 

Team entries without a Start or Finish will adopt these values from the associated investment. 

5.9.3 Saving or Reverting Changes 

Changes made to Gantt bars won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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5.10 Capacity and Utilization 
In Allocations by Investment mode, the lower view section displays all resources, roles and teams 

for which you have access rights by default. Roles are displayed at the bottom of the list. 

You can select resource fields to display in the Utilization – Columns tab of your Preferences (see 

"5.15.4 Utilization – Columns" on page 62. 

You can filter this view (see "5.10.6 Filtering the View" on page 49). 

Optionally, the utilization and capacity, based on allocations, are also displayed. 

 

5.10.1 Visualization: Color-Coded Grid or Histogram 

There are two display modes available for the utilization. In both modes, the displayed utilization is 

based on the editable value from allocations, Allocation or Hard Allocation. 

> With Show Utilization selected in the General tab of the Preferences, the total utilization and 

remaining capacity of the displayed resources, roles and teams will be displayed per period in a 

grid of numbers that are color coded to display low or high utilization. 

Cell colors indicate low (white), optimal (green), high (yellow) or very high (red) utilization of a 

resource, role or team in a period (see "5.15.7 Utilization" on page 65). 

> Alternatively, via Show Histogram in the Visualization menu in the toolbar (regardless of Show 

Utilization), you can display the utilization and capacity as a histogram chart. The chart displays 

the utilization as a colored stack which is matched against a dotted capacity line. 

As in the grid view, signal colors indicate optimal utilization or overload. 

However, only the utilization warning and high utilization thresholds take effect in the histogram: 

• The dotted horizontal line displays the resource, role or team capacity. 

• Workload below the utilization warning threshold is colored green. 

• Further workload between the utilization and high utilization thresholds is colored yellow.  

• Further workload above the high utilization threshold is colored red. 

• The low utilization threshold has no effect here (see "5.15.7 Utilization" on page 65). 

5.10.2 Resource Fields 

When using the grid, you can configure the left and right hand side values in the Utilization tab of 

your Preferences (see "5.15.7 Utilization" on page 65). 

Available values: [Total] Capacity, Remaining [Capacity], Allocation and Hard Allocation. 

The remaining capacity is based on the total capacity minus the editable value, Allocation or Hard 

Allocation. 
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5.10.3 Utilization, Remaining Capacity and Role Capacities 

In this mode, both the utilization and remaining capacity are based on the editable value (Allocation 

or Hard Allocation, see "5.2 Displayed and Editable Values per Period" on page 40), and are not 

affected by the allocation filter. 

For the displayed utilization and capacity, separate utilization and capacity filters are available (see 

"4.10 Utilization and Capacity Filters" on page 37 for details and an example). 

Role capacities may include sub-role capacities (see "Role Capacity Calculation" on page 65) and 

may be total or remaining (see "9.12.18 Show Total Role Capacity in Utilization Panel" on page 167, 

grid view only, doesn't apply to histogram). 

5.10.4 Team Utilization 

For a resource allocated to a team, that allocation is included as a percentage of the resource’s 

capacity as entered in the team (e.g., if a resource is allocated to a team with 50%, in a week where 

that resource has an capacity of 40 hours, an allocation of 20 hours will be included for the team). 

5.10.5 Displaying Utilization and Capacity Details 

Hover over a grid cell or histogram segment to display the associated values. Click on a grid cell or 

histogram segment to display the associated investments. Click on a column header to filter the list. 

Select the columns to display in your preferences, see "5.15.4 Utilization – Columns" on page 62. 

5.10.6 Filtering the View 

Without a filter, any resources, roles and teams for which you have access rights will be displayed. 

Roles are listed at the bottom of the list. 

> Section "4.4 Filtering the Resource, Role and Team List" on page 27 describes how you filter the 

resource list to show only specific resources, roles and teams. 

> Use the Show Investment Team quick filter in an investment's context menu to only display 

associated team members. 

> Use the utilization and capacity filters to filter the utilization and capacity displayed for resources, 

roles and teams. This also affects utilization level colors and histograms. 

See "4.10 Utilization and Capacity Filters" on page 37 for details and an example. 

5.10.7 Selecting a Resource, Role or Team 

When you select a team entry in the left hand side hierarchic list in the upper view section, the 

associated resource, role or team will also be selected in the utilization view. 

5.10.8 Allocating a Resource, Role or Team via Drag-and-Drop 

You can create a new team entry by dragging a resource, role or team from the utilization view on an 

investment. When the Gantt chart is not displayed, you can then enter the planned or hard allocation 

for that team entry. 

 Team entries and allocations will only be created when saving via the toolbar. You can easily 

identify unsaved team entries via the red triangle.  

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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5.10.9 Replacing a Resource, Role or Team via Drag-and-Drop 

Drag a resource, role or team from the utilization view on an existing team entry to replace the 

allocated resource, role or team. 

If you drag a resource or team on a role allocation, a menu will open offering Replacement Options: 

> Total Capacity always gives the resource or team the full allocation, even if it becomes over-

allocated in the process. 

> Remaining Capacity only allocates the resource or team to their remaining capacity. The 

allocation distributed this way is deducted from the role's team entry. 

Please note that the Replacement Options menu will always open, even if the resource or team won't 

become over-allocated when selecting Total Capacity. 

The following feature toggles apply to this feature: 

> The two replacement modes can be deactivated individually, see "9.12.19 Disable Replacement 

Options" on page 167. 

> You can deactivate the replacement of role allocations, see "9.12.20 Disable Role Allocation 

Replacement" on page 167. 

> When replacing role allocations with Remaining Capacity, you can determine that the role’s team 

entry is retained, see "9.12.21 Don't Replace Role With Remaining Capacity" on page 168. 

 Team entries and allocations will only be created when saving via the toolbar. You can easily 

identify unsaved team entries via the red triangle.  

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

5.10.10 Creating Multi-Role Allocations 

Like in Allocations by Investment mode, you can allocate a role to the same investment multiple 

times via dra-and-drop, copying the role with an index (e.g., "Architect" becomes "Architect (2)".) 

> Drag the role from the resource list onto the investment. 

> If the role already has a team entry in the investment, you will be prompted to create a new team 

entry for a copy of the role. 

 

You can deactivate this dialog, such that multiple role allocations will automatically create new team 

entries for role copies (see "9.12.28 Automatically Create New Team Entries for Roles" on page 170). 

 Team entries and allocations will only be created when saving via the toolbar. You can easily 

identify unsaved team entries via the red triangle.  

 Refresh the view without saving to revert your changes. 
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 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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5.11 Scenario Comparison 
In both Allocations modes, the Scenario menu is available in the toolbar if you have the Scenario – 

Navigate right and if the menu hasn't been hidden by a Clarity PPM application administator (see 

"9.12.2 Hide Toolbar Buttons" on page 160). 

In the Scenario menu, you have access to all scenarios for which you have the View right. You can 

edit data in any scenario for which you have the Edit right. 

Investment rights are not required, but shifting and resizing investments with hard allocations in this 

mode requires the Resource – Hard Book right for all associated resources. 

The Excel export isn't available in scenario mode. 

 

5.11.1 Scenario Menu Features 

The scenario menu in the toolbar offers the following features. 

> Select a scenario to compare with the plan of record. 

> Deselect a selected scenario to end the scenario comparison. 

> Via the Scenario menu, you can also create new scenarios or open the scenario manager. 

See section "5.14.5 Scenario" on page 58 for details about these features. 

5.11.2 Visualization and Editing in Scenario Comparison Mode 

While the comparison is active, team entries are displayed in a two row layout: 

 

> The first row displays the plan of record data, which you can not edit in comparison mode. 

> The second row displays the associated data in the compared scenario. In comparison mode, 

you can only edit scenario data: the Investment Status, Start and Finish of an investment (see 

following section for details), the Start and Finish of a team entry and, without Show Gantt Bars 

for Team Members in the Visualization menu, the associated Allocation per period. With Show 

Gantt Bars for Team Members in the Visualization menu, you can change the start and duration 

of team entries via drag-and-drop in the Gantt chart, with the same effect as changing the Start 

and Finish fields in the list. 

The Hard Allocation per period is read-only in scenarios in Clarity PPM and displays the 

commited plan of record values. You cannot change these values in a scenario. 
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5.11.3 Transferring Investments and Team Entries to a Scenario 

Initially, investments exist only in the plan of record. Change the Investment Status in an 

investment's second row or the Start, Finish or Allocation per period in a team entry's second row to 

copy the associated investment with all team entries to the scenario. 

> You can change the Investment Status in Allocations by Investment mode only, and you can set 

it to Approved or Unapproved only in a scenario, provided these values are available. 

> Team entries added to an investment after that investment has been added to a scenario will not 

be available in the scenario. 

> Investments and team entries deleted in the plan of record will also be deleted in all scenarios in 

which they exist, even if differences have been entered for them in a scenario. 

While the comparison is active, you can only edit the copies of team entries created in the scenario. 

 

Changes made to the Start, Finish, Investment Status or Allocation per period are highlighted in light 

blue. Allocations are summed up on the top level (investment or role/resource/team). Where 

changes exist, as opposed to the plan of record, they will also be highlighted in light blue on this level. 

Additionally, the Gantt bars for investments and team entries will also be highlighted in light blue 

when the Start, Finish or total Allocation change as opposed to the plan of record. 

Changing the Start and Finish of an investment via the list or Gantt chart will also affect associated 

team entries if applicable. 

Extending a team entry beyond the Start or Finish of the associated investment will also extend the 

investment, such that it includes that team entry. Reducing the durations of team entries won't 

reduce the investment's duration. Team entries without a Start or Finish will adopt these values from 

the associated investment. Changing the duration of a team entry will redistribute its allocation 

values with the same proportion as before the change. 

 Any changes you make to scenario data in this mode will only be applied when you save them via 

the toolbar. You can easily identify unsaved changes via the red triangle in a field.  

 Refresh the view without saving to revert your changes. 
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5.11.4 Utilization View 

The following specifics apply to the utilization view while scenario comparison is active. 

> In Allocations by Investment mode, while the scenario comparison is active, the resource 

utilization view includes scenario data where they exist. 

• Team entries of investments that don't exist in the compared scenario and associated 

allocations will be loaded from the plan of record. 

• Team entries of investments existing in the compared scenario and associated allocations will 

be loaded from that scenario. 

> The utilization and capacity filters are applied here as well. See section "4.10 Utilization and 

Capacity Filters" on page 37 for details and an example. 

> In Allocations by Investment mode, while the scenario comparison is active, you can’t add team 

entries to investments via drag-and-drop of resources, roles and teams from the utilization view. 

5.11.5 Context Menu 

In Allocations by Investment mode, while the scenario comparison is active, the context menu offers 

only the following options. 

> Open properties: investments and team entries (resources, roles and teams) 

> Expand all: display all team entries of an investment 
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5.12 Roadmap Scenario Mode 
Please note that the roadmap scenario mode feature is only available after adding an itd Advanced 

Resource Planning channel to the roadmap blueprint (see "9.7 Planning Modes” on page 152). 

With the roadmap scenario mode, roadmaps offer an itd Advanced Resource Planning tab, which 

shows a capacity scenario for the currently selected roadmap scenario in its Allocations modes: 

 

This view compares the current schedule of investments with the schedule of their linked roadmap 

items. Additionally, you can filter by, display and edit the In Plan property of roadmap items, and you 

can filter the utilization by the In Plan field in this mode with the standard utilization filter feature. 

> The itd Advanced Resource Planning application in this view is automatically filtered (in addition 

to any manually entered filters and automatic standard filters such as Hide investments from the 

past) and includes any investments linked to roadmap items in the selected roadmap scenario. 

> In the Allocations modes, the scenario mode (see previous section) is always active. 

> The capacity scenario is initially created when first opening the view for a specific roadmap 

scenario and is then linked to that roadmap scenario. 

Reopening the view for a roadmap scenario for which a capacity scenario already exists will load 

that capacity scenario. 

Capacity scenarios are shared among all users and are updated with changes saved by any user. 

> Investments in the capacity scenario are synchronized with their linked roadmap items in the 

roadmap scenario, such that any changes you save for an investment’s Start or In Plan field in 

the capacity scenario affect its linked roadmap item in the roadmap scenario and vice versa. 

• The investment’s Start date in the capacity scenario is equal to and synchronized with its 

linked roadmap item’s start date. 

The investment’s Finish date is shifted according to its duration, both of which are not linked 

to the roadmap item. 

Any associated team entries are shifted accordingly in the capacity scenario. 

Shifting and resizing roadmap items linked to investments with hard allocations in this mode 

requires the Resource – Hard Book right for all associated resources. 

• The In Plan value in the capacity scenario is equal to and synchronized with its linked 

roadmap item’s In Plan value. 

• Any changes made to allocations in the capacity scenario are synchronized back to Clarity 

PPM and show up under Capacity. 

Please note that capacity changes made in Clarity PPM won’t be synchronized back to the 

capacity scenario. 

> Any changes saved to the capacity scenario are restored when you or another user reopens the 

view for the same roadmap scenario, including changes not affecting linked roadmap items. 
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5.13 Hierarchy Mode 
You can integrate itd Advanced Resource Planning in the Hierarchies module for hierarchies of the 

Investment type. 

Please note that the hierarchy mode feature is only available after adding an itd Advanced Resource 

Planning channel to the hierarchy blueprint (see "9.7 Planning Modes” on page 152). 

With the hierarchy mode, hierarchies offer an itd Advanced Resource Planning tab. 

 

In this mode, the view is automatically filtered to display only investments included in the hierarchy. 

You can display and sort by the Hierarchy Level field, which displays an investment’s hierarchy level. 

With the Resource – Only Hierarchy Team filter, the lower list will only display resources, roles and 

teams allocated to investments in the hierarchy via team entries. 

Please note: This mode is currently in the beta phase and is included as a preview. Further features 

are planned. We look forward to receiving feedback on this mode. 
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5.14 Toolbar Features 
In Allocations by Investment mode, you have access to the following features in the toolbar. 

5.14.1 View 

The View menu at the top left displays the active view and allows switching views, saving the current 

view under a new name and editing your favorites and view sharing settings under Manage. 

If you have the right to save changes to the current view, the Save View button is active. If it isn't, you 

can still save a copy of the current view. 

You can find details of the features available here under "3 Views" on page 22. 

5.14.2 Display Period 

To the right of the View menu, you have access to various controls for changing the display period. 

The slice period and number of slices are saved with the view and are synchronized with the 

Timeslices tab of the Preferences (see "5.15.2 Timeslices" on page 60). 

Most options available there are also available in the toolbar, with the exception of fiscal periods as 

slice periods. 

The start date won't be saved. The view automatically starts with the current date. 

 Previous Periods: Here you switch back by the selected display period (e.g., 6 months). 

 Previous Period: Here you switch back by the selected slice period (e.g., 1 month). 

 Slice Period and Number of Slices: Select the slice period (e. g, months) and enter the number of 

slices in the field or use the buttons to raise or lower the number. 

Then click on Show to update the view with the new slice settings. 

 Jump to a Certain Date: Here you select the view's start date in a calendar view. 

 Next Period: Here you switch ahead by the selected slice period (e.g., 1 month). 

 Next Periods: Here you switch ahead by the selected display period (e.g., 6 months). 

5.14.3 Refresh and Save 

Use the Refresh and Save buttons to discard or save your changes. 

 Refresh: This will reload all data. If there are unsaved changes, you will be asked if you want to 

save first. Answering no will discard your changes. 

 Save: This will save all unsaved changes you have made in the current view. 

5.14.4 Export to Excel 

You can export all rows and columns of the upper view to Microsoft Excel. 

 Export to Excel: Here you export the upper view to Microsoft Excel. 

The data will be exported as displayed, with the same filter settings and with all rows and 

columns that are currently displayed. For list entries with sub-elements, these sub-elements will 

only be exported if their parent item has been expanded, such that they are currently visible. 

The Excel export is limited to a maximum of 15,000 rows and isn't available in scenario mode. 
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5.14.5 Scenario 

The scenario mode is available with the Scenario – Navigate right if the menu hasn't been hidden by 

a Clarity PPM application administator (see "9.12.2 Hide Toolbar Buttons" on page 160). 

The Excel export isn't available in scenario mode. 

See section "5.11 Scenario Comparison" on page 52 for details about the scenario mode. 

 Scenario: Here you activate or deactivate the scenario mode. You can start with an existing 

scenario or create a new scenario. 

 Select or Deselect a Scenario: In the Scenario menu, all scenarios you have access to are 

available for selection. Select a scenario to start the scenario comparison. Deselect the active 

scenario to end the scenario comparison. 

 New Scenario: Here you create a new scenario. Enter the name for the new scenario in the 

toolbar. Click on the check mark to confirm or click on the X to cancel. 

If you confirm, the new scenario will be directly selected and the comparison will be started. 

 Manage Scenarios: Here you open the Clarity PPM default scenario manager view. 

In this view, you can view, edit, add or delete scenarios. You can also set the Current and 

Compare flags, which won't affect itd Advanced Resource Planning. 

5.14.6 Visualization 

In Allocations by Investment mode, you have access to the following options under Visualization. 

 Visualization > Cell: Here you toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "5.3 Displaying Trend Arrows" on page 41. 

 Visualization > Gantt Bars: Here you toggle the display of Gantt bars for investments and team 

entries, see "5.9 Interactive Gantt Bars" on page 47. 

 Visualization > Utilization 

 Show Histogram: Here you switch between the two display modes for the utilization and 

capacity of resources, roles and teams, see "5.10 Capacity and Utilization" on page 48. 

5.14.7 Preferences 

 Preferences: Here you configure other view settings such as display fields and filter fields, see 

"5.15 Preferences" on page 59. Preferences will be saved separately for each view. 

5.14.8 Help 

 Help: Here you can find information about itd Advanced Resource Planning and about asking for 

support. If you do, please always specify your version, which you can find under Info. 

5.14.9 Fullscreen 

 Fullscreen: In full screen mode, the Clarity PPM navigation will be hidden, such that more items 

can be displayed in itd Advanced Resource Planning. 

You can turn the navigation back on using the same button. 
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5.15 Preferences 
Click on the Preferences button in the toolbar to edit view options. 

5.15.1 General 

Settings in the General tab control the display and behavior of the current view. 

 

> Toolbar Only with Icons: select this to hide the captions on buttons with icons, reducing the width 

of the toolbar.  

> Show Utilization: when the histogram isn't displayed, this setting controls whether the utilization, 

total and/or remaining capacity of resources, roles and teams are displayed per period in the 

resource list. 

> Calculate Sums: select this to display totals of the workload fields (in the allocation modes: 

Allocation, Hard Allocation and Actuals) for all aggregation levels (in this mode: per investment). 

You can choose between On (display global sums), Filtered (apply allocation filter to global sums) 

and Off (don't calculate sums). 

This setting affects the loading time, with Off being the fastest and Filtered the slowest method. 

The Team has Allocation filter (see page 33) is only available when you set this to On or Filtered 

Show Team Entries of Inactive Resources: display or hide team entries of inactive resources. 

> Load Data on Startup: specify here whether data is loaded directly when opening itd Advanced 

Resource Planning or only after clicking the filter button. 

> Show Investment Hierarchy: in Allocations by Investment mode, select this to display parent and 

sub-investments of investments explicitly selected via your allocation filter (see "4.8.2 Selecting 

Investment Hierarchies in by Investment Modes" on page 30). 

Hiding investment hierarchies may speed up loading the view. 
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5.15.2 Timeslices 

Settings in the Timeslices tab control the time axis scale and display period. 

 

> Slice Period: enter the planning period here. Possible settings are Days, Weeks, Months, 

Quarters, Calendar Years and, if configured, Fiscal Period. 

The selection of available slice periods may be limited by Clarity PPM application administrators 

via the itd AE Preferences lookup (see "9.12.3 Restrict Time Slice Periods in the Preferences and 

in the Toolbar" on page 161). In this case, only options enabled via the associated lookup value 

will be available here and in the toolbar of itd Advanced Resource Planning. 

> Fiscal Entity and Fiscal Period: with the Fiscal Period setting, if multiple fiscal entities or periods 

have been defined in your Clarity PPM system, select the desired fiscal entity and period here. 

> Work Effort Unit: specify the unit for efforts here. By default, the System Standard will be applied. 

Alternatively, Hours, Days or full time equivalents (FTE) are available for selection here. 

> Slice Count: enter the amount of slices to be displayed. 

> Decimal Places: enter the desired number of decimals for entering and displaying assignments 

and allocations. 



itd Advanced Resource Planning 12.2.0 

Allocations by Investment 

 61 

5.15.3 Columns 

In the Columns tab, you select the columns to display in the list at the top left of the current view. 

 

The following fields are always displayed in the first column: 

> Name (investment, resource/role/team) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following fields can be selected for display by default: 

> Actuals, Allocation, Hard Allocation (investment, team entry): worked, planned and booked 

hours for investments (first level), or team entries (second level) 

> Default Allocation (team entry): editable; this applies in periods during the team entry where no 

allocation segments have been defined. 

> Effective Role (team entry): resource, role or team investment role 

> ID (investment) 

> Investment Status (investment): editable 

In scenario mode, you can change this field for investments in the scenario.  

> Investment Type (investment) 

> Skills (role team entry): editable; only with skills hierarchy, see "9.12.6 Use Old Skills Hierarchy" on 

page 162. 

> Staff OBS Unit (team entry): editable 

> Start, Finish (investment, team entry): investment or team entry duration. 

In scenario mode, you can change these fields for investments and team entries in the scenario. 

 

Members of the ARP Admin group may add to the selection and enable editing for other fields 

available for investments, investment sub-types, resources, roles, teams and team entries. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

See section "9.11 Configuring List and Filter Fields" on page 156 for details. 
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5.15.4 Utilization – Columns 

In the Utilization – Columns tab, you select the columns to display in the utilization view’s resource 

list at the bottom left and in the capacity popup that opens when clicking on a utilization segment. 

 

The following information is always displayed in the first column of the resource list: 

> Icon (resource/role/team) 

> Name (resource/role/team) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following additional resource list fields can be selected by default: 

> Department (resource/team) 

> Department OBS, Location (resource/team) 

> Is External (resource/role/team) 

> Manager (resource/role/team) 

> Skills (resource/role/team) 

The following information is always displayed in the capacity popup: 

> Type Icon and Name (investment) – first column 

> Segment Utilization (allocations) – last column 

The following additional team entry fields can be selected for the capacity popup by default: 

> Start, Finish (team entry) 

> Staff OBS Unit (team entry) 

> Default Allocation (team entry) 

> Effective Role (team entry) 

> Skills (role team entry) only with skills hierarchy, see "9.12.6 Use Old Skills Hierarchy", page 162. 

Members of the ARP Admin group may add other fields available for resources, roles and teams or 

for team entries to these selections. This includes most Clarity PPM standard fields and most 

custom fields defined for these objects. See "9.11 Configuring List and Filter Fields" on page 156. 
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5.15.5 Filter – Allocations 

In the Filter – Allocations tab, you select filter fields for the allocation filter. This lets you filter the 

current view by investments, resources/roles/teams and team entries. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See "4.8 Default Filter Fields for the Main View" on page 28 for details about the default filter fields. 

Members of the ARP Admin group may add to the selection other fields available for investments, 

investment sub-types, resources, roles, teams and team entries. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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5.15.6 Filter – Resources 

In the Filter – Resources tab, you select filter fields for the resource panel. This lets you filter the 

displayed resources, roles and teams. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See section "4.9 Default Filter Fields for the Utilization View" on page 35 for details about supported 

default filter fields. 

Members of the ARP Admin group may add to the selection other fields available for resources, roles 

and teams.  

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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5.15.7 Utilization 

Settings in the Utilization tab control the display and calculation of the utilization. 

In Allocations by Investment mode, the utilization will be calculated from allocations. 

 

> The Utilization Rate controls the visualization of low or high utilization. 

• Low Utilization at and Below: upper utilization boundary below which resources, roles and 

teams will be marked as lowly utilized with a grey background in the respective period. 

Utilization between the thresholds for low utilization and utilization warning (e.g., above 80% to 

100% as according to the screenshot) will be marked as optimal with a green background. 

This threshold value has no effect in the histogram. 

• Utilization Warning Above: lower utilization boundary above which resources, roles and teams 

will be marked as slightly over-utilized with a yellow background in the respective period. This 

applies as long as the utilization stays at or below the lower boundary for high utilization. 

In the histogram, workload is colored green up to this threshold value. 

• High Utilization Above: lower boundary above which resources, roles and teams will be 

marked as highly over-utilized with a red background in the respective period. 

In the histogram, workload is colored yellow up to this threshold value and red above. 

> The Capacity Filter by Staff OBS Unit is applied to the capacity displayed for resources, roles and 

teams, such that only resources and teams with a selected Department OBS will be displayed as 

available and included in the capacity of associated roles. 

Additionally, you can filter the utilization. See "4.10 Utilization and Capacity Filters" on page 37. 

> The Role Capacity Calculation option is only available after activation by a CA PPM application 

administrator via the itd AE Preferences lookup settings (see "9.12.17 Include Sub-Roles in Role 

Capacity” on page 166). It controls the inclusion of sub-roles when calculating role capacities. 

Under Calculate Capacity of Roles Based On, select: 

• All Role Owners (Standard): in the default setting, the capacity of a role is calculated based 

only on associated resources. 

• All Role Owners and Sub-Roles: select this option to include the capacities of sub-roles in the 

calculation of a role’s capacity. 
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> Under Non-Histogram Mode, you can configure the left and right hand side values in the 

utilization grid that is displayed when the histogram is turned off. 

Available values: 

• Capacity 

• Remaining 

• Allocation 

• Hard Allocation 

Remaining is the Capacity minus the editable value, Allocation or Hard Allocation. 
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5.15.8 Layout 

Settings in the Layout tab control the display values and the editable value for allocations in the right 

hand side allocation grid as well as sorting fields for investments and team entries. 

 

> Cell Configuration: here you configure the values used in the right hand side allocation grid. 

The displayed utilization is always based on the editable value. 

• Field to Display on the Left Part of the Cell (Read Only): Empty, Allocation, Hard Allocation, 

ETC, Actuals, Actuals + ETC, Requested or Capacity 

• Field to Display on the Right Part of the Cell (Editable): Allocation or Hard Allocation 

• Tolerance of Deviation: Treshold value for displaying trend arrows to indicate a deviation of 

the left cell value from the right one when activated via Visualization. 

The left hand side sum columns (Allocation, Hard Allocation, Actuals) can be displayed or hidden 

via the Columns tab (see "5.15.3 Columns" on page 61). 

To display aggregated totals for investments in the allocation grid and sum columns, set 

Calculate Sums to On or to Filtered in the General tab (see "Calculate Sums" on page 59). 

> Sorting: In addition to the fields listed here, any custom fields without lookups are available. If you 

don't select the respective default field, items will be sorted by that field on the second level. 

• Sort Investments By: Investment Type or Name (Default). 

• Sort Team Entries By: Effective Role, Finish Date, Name (Default) or Start Date. 

> Browser Specific Layout Configuration: Here you can select to Use Colors with Higher Contrast. 

This setting will affect all your views in itd Advanced Resource Planning. 
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6 Allocations by Resource 

The Allocations by Resource mode groups team entries for investments and associated allocations 

by the allocated resources, roles and teams. 

Their utilization and capacity are displayed directly in the right hand side allocation grid view. 

 

6.1 Displayed Data 
In Allocations by Resource mode, the following data will be displayed: 

> Resources, roles and teams 

> Investments (custom types included) with team entries of displayed resources, roles and teams  

> Associated team entries and allocations or hard allocations 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25). 

6.1.1 Show Utilization 

With the Show Utilization option selected in the General tab of the Preferences, the utilization, total 

and/or remaining capacity of a resource, role or team will be displayed in the associated row (see 

"6.10 Utilization and Capacity" on page 74).  

6.1.2 Team Entry Data 

In this mode, displayed investments represent associated team entries. 

The Start and Finish fields displayed for a resource, role or team indicate the earliest start and 

lastest finish of associated team entries. 

6.2 Displayed and Editable Values per Period 
In the Layout tab of the Preferences, you can select up to two values that will be displayed per period 

for team entries (see "Cell Configuration" on page 89). 

> Optional read-only value (small blue number at the left edge of the cell): Allocation, Hard 

Allocation, ETC, Actuals, Actuals + ETC, Requested or Capacity 

> Editable value (larger number at the right edge of the cell): Allocation or Hard Allocation; base of 

displayed remaining capacity (see "6.10 Utilization and Capacity" on page 74) 

The configured values will be displayed when hovering over the allocation grid with the associated 

preferences setting (see "9.12.8 Show Grid Hints for by Resource Views" on page 162). 
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6.3 Displaying Trend Arrows 
Via the Visualization menu, you can display trend arrows comparing the left and right cell values, see 

"Visualization > Cell" on page 82. 

 

For instance, this can help you to easily compare actuals with the originally planned values. 

Wherever both values are present and different, a little arrow at the left cell edge visualizes a negative 

or positive deviation of the left cell value from the right cell value. 

In the Layout tab of the Preferences, you can set a threshold percentage for the minimal deviation to 

visualize via arrows, see "Tolerance of Deviation" on page 89. 

6.4 Allocation, Hard Allocation and Actuals 
In the Columns tab of the Preferences, you can display or hide the Allocation, Hard Allocation and 

Actuals fields in the left hand side list (see "6.15.3 Columns" on page 85). 

The fields display the respective values for each team entry. 

With Calculate Sums in the General tab of the Preferences, aggregated sums will also be calculated 

and displayed per resource, role and team. Depending on the Calculate Sums setting, global (On) or 

Filtered sums will be displayed, according to your allocation filter (see "Calculate Sums" on page 83). 

In Allocations by Resource mode, Show Utilization will also calculate sums. When combined with 

Calculate Sums set to Filtered, the sums displayed per resource, role and team will be filtered (see 

"Show Utilization" on page 83). 

6.5 Editing Allocations 
In the right half of the allocations view, you can see and edit team entries for resources, roles and 

teams, grouped by the associated investments or by the allocated resources, roles and teams. 

Without selection of the Show Gantt Bars for Team Members option in the Visualization menu in 

the toolbar, you can enter the desired allocation values in the right hand side grid. Extending a team 

entry by entering values in grid cells outside the duration of the associated investment will also 

extend the investment such that the duration of the investment includes the team entry. 

 Changes made in the allocation grid will only be applied when you save them via the toolbar. You 

can easily identify unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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6.6 Editing List Fields 
You can edit the Start, Finish and Staff OBS Unit fields of team entries in the list. 

Most additional fields may also be made editable by members of the ARP Admin group (see "6.6.3 

Editing Additional Fields" on the bottom of this page). 

 Changes will only be applied when you save them via the toolbar. You can easily identify unsaved 

changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

6.6.1 Editing the Start and Finish of Team Entries 

You can change the duration of team entries via the Start and Finish fields displayed in the left hand 

side hierarchic list, distributing planned and hard allocations over the new duration with the same 

proportions as before the change. Therefore, shortening a team entry will raise the allocation per 

period while extending a team entry will lower it. 

Extending a team entry beyond the associated investment's Start or Finish will also extend the 

investment, such that it includes that team entry. 

Reducing the durations of team entries won't reduce the investment's duration. 

Team entries without a Start or Finish will adopt these values from the associated investment. 

6.6.2 Editing the Staff OBS Unit of Team Entries 

You can edit the Staff OBS Unit field of team entries in the list. To do this, click in the field. 

Click on the magnifier icon to select an OBS unit or the trashcan icon to clear the field. 

6.6.3 Editing Additional Fields 

You can also edit any additional list fields that have been made editable by members of the ARP 

Admin group (see "9.11 Configuring List and Filter Fields" on page 156). 

6.6.4 Copying List Fields 

You can copy editable field values up or down via drag-and-drop. This feature supports lookup fields 

and respects restrictions on column values. 

Copying field values this way requires the start and target row to be of the same type, i.e., 

resource/role/team or team entry. 
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6.7 Context Menu for Displayed Objects 
Hover over a resource, role or team or a team entry to open the associated context menu. 

The following sections describe the default options available here. 

Members of the ARP Admin group can hide default options and add additional custom options (see 

"9.10 Defining Actions" on page 154). 

6.7.1 Open Properties 

The Open properties option is available in the context menu for resources, roles, teams and team 

entries. Here you open the associated Clarity PPM detail view. 

> Investment, role and resource properties open in a new browser tab. 

> Team entry properties open on top of itd Advanced Resource Planning. 

6.7.2 Allocate From Estimates 

The Allocate From Estimates option is available in the context menu for team entries. 

For the selected team entry, or for all team entries of the selected investment, the estimated effort of 

associated assignments will be entered as allocation.  

This action will be directly applied without further confirmation. 

6.7.3 Commit Allocation 

The Commit Allocation option is is available in the context menu for team entries. 

For the selected team entry, or for all team entries of the selected investment, the allocation will be 

entered as hard allocation. 

This action will be directly applied without further confirmation. 

6.7.4 Accept Hard Allocation 

The Accept Hard Allocation option is is available in the context menu for team entries. 

For the selected team entry, or for all team entries of the selected investment, the hard allocation will 

be entered as allocation. 

This action will be directly applied without further confirmation. 

6.7.5 Delete 

The Delete option is available in the context menu for team entries without actuals. Once you select 

the Delete option, the selected team entry will instantly be deleted without further confirmation. 

Team entries with actuals can't be deleted. 

Deleting other objects isn't supported in the allocations modes. 

6.7.6 Expand All 

The Expand all option is available in the context menu for resources, roles and teams. Select this to 

expand all associated team entries. 
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6.8 Conversations 
The standard MUX conversations for team entries are available in itd Advanced Resources Planning 

in the Allocations by Investment and Allocations by Resource views. 

Clicking on a team entry in either of the Allocations by Investment or Allocations by Resource views 

adds a small Details button at the top right side of the view. 

 

This button opens a conversation panel for this team entry only. 
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6.9 Interactive Gantt Bars 
In Allocations by Resource mode, you can toggle the display of Interactive Gantt bars for team 

entries only via the Visualization menu in the toolbar. 

6.9.1 Create Requisition 

The Create Requisition option is available in the context menu for team entries. Here you create a 

new requisition for the allocation of a team entry. 

This action will be directly applied without further confirmation. 

6.9.2 Gantt Bars for Team Entries 

Gantt bars for team entries will be displayed when selecting Show Gantt Bars for Team Members in 

the Visualization menu in the toolbar. 

While Gantt bars are displayed for team entries, you can't edit the planned or hard allocation values 

displayed per period directly. 

You can shift and resize team entries via drag and drop of their Gantt bars. 

This will redistribute the allocation values displayed per period for the respective team entry, planned 

or hard, over the capacity of the respective resource, role or team during the new duration with the 

same proportions as before the change. 

Shifting or extending a team entry beyond the associated investment's Start or Finish will also 

extend the investment, such that it includes the team entry. 

Reducing the durations of team entries won't reduce the investment's duration. 

Team entries without a Start or Finish will adopt these values from the associated investment. 

6.9.3 Saving or Reverting Changes 

Changes made to Gantt bars won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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6.10 Utilization and Capacity 
With Show Utilization in the General tab of your Preferences, the utilization, total and/or remaining 

capacity of resources, roles and teams, based on allocations, are displayed per period in color-coded 

numbers. 

 

6.10.1 Visualization of Low, Optimal, High and Very High Utilization 

Cell colors display whether a role's or resource's utilization is low (white), optimal (green), high 

(yellow) or very high (red) in that period (see "6.15.5 Utilization" on page 87). 

Utilization histogram charts are not available in this mode. 

6.10.2 Resource Fields 

Two values are displayed per resource, role, team and period. You select these values in the Layout 

tab of your Preferences, from among [total] Capacity, Remaining [capacity], Allocation and Hard 

Allocation (see "Cell Configuration" on page 89). 

6.10.3 Utilization, Remaining Capacity and Role Capacities 

In this mode, the utilization may be either the Allocation or Hard Allocation, or both (see previous 

section). The remaining capacity is always based on the editable value (Allocation or Hard 

Allocation, see "6.2 Displayed and Editable Values per Period" on page 68). 

With Calculate Sums set to Filtered in the General tab of your Preferences, the Allocation and Hard 

Allocation will only include displayed allocations, as selected by your allocation filter. 

With Calculate Sums set to On or Off, all allocations in the associated period will be included instead, 

even if they aren't displayed. 

The remaining capacity is not affected by allocation filters, and based on all allocations by default. 

For the displayed utilization and capacity, separate utilization and capacity filters are available (see 

"4.10 Utilization and Capacity Filters" on page 37 for details and an example). 

Depending on your preferences, role capacities may include sub-roles (see "Role Capacity 

Calculation" on page 88). 

6.10.4 Team Utilization 

For a resource allocated to a team, that allocation is included as a percentage of the resource’s 

capacity as entered in the team (e.g., if a resource is allocated to a team with 50%, in a week where 

that resource has an capacity of 40 hours, an allocation of 20 hours will be included for the team). 

6.10.5 Displaying Utilization and Capacity Details 

Hover over a grid cell to show the displayed resource fields, utilization mode (Filtered or not) and 

remaining capacity calculation, if applicable. 
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6.10.6 Filtering the View 

Use the utilization and capacity filters to filter the utilization and capacity displayed for resources, 

roles and teams. This also affects utilization level colors. 

See "4.10 Utilization and Capacity Filters" on page 37 for details and an example. 
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6.11 Scenario Comparison 
In the Allocations modes, the Scenario menu is available in the toolbar if you have the Scenario – 

Navigate right and if the menu hasn't been hidden by a Clarity PPM application administator (see 

"9.12.2 Hide Toolbar Buttons" on page 160). 

In the Scenario menu, you have access to all scenarios for which you have the View right. You can 

edit data in any scenario for which you have the Edit right. 

Investment rights are not required, but shifting and resizing investments with hard allocations in this 

mode requires the Resource – Hard Book right for all associated resources. 

The Excel export isn't available in scenario mode. 

 

6.11.1 Scenario Menu Features 

The scenario menu in the toolbar offers the following features. 

> Select a scenario to compare with the plan of record. 

> Deselect a selected scenario to end the scenario comparison. 

> Via the Scenario menu, you can also create new scenarios or open the scenario manager. 

See section "6.14.5 Scenario" on page 82 for details about these features. 

6.11.2 Visualization and Editing in Scenario Comparison Mode 

While the comparison is active, team entries are displayed in a two row layout: 

 

> The first row displays the plan of record data, which you can not edit in comparison mode. 

> The second row displays the associated data in the compared scenario. In comparison mode, 

you can only edit scenario data: the Investment Status of an investment (see following section 

for details), the Start and Finish of a team entry and, without Show Gantt Bars for Team 

Members in Visualization, the Allocation per period. With Show Gantt Bars for Team Members 

in Visualization, you can change the start and duration of team entries via drag-and-drop in the 

Gantt chart, with the same effect as changing the Start and Finish fields in the list. 

The Hard Allocation per period is read-only in scenarios in Clarity PPM and displays the 

commited plan of record values. You cannot change these values in a scenario. 
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6.11.3 Transferring Investments and Team Entries to a Scenario 

Initially, investments exist only in the plan of record. Change the Investment Status in an 

investment's second row or the Start, Finish or Allocation per period in a team entry's second row to 

copy the associated investment with all team entries to the scenario. 

Please note: 

> You can change the Investment Status in Allocations by Investment mode only, and you can set 

it to Approved or Unapproved only in a scenario, provided these values are available. 

> Team entries added to an investment after that investment has been added to a scenario will not 

be available in the scenario. 

> Investments and team entries deleted in the plan of record will also be deleted in all scenarios in 

which they exist, even if differences have been entered for them in a scenario. 

While the comparison is active, you can only edit the copies of team entries created in the scenario. 

 

Changes made to an investment's Investment Status or to a team entry's Start, Finish or Allocation 

per period are highlighted in light blue. Allocations are summed up on the top level (investment or 

resource/role/team). Where changes exist, as opposed to the plan of record, they will also be 

highlighted in light blue on this level. 

Additionally, the Gantt bars for investments and team entries will also be highlighted in light blue 

when the Start, Finish or total Allocation change as opposed to the plan of record. 

Extending a team entry beyond the Start or Finish of the associated investment will also extend the 

investment, such that it includes that team entry. Reducing the durations of team entries won't 

reduce the investment's duration. Team entries without a Start or Finish will adopt these values from 

the associated investment. Changing the duration of a team entry will redistribute its allocation 

values with the same proportion as before the change. 

 Any changes you make to scenario data in this mode will only be applied when you save them via 

the toolbar. You can easily identify unsaved changes via the red triangle in a field.  

 Refresh the view without saving to revert your changes. 

6.11.4 Utilization 

In Allocations by Resource mode, the scenario mode lets you compare the utilization and remaining 

capacity of resources, roles and teams in the plan of record to their scenario values. 

 

The utilization and capacity filters are applied here as well. See section "4.10 Utilization and Capacity 

Filters" on page 37 for details and an example. 
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6.11.5 Context Menu 

In Allocations by Resource mode, while the scenario comparison is active, the context menu offers 

only the following options. 

> Open properties: resources/roles/teams and team entries (investments) 

> Expand all: display all team entries of a resource, role or team 
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6.12 Roadmap Scenario Mode 
Please note that the roadmap scenario mode feature is only available after adding an itd Advanced 

Resource Planning channel to the roadmap blueprint (see "9.7 Planning Modes” on page 152). 

With the roadmap scenario mode, roadmaps offer an itd Advanced Resource Planning tab, which 

shows a capacity scenario for the currently selected roadmap scenario in its Allocations modes: 

 

This view compares the current schedule of investments with the schedule of their linked roadmap 

items. Additionally, you can filter by, display and edit the In Plan property of roadmap items, and you 

can filter the utilization by the In Plan field in this mode with the standard utilization filter feature. 

> The itd Advanced Resource Planning application in this view is automatically filtered (in addition 

to any manually entered filters and automatic standard filters such as Hide investments from the 

past) and includes any investments linked to roadmap items in the selected roadmap scenario. 

> In the Allocations modes, the scenario mode (see previous section) is always active. 

> The capacity scenario is initially created when first opening the view for a specific roadmap 

scenario and is then linked to that roadmap scenario. 

Reopening the view for a roadmap scenario for which a capacity scenario already exists will load 

that capacity scenario. 

Capacity scenarios are shared among all users and are updated with changes saved by any user. 

> Investments in the capacity scenario are synchronized with their linked roadmap items in the 

roadmap scenario, such that any changes you save for an investment’s Start or In Plan field in 

the capacity scenario affect its linked roadmap item in the roadmap scenario and vice versa. 

• The investment’s Start date in the capacity scenario is equal to and synchronized with its 

linked roadmap item’s start date. 

The investment’s Finish date is shifted according to its duration, both of which are not linked 

to the roadmap item. 

Any associated team entries are shifted accordingly in the capacity scenario. 

Shifting and resizing roadmap items linked to investments with hard allocations in this mode 

requires the Resource – Hard Book right for all associated resources. 

• The In Plan value in the capacity scenario is equal to and synchronized with its linked 

roadmap item’s In Plan value. 

• Any changes made to allocations in the capacity scenario are synchronized back to Clarity 

PPM and show up under Capacity. 

Please note that capacity changes made in Clarity PPM won’t be synchronized back to the 

capacity scenario. 

> Any changes saved to the capacity scenario are restored when you or another user reopens the 

view for the same roadmap scenario, including changes not affecting linked roadmap items. 
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6.13 Hierarchy Mode 
You can integrate itd Advanced Resource Planning in the Hierarchies module for hierarchies of the 

Investment type. 

Please note that the hierarchy mode feature is only available after adding an itd Advanced Resource 

Planning channel to the hierarchy blueprint (see "9.7 Planning Modes” on page 152). 

With the hierarchy mode, hierarchies offer an itd Advanced Resource Planning tab. 

 

In this mode, the view is automatically filtered to display only investments included in the hierarchy. 

You can display and sort by the Hierarchy Level field, which displays an investment’s hierarchy level. 

Please note: This mode is currently in the beta phase and is included as a preview. Further features 

are planned. We look forward to receiving feedback on this mode. 
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6.14 Toolbar Features 
In Allocations by Resource mode, you have access to the following features in the toolbar. 

6.14.1 View 

The View menu at the top left displays the active view and allows switching views, saving the current 

view under a new name and editing your favorites and view sharing settings under Manage. 

If you have the right to save changes to the current view, the Save View button is active. If it isn't, you 

can still save a copy of the current view. 

You can find details of the features available here under "3 Views" on page 22. 

6.14.2 Display Period 

To the right of the View menu, you have access to various controls for changing the display period. 

The slice period and number of slices are saved with the view and are synchronized with the 

Timeslices tab of the Preferences (see "6.15.2 Timeslices" on page 84) 

Most options available there are also available in the toolbar, with the exception of fiscal periods as 

slice periods. 

The start date won't be saved. The view automatically starts with the current date. 

 Previous Periods: Here you switch back by the selected display period (e.g., 6 months). 

 Previous Period: Here you switch back by the selected slice period (e.g., 1 month). 

 Slice Period and Number of Slices: Select the slice period (e. g, months) and enter the number of 

slices in the field or use the buttons to raise or lower the number. 

Then click on Show to update the view with the new slice settings. 

 Jump to a Certain Date: Here you select the view's start date in a calendar view. 

 Next Period: Here you switch ahead by the selected slice period (e.g., 1 month). 

 Next Periods: Here you switch ahead by the selected display period (e.g., 6 months). 

6.14.3 Refresh and Save 

Use the Refresh and Save buttons to discard or save your changes. 

 Refresh: This will reload all data. If there are unsaved changes, you will be asked if you want to 

save first. Answering no will discard your changes. 

 Save: This will save all unsaved changes you have made in the current view. 

6.14.4 Export to Excel 

You can export all rows and columns of the view to Microsoft Excel. 

 Export to Excel: Here you export the view to Microsoft Excel. 

The data will be exported as displayed, with the same filter settings and with all rows and 

columns that are currently displayed. For list entries with sub-elements, these sub-elements will 

only be exported if their parent item has been expanded, such that they are currently visible. 

The Excel export is limited to a maximum of 15,000 rows and isn't available in scenario mode. 
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6.14.5 Scenario 

The scenario mode is available with the Scenario – Navigate right if the menu hasn't been hidden by 

a Clarity PPM application administator (see "9.12.2 Hide Toolbar Buttons" on page 160). 

The Excel export isn't available in scenario mode. 

See section "6.11 Scenario Comparison" on page 76 for details about the scenario mode. 

 Scenario: Here you activate or deactivate the scenario mode. You can start with an existing 

scenario or create a new scenario. 

 Select or Deselect a Scenario: In the Scenario menu, all scenarios you have access to are 

available for selection. Select a scenario to start the scenario comparison. Deselect the active 

scenario to end the scenario comparison. 

 New Scenario: Here you create a new scenario. Enter the name for the new scenario in the 

toolbar. Click on the check mark to confirm or click on the X to cancel. 

If you confirm, the new scenario will be directly selected and the comparison will be started. 

 Manage Scenarios: Here you open the Clarity PPM default scenario manager view. 

In this view, you can view, edit, add or delete scenarios. You can also set the Current and 

Compare flags, which won't affect itd Advanced Resource Planning. 

6.14.6 Visualization 

In Allocations by Resource mode, you have access to the following options under Visualization. 

 Visualization > Cell: Here you toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "6.3 Displaying Trend Arrows" on page 69. 

 Visualization > Gantt Bars: Here you toggle the display of Gantt bars for team entries, see "6.9 

Interactive Gantt Bars" on page 73. 

6.14.7 Preferences 

 Preferences: Here you configure other view settings such as display fields and filter fields, see 

"6.15 Preferences" on page 83. Preferences will be saved separately for each view. 

6.14.8 Help 

 Help: Here you can find information about itd Advanced Resource Planning and about asking for 

support. If you do, please always specify your version, which you can find under Info. 

6.14.9 Fullscreen 

 Fullscreen: In full screen mode, the Clarity PPM navigation will be hidden, such that more items 

can be displayed in itd Advanced Resource Planning. 

You can turn the navigation back on using the same button. 
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6.15 Preferences 
Click on the Preferences button in the toolbar to edit view options. 

6.15.1 General 

Settings in the General tab control the display and behavior of the current view. 

 

> Toolbar Only with Icons: select this to hide the captions on buttons with icons, reducing the width 

of the toolbar.  

> Show Utilization: select this to display the utilization and/or capacity of roles, resources and 

teams per period (see "Cell Configuration" on page 89). 

In Allocations by Resource mode only, with Show Utilization, global sums will also always be 

calculated for the Allocation and Hard Allocation columns, and the Team has Allocation filter 

(see page 33) will be available, even if Calculate Sums is set to Off. 

With Show Utilization and Calculate Sums set to On or Filtered, sums are also displayed for the 

Actuals column. With Filtered, the allocation filter will also be applied to column sums and the 

utilization, such that they only include displayed allocations. 

With Calculate Sums set to On or Off, the column sums and utilization are global. 

The remaining capacity is always global and includes any allocations in the associated period. 

> Calculate Sums: select this to display totals of the workload fields (in the allocation modes: 

Allocation, Hard Allocation and Actuals) for all aggregation levels (in this mode: per resource, 

role and team). 

You can choose between On (display global sums), Filtered (apply allocation filter to global sums) 

and Off (don't calculate sums). This setting affects the loading time, with Off being the fastest 

and Filtered the slowest method. 

The Team has Allocation filter (see page 33) is only available when you set this to On or Filtered, 

or, in Allocations by Resource mode only, when Show Utilization is selected. 

> Load Data on Startup: specify here whether data is loaded directly when opening itd Advanced 

Resource Planning or only after clicking the filter button. 
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6.15.2 Timeslices 

Settings in the Timeslices tab control the time axis scale and display period. 

 

> Slice Period: enter the planning period here. Possible settings are Days, Weeks, Months, 

Quarters, Calendar Years and, if configured, Fiscal Period. 

The selection of available slice periods may be limited by Clarity PPM application administrators 

via the itd AE Preferences lookup (see "9.12.3 Restrict Time Slice Periods in the Preferences and 

in the Toolbar" on page 161). In this case, only options enabled via the associated lookup value 

will be available here and in the toolbar of itd Advanced Resource Planning. 

> Fiscal Entity and Fiscal Period: with the Fiscal Period setting, if multiple fiscal entities or periods 

have been defined in your Clarity PPM system, select the desired fiscal entity and period here. 

> Work Effort Unit: specify the unit for efforts here. By default, the System Standard will be applied. 

Alternatively, Hours, Days or full time equivalents (FTE) are available for selection here. 

> Slice Count: enter the amount of slices to be displayed. 

> Decimal Places: enter the desired number of decimals for entering and displaying assignments 

and allocations. 
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6.15.3 Columns 

In the Columns tab, you select the columns to display in the list at the top left of the current view. 

 

The following fields are always displayed in the first column: 

> Name (resource/role/team, investment) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following fields can be selected for display by default: 

> Actuals, Allocation, Hard Allocation (resource/role/team, team entry): worked, planned and 

booked hours per roles, resource and team (first level) / team entry (second level) 

> Default Allocation (team entry): editable; this applies in periods during the team entry where no 

allocation segments have been defined. 

> Department OBS, Location (resource/team) 

> Effective Role (role): parent role 

> Effective Role (resource): primary role 

> Effective Role (team entry): resource/role/team investment role 

> ID (resource/role/team) 

> Skills (resource/role/team, role team entry): editable; only available for role team entries when 

using skills hierarchy, see "9.12.6 Use Old Skills Hierarchy", page 162. 

> Staff OBS Unit (team entry): editable 

> Start, Finish (team entry): duration of all team entries displayed for a resource/role/team (first 

level) or duration of team entries (second level) 

In scenario mode, you can change these fields for team entries in the scenario. 

Members of the ARP Admin group may add to the selection and enable editing for other fields 

available for investments, investment sub-types, resources, roles, teams and team entries. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

See section "9.11 Configuring List and Filter Fields" on page 156 for details. 
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6.15.4 Filter 

In the Filter tab, you select filter fields for the allocation filter. This lets you filter the current view by 

investments, resources/roles/teams and team entries. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See section "4.8 Default Filter Fields for the Main View" on page 28 for details about the default filter 

fields. 

Members of the ARP Admin group may add to the selection other fields available for investments, 

investment sub-types, resources, roles, teams and team entries. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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6.15.5 Utilization 

Settings in the Utilization tab control the display and calculation of the utilization. 

In Allocations by Investment mode, the utilization will be calculated from allocations. 

 

> The Utilization Rate controls the visualization of low or high utilization. 

• Low Utilization at and Below: upper utilization boundary below which resources, roles and 

teams will be marked as lowly utilized with a grey background in the respective period. 

Utilization between the thresholds for low utilization and utilization warning (e.g., above 80% to 

100% as according to the screenshot) will be marked as optimal with a green background. 

This threshold value has no effect in the histogram. 

• Utilization Warning Above: lower utilization boundary above which resources, roles and teams 

will be marked as slightly over-utilized with a yellow background in the respective period. This 

applies as long as the utilization stays at or below the lower boundary for high utilization. 

In the histogram, workload is colored green up to this threshold value. 

• High Utilization Above: lower boundary above which resources, roles and teams will be 

marked as highly over-utilized with a red background in the respective period. 

In the histogram, workload is colored yellow up to this threshold value and red above. 

• Team Entry or Resource Highlighting: with the default setting Team, signal colors are based 

on the editable value displayed in the right half of team entry cells, Allocation or Hard 

Allocation, as proportion of their total capacity. 

With the Resource setting, resource cells will be colored based on the second resource value 

instead. This highlighting only supports Allocation and Hard Allocation as well. No colors are 

available when the Capacity or Remaining values are selected. 

You can find the actual selection of values in the Layout tab of your Preferences. 

> The Capacity Filter by Staff OBS Unit is applied to the capacity displayed for resources, roles and 

teams, such that only resources and teams with a selected Department OBS will be displayed as 

available and included in the capacity of associated roles. 

Additionally, you can filter the utilization. See "4.10 Utilization and Capacity Filters" on page 37. 
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> The Role Capacity Calculation option is only available after activation by a CA PPM application 

administrator via the itd AE Preferences lookup settings (see "9.12.17 Include Sub-Roles in Role 

Capacity” on page 166). It controls the inclusion of sub-roles when calculating role capacities.  

Under Calculate Capacity of Roles Based On, select: 

• All Role Owners (Standard): in the default setting, the capacity of a role is calculated based 

only on associated resources. 

• All Role Owners and Sub-Roles: select this option to include the capacities of sub-roles in the 

calculation of a role’s capacity. 
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6.15.6 Layout 

Settings in the Layout tab control the display values and the editable value for allocations in the right 

hand side allocation grid, the display values for resourve utilization and capacity as well as sorting 

fields for resources and investments. 

 

> Cell Configuration: here you configure the values used in the right hand side allocation grid as 

well as the values to display for the grid view of the utilization and capacity of roles, resources 

and teams (active with Show Utilization in the General tab, see "Show Utilization" on page 83). 

• Field to Display on the Left Part of the Cell (Read Only): Empty, Allocation, Hard Allocation, 

ETC, Actuals, Actuals + ETC, Requested or Capacity 

• Field to Display on the Right Part of the Cell (Editable): Allocation or Hard Allocation 

The displayed utilization is always based on the editable value. 

• Resource Field to Display on the Left Part of the Cell: Capacity, Remaining, Allocation or Hard 

Allocation 

• Resource Field to Display on the Right Part of the Cell: Capacity, Remaining, Allocation or 

Hard Allocation 

• Tolerance of Deviation: Treshold value for displaying trend arrows to indicate a deviation of 

the left cell value from the right one when activated via Visualization. 

The left hand side sum columns (Allocation, Hard Allocation, Actuals) can be displayed or hidden 

via the Columns tab (see "6.15.3 Columns" on page 85). 

For aggregated totals of roles, resources and teams in the allocation grid and sum columns, set 

Calculate Sums to On or Filtered in the General tab (see "Calculate Sums" on page 83). 

With Show Utilization, the allocation grid will display the resource fields selected here for roles, 

resources and teams instead. 

Please also note the details of combining the Show Utilization and Calculate Sums settings in 

Allocations by Resource mode (see "Show Utilization" on page 83). 

> Sorting: In addition to the fields listed here, any custom fields without lookups are available. If you 

don't select the respective default field, items will be sorted by that field on the second level. 

• Sort Resources by: Name (Default) or Primary Role. 



itd Advanced Resource Planning 12.2.0 

Allocations by Resource 

 90 

• Sort Investments By: Investment Type or Name (Default). 

> Browser Specific Layout Configuration: Here you can select to Use Colors with Higher Contrast. 

This setting will affect all your views in itd Advanced Resource Planning. 
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7 Assignments by Investment 

The Assignments by Investment mode groups resource, role and team assignments by associated 

investments. Project or custom investment phases, tasks and milestones are also displayed. 

The utilization and capacity of resources, roles and teams are displayed in a separate view in color-

coded numbers or as graphical histograms. 

This mode supports editing of project structures in an interactive Gantt chart. 

 

7.1 Displayed Data 
In Assignments by Investment mode, the following data will always be displayed: 

> Investments (custom types included) 

> Tasks of displayed projects and custom investment types 

> Assignments of resources, roles and teams 

> List of all resources, roles and teams, optionally with utilization and capacity (see "7.12 Utilization 

and Capacity" on page 108) 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25) 

7.1.1 Displaying Phases, Milestones and Investment Hierarchies 

Displaying of phases and milestones as well as of investment hierarchies is optional and can be 

toggled for each in the General tab of the Preferences (for investment hierarchies, also see "4.8.2 

Selecting Investment Hierarchies in by Investment Modes" on page 30). 

7.1.2 Displaying Assignments 

Displaying assignments is also optional and can be toggled in the Visualization menu. 

Without assignments, the view will load faster and display only investments, phases, tasks and 

milestones. 

In this mode, the following features aren't available: 

> Resource, role, team, assignment and team entry filters 

> Assignment data 

> Calculated sums of Estimated Effort, Actuals und Total Effort 

> Editing the Estimated Effort of tasks and assignments 

> Resource, role and team list with utilization view 
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7.2 Displayed and Editable Values per Period 
In the Layout tab of the Preferences, you can select an optional display value for assignments per 

period (see "Field to Display on the Left Part of the Cell" on page 124). 

> Field to Display on the Left Part of the Cell (optional): Empty (no field), ETC, Actuals, Capacity or 

a custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

> Field Displayed on the Right Part of the Cell (Assignment): In Assignments by Resource mode, 

the assignment value is always displayed on the right. This is also the base of the displayed 

utilization and capacity (see "7.12 Utilization and Capacity" on page 108). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.7 Show Grid Hints for by Investment Views" on page 162). 

7.3 Displaying Trend Arrows 
Via the Visualization menu, you can display trend arrows comparing the left and right cell values, see 

"Visualization > Cell" on page 115. 

 

For instance, this can help you to easily compare actuals with the originally planned values. 

Wherever both values are present and different, a little arrow at the left cell edge visualizes a negative 

or positive deviation of the left cell value from the right cell value. 

In the Layout tab of the Preferences, you can set a threshold percentage for the minimal deviation to 

visualize via arrows see "Tolerance of Deviation" on page 124. 

7.4 Displaying Investment Descriptions 
Hover over an investment to display its description. 

This feature may be deactivated via the itd AE Preferences Lookup by Clarity PPM application 

administrators (see "9.12.26 Hide Description Tooltips" on page 169). 
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7.5 Estimated Effort, Actuals and Total Effort 
In the Columns tab of the Preferences, you can display or hide the Estimated Effort, Actuals and 

Total Effort (Estimated + Actuals) fields in the left hand side list (see "7.15.3 Columns" on page 119). 

The fields display the respective values for each assignment. 

With Calculate Sums in the General tab of the Preferences, aggregated sums will also be displayed 

per task, phase and investment. Depending your selection, global sums (On) or Filtered sums (using 

the assignment filter) will be displayed (see "Calculate Sums" on page 116). 

Only assignments of labor roles and resources as well as teams will be included in the sums. 

Assignments of material, equipment and expense roles and resources won't be included. 

For investments, you can display the sums calculated by Clarity PPM, as displayed in investment 

lists, instead of letting itd Advanced Resource Planning calculate the sums. To do this, select the Use 

Clarity PPM's calculated investment sums option in the General tab of the Preferences. 

You can edit the Estimated Effort for assignments and tasks by entering a value (see "7.8 Editing List 

Fields" on page 96).  

7.6 Editing Assignments 
With Show Gantt Bars for Assignments turned off in the Visualization menu in the toolbar, you can 

edit the ETC per period that is displayed in the right half of each cell. Click on the right half of a cell to 

edit its value. The white background of a cell or its right half indicates that the value can be edited. 

The left half of a cell displays Actuals, Capacity or any custom time scaled monetary value (see 

"Field to Display on the Left Part of the Cell" on page 124). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.7 Show Grid Hints for by Investment Views" on page 162). 

The Estimated Effort will automatically be updated with the sum of efforts per period you enter. 

With Calculate Sums set to On or Filtered (see "Calculate Sums" on page 116), this will also update 

the associated task, phase (if any) and investment. 

Entering workload outside the duration of an assignment will expand it accordingly. If required, 

parent objects will also be expanded, such that they include the assignment. 

Alternatively, enter the total Estimated Effort for a task or an assignment in the associated column 

(see "7.8.4 Editing the Estimated Effort of Tasks and Assignments" on page 97). 

With Update Allocation in the General tab of the Preferences, the new assignment values will also 

be entered as allocation for the same periods. 

7.6.1 Copying Grid Cells via Drag and Drop 

Via drag and drop, you can copy the value of a grid cell to neighboring cells, either horizontally, on the 

timeline, or vertically, to other resources, roles and teams: 

> To do this, click in the cell you wish to copy, hold the mouse button and drag in the desired 

direction. 

> Release the mouse button when you're done to copy the selected assignment value to all grid 

cells you touched while dragging. 

> Save your changes via the toolbar or Refresh without saving to revert your changes. 
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7.6.2 Display ETC sums outside of visible time range 

Via Columns in the Preferences, you can display ETC sums for assignmens that are before or after 

the visible period. 

The ETC before and ETC after columns display the total hours before or after the visible period. 

Click on a value in the ETC before column to shift the visible period back, such that the first ETC 

value in that direction is at the end of the new range . 

Click on a value in the ETC after column to shift the visible period ahead, such that the first ETC 

value in that direction is at the start of the new range. 

7.6.3 Display Options 

Use the buttons and menus in the toolbar to select the start date and period and to specify how 

many periods to display at once. Display options for this view are also available in the Timeslices tab 

of the Preferences (see "7.15.2 Timeslices" on page 118). 

7.6.4 Saving or Reverting Changes 

Changes made to assignments won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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7.7 Editing Custom Time Scaled Monetary Values 
In the left half of an assignment grid cell, depending on your settings, Actuals, Capacity or any 

custom time scaled monetary value will be displayed (see "Field to Display on the Left Part of the 

Cell" on page 124). 

With Show Gantt Bars for Assignments turned off in the Visualization menu in the toolbar, you can 

edit custom time scaled monetary values by clicking in the left half of a cell displaying such a value. 

The white background of a cell or its left half indicates that the value can be edited. 

When displaying the associated column, that column will be updated on the assignment level and on 

all other levels summing up over the assignment. 

 Changes will only be applied when you save them via the toolbar. You can easily identify unsaved 

changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

7.7.1 Integrating a Custom Time Scaled Monetary Value 

Displaying and editing custom time scaled monetary values in the field list and grid requires adding 

the field via the field configuration. All other steps are optional. 

Administration 

> Add the field via the field configuration (see "9.11 Configuring List and Filter Fields" on page 156). 

• Optionally, select the desired resource types (e.g., Material, Equipment and Expense). 

• This step requires membership in the ARP Admin group. 

> Optionally, via the itd AE Preferences lookup, restrict editing the ETC, such that ETC can't be 

entered for resource types for which you wish to enter monetary values only (e.g., Material, 

Equipment and Expense; see "9.12.24 Editable Resource Types" on page 169). 

• This step requires the global Administration – Application Setup right, which Clarity PPM 

application administrators have by default.  

Configuration Options 

> Add the field as a visible column (see "7.15.3 Columns" on page 119). 

> Select it as a grid value (see "Field to Display on the Left Part of the Cell" on page 124). 
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7.8 Editing List Fields 
Click table cells in the left hand side hierarchic list to edit the displayed investments, team entries, 

phases, tasks, milestones and assignments. 

 Changes will only be applied when you save them via the toolbar. You can easily identify unsaved 

changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

7.8.1 Renaming Investments, Projects Phases, Tasks and Milestones 

You can rename investments, phases, tasks and milestones. To do this, click on the associated row 

in the Name column and press [F2] or [Return]. Enter the desired name. Press [Return] to confirm or 

[Esc] to cancel. Alternatively, you can rename objects via the context menu. 

7.8.2 Editing the IDs of Phases, Tasks and Milestones 

If Auto-numbering is disabled for the ID field of tasks, you can edit the IDs of phases, tasks and 

milestones. To do this, click in the respective field and enter the desired ID. 

You can’t edit the IDs of investments, resources, roles and teams that are also displayed in this view. 

7.8.3 Editing the Start, Finish and Duration of Objects 

Via the list, you can edit the Start, Finish and Duration of non-project investments, phases, tasks and 

assignments. You can't change the Start and Finish of projects and custom investment types 

directly, as they are derived from the total duration of associated phases, tasks and milestones. 

You can only cange the Start and Finish of tasks and assignments while the status is Not started 

and no actuals exist for them. The status check can be turned off (see "9.12.25 Edit Start and Finish 

of Tasks and Assignments Regardless of Status on page 169). 

> Changes of the Start and Finish will also affect parent and sub-objects as well as the distribution 

of assignments (see below). 

By default, changing the Start of a phase or task will keep the Duration by shifting the Finish for 

the same number of work days according to the base calendar. This feature may be disabled by 

Clarity PPM application administrators via the itd AE Preferences lookup (see "9.12.27 Keep Task 

Duration" on page 170). In this case, changing the Start won't affect the Finish. 

In any case, you can change the Start without the Finish by dragging the left edge of a phase or 

task bar in the interactive Gantt chart (see "7.11 Interactive Gantt Bars" on page 105). 

> Alternatively, you can change the Duration of a phase or task. The duration is measured in work 

days within the actual duration of the phase or task according to the base calendar. The Finish 

date will be adjusted accordingly. 

• Changing the duration of a phase will change its tasks proportionally (e.g., shrinking a phase 

from 8 to 6 weeks will reduce an associated task from 4 to 3 weeks). 

• Likewise, changing the duration of a non-project investment or task (directly or indirectly via a 

phase) will change its assignments proportionally. 

• Extending an assignment beyond the Start or Finish of the associated task or non-project 

investment will also extend the task or non-project investment, such that it includes the 



itd Advanced Resource Planning 12.2.0 

Assignments by Investment 

 97 

assignment. Likewise, extending a task will extend the associated phase, if required. Extending 

a phase will extend the associated project, if required.  

• Shortening has no effect on associated objects. 

• Changing the duration of an assignment will redistribute the remaining effort over the working 

hours during the new remaining duration (between Actuals Thru and Finish) with the same 

proportions as before the change. The effort per period can then no longer be edited until the 

changes are applied or rejected. 

With the Update Allocation in the General tab of the Preferences, the new assignment values 

will also be entered as allocation for the same periods. 

7.8.4 Editing the Estimated Effort of Tasks and Assignments 

You can edit the Estimated Effort of a task or assignment. 

To do this, click into the Est. Effort field in the associated row and enter the desired value. 

> Estimated Effort entered for a task will be distributed proportionally to assigned resources, roles 

and teams with respect to the previous Estimated Effort values. For example, if you change the 

effort for a task from 40 to 80 hours, with one resource booked for 30 hours and another one for 

10 hours, the first one will be set to 60 hours and the second one will be set to 20 hours.  

The effort per assignment and the effort per period can then no longer be edited until the changes 

are applied or reverted. 

> If you change the Estimated Effort for an assignment, directly or via the associated task, the new 

value will be evenly distributed over the working hours during th assignment's new remaining 

duration (between Actuals Thru and Finish), overwriting the previous planning. The effort per 

period can then no longer be edited until the changes are applied or reverted. With Update 

Allocation in the General tab of the Preferences, the new assignment values will also be entered 

as allocation for the same periods. 

7.8.5 Editing a Custom Time Scaled Monetary Value for an Assignment 

You can edit any custom time scaled monetary value displayed as a visible column for an 

assignment in very much the same fashion as for editing the Estimated Effort: click into the field in 

the associated row and enter the desired value. 

> Changing a custom time scaled monetary value for an assignment will distribute that value over 

the working hours during the assignment considering the Loading Pattern, overwriting the 

previous planning. 

7.8.6 Editing the Loading Pattern of Project Task Assignments 

For project task assignments, you can edit the Loading Pattern. Click in the field to select a value.  

7.8.7 Editing the Staff OBS Unit of Team Entries 

You can edit the Staff OBS Unit Field of team entries in the list. To do this, click in the field. 

Click on the magnifier icon to select an OBS unit or the trashcan icon to clear the field. 

7.8.8 Editing the Investment Status 

For investments, you can edit the Investment Status. Click in the field to select a value.  

7.8.9 Editing Additional Fields 

You can edit additional list fields made editable by members of the ARP Admin group (see "9.11 

Configuring List and Filter Fields" on page 156). 
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7.8.10 Copying List Fields 

You can copy editable field values up or down via drag-and-drop. This feature supports lookup fields 

and respects restrictions on column values. 

Copying field values this way requires the start and target row to be of the same type, i.e., 

investment, phase/task, milestone, or assignment. 

For investments, the investment type must also be the same, e.g., project or idea. All custom 

investment types are considered to be the same type for this feature. 
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7.9 Context Menu for Displayed Objects 
Hover over an investment, phase, task, milestone or assignment and click on the three dots that are 

displayed to open the associated context menu. The following sections describe the default options 

available here. Members of the ARP Admin group can hide default options and add additional 

custom options (see "9.10 Defining Actions" on page 154). 

7.9.1 Open Properties 

The Open properties option is available for investments, phases, tasks, milestones and assignments. 

Here you open the associated Clarity PPM detail view. 

> Investment properties open in a new browser tab. 

> Phase, task, milestone and assignment properties open on top of the current tab. 

7.9.2 Create Task 

The Create Task option is available in the context menu for projects, phases and tasks without 

assignments. The latter will become phases when a task is created for them. For details about this 

feature, see the "7.10.1 Creating Tasks, Milestones and Phases" section on page 102. 

7.9.3 Autoschedule 

The Autoschedule option is available in the context menu for projects and applies the Clarity PPM 

standard process for autoscheduling a project. 

Autoschedule a project as follows: 

> Hover over the desired project. 

> Click on the three dots displayed next to the project’s name. 

> Select the Autoschedule option to open the associated overlay window: 

 

> This offers exactly the same options as the autoscheduler for the PPM Gantt view, except for the 

Publish after Scheduling option, which is not available in itd Advanced Resource Planning. 

When you confirm by clicking OK, autoscheduling of the project will instantly be initiated.  

Please refer to the Clarity PPM documentation for information about the autoscheduler.  
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7.9.4 Allocate From Estimates 

The Allocate From Estimates option is available for investments and task assignments. 

For each team entry of the selected investment or for the team entry of the selected assignment, this 

will enter the sum of the estimated effort entered for associated assignments as allocation. This 

action will be directly applied without further confirmation. 

7.9.5 Indent or Outdent Task 

The Indent Task and Outdent Task options are available for phases, tasks and milestones. Here you 

include them in a preceding task or phase or remove them from one. 

See section "7.10.3 Indenting and Outdenting Tasks" on page 102 for details about this. 

7.9.6 Delete 

The Delete option is available for tasks and assignments without actuals as well as for milestones. 

You will be asked to confirm before anything is deleted.  

You can only delete phases after outdenting or deleting any included tasks and milestones. 

7.9.7 Unassign to Effective Role 

The Unassign to Effective Role option is available for assignments of resources and teams without 

actuals. The assignment will be reset to its effective role. If that role already as a team entry in the 

investment, a new team entry will be created for a copy of the role. 

7.9.8 Task Dependencies 

The Task Dependencies option is available for tasks and milestones of projects. 

This will open a window where you can see and edit dependencies between tasks and milestones. 

See section "7.10.5 Creating and Editing Task and Milestone Dependencies" on page 103 for details. 

7.9.9 Remove Lock 

The Remove lock option is available for projects locked due to changes made by users in itd 

Advanced Resource Planning.  

Every user may unlock projects via the context menu that were locked due to their own changes 

made in itd Advanced Resource Planning. 

Members of the ARP Admin group may unlock any projects via the context menu that were locked 

due to changes made by any user in itd Advanced Resource Planning. 

Projects locked due to changes made outside of itd Advanced Resource Planning can only be 

unlocked via the associated button in the project's properties. 

7.9.10 Expand All 

The Expand all option is available for investments and phases. 

Select this to expand the full sub-structure of the selected investment or phase. 

7.9.11 Rename 

The Rename option is available for investments, phases, tasks and milestones. 

Press [Return] to confirm or [Esc] to cancel. The change will only be applied when saving via the 

toolbar. Refresh without saving to undo. 
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7.9.12 Show candidates (by Role, OBS and Skills) 

The Show candidates (by Role, OBS and Skills) option is available for role assignments. 

This will apply the following filters to the Resources list, adding missing filter fields automatically: 

> Primary Role will be the selected role. 

> Resource OBS Unit will be the Staff OBS Unit of the associated team entry, if selected. 

> Skills will be the skills selected for the associated team entry, if any. 

> Skill Matching will require to match all skills (alternatively, you can require to match at least one). 

7.9.13 Show Investment Team 

The Show Investment Team option is available for investments. This filters the resource list by the 

selected investment, such that only that investment's team members are displayed. 
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7.10 Working with Tasks, Milestones and Phases 
The following sections describe creating and editing tasks, milestones and phases for a project or 

custom investment type. 

7.10.1 Creating Tasks, Milestones and Phases 

Create a task for an investment, phase or task as follows. Creating a task for another task makes the 

latter a phase. Please note that this is only possible for tasks without assignments. 

> Hover over the desired investment or phase. 

> Click on the three dots displayed next to the name of the investment or phase. 

> Select the Create Task option to insert a new row for the new task. 

> In the menu at the left edge of the new task row, select the desired task type: Task, Key task, 

Milestone or Key Milestone. 

> Enter the desired Name, Start, Finish and/or Duration. 

> If Auto-numbering is disabled for the ID field of tasks, you can enter the desired ID. 

> Click on the Save button in the toolbar to confirm. To cancel, click on the Refresh button in the 

toolbar and select No when asked whether pending changes should be saved. 

7.10.2 Working with Phases 

You can turn any task without assigmments into a phase by creating another task for it (see "7.10.1 

Creating Tasks, Milestones and Phases" on page 102) or by indenting a task, milestone or phase 

following it (see the following section "7.10.3 Indenting and Outdenting Tasks"). 

After converting a task into a phase, you can create additional tasks and milestones for it via the 

associated context menu (see "7.10.1 Creating Tasks, Milestones and Phases" on page 102). You 

can also add existing tasks, milestones and phases to a phase via drag-and-drop (see "7.10.4 Moving 

and Copying Tasks, Milestones and Phases" on page 103) or by indenting them (see the following 

section "7.10.3 Indenting and Outdenting Tasks"). 

The depth of phases and sub-phases is unlimited. 

Outdenting or deleting all associated tasks, milestones and phases will turn a phase back into a task. 

7.10.3 Indenting and Outdenting Tasks, Milestones and Phases 

You can indent a task, milestone or phase under a phase or under another task without assignments, 

making the latter a phase. Outdent or delete all tasks, milestones and phases belonging to a phase to 

make that phase a task again. Indent or outdent via the context menu in the left hand side hierarchic 

list view. To open the context menu, hover over the desired task or milestone and click on the three 

dots, then select the desired action: 

> Indent Task following a phase or another task. 

> Outdent Task moves an indented task, milestone or phase up one level. Outdent all tasks, 

milestones and phases belonging to a phase to make it a task again. 

You can also change the structure level of a task, milestone or phase by adding it to an existing 

phase or by removing it from a phase via drag-and-drop (see "7.10.4 Moving and Copying Tasks, 

Milestones and Phases" on page 103).  

The indenting and outdenting of tasks will be directly applied without confirmation. 
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7.10.4 Moving and Copying Tasks, Milestones and Phases 

You can modify the order and hierarchy of tasks, milestones and phases via drag-and-drop. Changes 

will instantly be applied without confirmation. 

Hold the [Ctrl] key while executing the listed steps to copy the selected object instead of moving it. 

This is only possible for objects whose ID doesn't already exist in the target project or is empty. 

Phases will be copied with their full sub-structure. 

Assignments will also be copied. Please note that this may require creating team entries for 

assigned resources, roles and teams. In this case, you will need the Resource – Soft Book right in 

addition to the Project – Edit right to perform this operation. 

> To this end, click on the icon of the object you want to move, hold the mouse button and drag the 

object to its target position. 

> Drag up to insert before or down to insert after the target object. 

> Release the mouse button to perform the action. 

7.10.5 Creating and Editing Task and Milestone Dependencies 

Task and Milestone Dependencies are only supported in projects. 

Satisfied dependencies between tasks and milestones will be displayed in the Gantt chart as blue 

arrows. Violated dependencies will be displayed as red arrows. You can open a list view of a task’s or 

milestone’s dependencies, in which you can also create new dependencies, as follows. 

> Double-click on a dependency in the Gantt chart OR 

> Hover over a task or milestone in the left hand side hierarchic list, click on the three dots and 

select the Task Dependencies option from the associated context menu. 

Either of these actions will open the Task Dependencies view for the selected task or milestone: 
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> To create a new dependency, enter parameters in the upper half of the view under Create New 

Dependency. Enter a daily or percentual Lag to require a delay between the predecessor and its 

successor. If you enter a percentual lag, specify the duration of the required delay as a 

percentage of the predecessor’s duration. Click on Add in the toolbar in the middle to create the 

dependency. 

With the Move successors on dependency creation option selected in the General tab of the 

Preferences, new dependencies that are initially violated will automatically be satisfied by moving 

the selected successor and any of its own successors ahead. Please note that existing violated 

dependencies between the successor and its own successors won't be satisfied in this process. 

Also, if the selected successor or any of its successors has actuals or the Exclude from 

Autoscheduling property, that task or milestone and its successors won't be moved. 

> Select fields in the list in the lower half of the view to edit them. 

> Select a dependency in the list in the lower half of the view and click Delete to delete it. 

> Select a dependency in the list in the lower half of the view and click Open to open its detail view. 
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7.11 Interactive Gantt Bars 
In Assignments by Investment mode, you can toggle the display of interactive Gantt bars separately 

for investments, tasks, phases and milestones as well as assignments via the Visualization menu in 

the toolbar. When Gantt bars for tasks and milestones are turned on, their dependencies will also be 

displayed. Additionally, you can highlight critical paths for projects via the Visualization menu. 

7.11.1 Gantt Bars for Investments 

Gantt bars for investments will be displayed when selecting Show Gantt Bars for Investments in the 

Visualization menu in the toolbar. 

Via drag and drop, you can shift and resize Gantt bars for non-project investments, but not for 

projects and custom investment types. 

Changes made to non-project investments will also be applied to all associated assignments, even if 

they aren't displayed. Shifting a non-project investment will shift all associated assignments 

accordingly. Resizing a non-project investment will resize all associated assignments proportionally 

(e.g., reducing an investment's duration from 8 to 6 weeks will reduce an associated assignment 

from 4 weeks to 3 weeks). 

This will also redistribute the ETC values displayed per period for all affected assignments over the 

capacity of the respective resource, role or team during the assignment's new duration, with the 

same proportions as before the change. 

The Start and Finish of projects and custom investment types depend on the associated phase, task 

and milestone dates and may not be modified directly. 

7.11.2 Gantt Bars for Tasks and Phases 

Gantt bars for tasks and phases, as well as diamond shapes for milestones and dependencies 

between tasks and milestones will be displayed when selecting Show Gantt Bars for Tasks and 

Phases in the Visualization menu in the toolbar. 

In Assignments by Investment mode, you can shift and resize Gantt bars for tasks and phases via 

drag and drop. You can also shift milestones via drag-and-drop. 

You can only cange the Start and Finish of tasks while the status is Not started and no actuals exist 

for them. The status check can be turned off (see "9.12.25 Edit Start and Finish of Tasks and 

Assignments Regardless of Status on page 169). 

Shifting or resizing a phase will shift or resize associated tasks and milestones accordingly. (e.g., 

reducing an phase's duration from 8 to 6 weeks will reduce an associated task from 4 weeks to 3 

weeks). In the same way, shifting or resizing a task directly or indirectly via a phase will affect 

associated assignments proportionally. 

This will also redistribute the ETC values displayed per period for all affected assignments over the 

capacity of the respective resource, role or team during the assignment's new duration, with the 

same proportions as before the change. 

Shifting or extending a task or milestone beyond the Start or Finish of the associated phase will also 

extend the phase, such that it includes the task or milestone. Likewise, extending a phase will extend 

the associated project, if required. 

Shortening a task or phase has no effects on their parent objects. 
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7.11.3 Gantt Bars for Assignments 

Gantt bars for assignments will be displayed when selecting Show Gantt Bars for Assignments in 

the Visualization menu in the toolbar. 

While Gantt bars are displayed for assignments, you can't edit the ETC values per period directly. 

You can shift and resize assignments via drag and drop of their Gantt bars. 

You can only cange the Start and Finish of assignments while the status is Not started and no 

actuals exist for them. The status check can be turned off (see "9.12.25 Edit Start and Finish of 

Tasks and Assignments Regardless of Status on page 169). 

Changing an assignment this way will redistribute the ETC displayed per period for the respective 

assignment over the capacity of the assigned resource, role or team during the new remaining 

duration (between Actuals Thru and Finish) with the same proportions as before the change. 

Shifting or extending an assignment beyond the Start or Finish of the associated task or non-project 

investment will also extend the task or investment, such that it includes the assignment. When a task 

is extended this way, the change will also be applied to the associated phase and project, if required 

to include the new task duration. 

Reducing the durations of assignments won't reduce the duration of the associated task, phase or 

investment. 

7.11.4 Creating and Editing Dependencies 

You can create dependencies between tasks and milestones by clicking on the desired predecessor 

and, holding the mouse button, dragging the dependency onto the desired successor. 

When you create a dependency like this, depending on your Preferences and the properties of the 

selected successor and any own successors it may have, those may be moved automatically in 

order to satisfy the new dependency (see "7.10.5 Creating and Editing Task and Milestone 

Dependencies" on page 103). 

Double-click on an existing dependency's arrow to open that dependency for editing. 

7.11.5 Dependencies from Tasks and Milestones Not Currently Displayed 

A special icon indicates dependencies from tasks and milestones that aren't currently displayed. 

This icon next to a task or milestone indicates it has at least one dependency connecting it with 

another task or milestone not currently displayed. The icon will be red when such a dependency is 

violated. Click on the icon to display the associated projects and tasks or milestones. 
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7.11.6 Displaying Critical Paths for Projects 

In the Visualization menu, you can toggle display of critical paths for projects. 

Critical paths are indicated by highlighting the associated tasks in red: 

 

7.11.7 Saving or Reverting Changes 

New dependencies between tasks and milestones of projects will be directly created without 

confirmation. 

Changes made to Gantt bars won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 



itd Advanced Resource Planning 12.2.0 

Assignments by Investment 

 108 

7.12 Utilization and Capacity 
The lower section of the view displays all resources, roles and teams for which you have access 

rights by default. Roles are displayed at the bottom of the list. 

You can select resource fields to display in the Utilization – Columns tab of your Preferences (see 

"7.15.4 Utilization – Columns" on page 120. 

You can filter this view (see "7.12.5 Filtering the View" on page 109). 

Optionally, the capacity and utilization of resources, roles and teams are also displayed. 

 

7.12.1 Visualization: Color-Coded Grid or Histogram 

There are two display modes available for the utilization. In both modes, the displayed utilization is 

based on remaining estimated effort from assignments. 

> With Show Utilization selected in the General tab of the Preferences, the total utilization and 

remaining capacity of the displayed resources, roles and teams will be displayed per period in a 

grid of numbers that are color coded to display low or high utilization. 

Cell colors indicate low (white), optimal (green), high (yellow) or very high (red) utilization of a 

resource, role or team in a period (see "7.15.7 Utilization" on page 123). 

> Alternatively, via Show Histogram in the Visualization menu in the toolbar (regardless of Show 

Utilization), you can display the utilization and capacity as a histogram chart. The chart displays 

the utilization as a colored stack which is matched against a dotted capacity line. 

As in the grid view, signal colors indicate optimal utilization or overload. 

However, only the utilization warning and high utilization thresholds take effect in the histogram: 

• The dotted horizontal line displays the resource, role or team capacity. 

• Workload below the utilization warning threshold is colored green. 

• Further workload between the utilization and high utilization thresholds is colored yellow.  

• Further workload above the high utilization threshold is colored red. 

• The low utilization threshold has no effect here (see "7.15.7 Utilization" on page 123). 

Please note that in single investment mode, the histogram can also be set up to compare the 

Total Effort and the Allocation or Hard Allocation (see "7.12.11 Assignments and Allocations in 

Single Investment Mode" on page 111). 

7.12.2 Utilization and Remaining Capacity 

In this mode, the displayed utilization and remaining capacity are always global, based on the 

remaining estimated effort from all assignments in the respective period, and unaffected by your 

assignment filter. 
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7.12.3 Displaying Actuals 

Optionally, the workload and remaining capacity for the current period include actuals already 

entered for that period (see "9.12.22 Consider Actuals for Remaining Capacity" on page 168). 

When displayed In the grid view, actuals aren't included in the utilization but deducted from the 

remaining capacity. When displayed In the histogram, they are included in the utilization. 

7.12.4 Displaying Utilization and Capacity Details 

Hover over a grid cell or histogram segment to display the associated values. Click on a grid cell or 

histogram segment to display the associated investments. Click on a column header to filter the list. 

Select the columns to display in your preferences, see "7.15.4 Utilization – Columns" on page 120. 

7.12.5 Filtering the View 

Without a filter, any resources, roles and teams for which you have access rights will be displayed.  

Roles are listed at the bottom of the list. Section "4.4 Filtering the Resource, Role and Team List" on 

page 27 describes how you add filter conditions for resources, roles and teams. 

Use the Show Investment Team quick filter in an investment's context menu to only display 

associated team members. 

7.12.6 Selecting a Resource, Role or Team 

When you select a resource, role or team assignment in the left hand side hierarchic list in the upper 

view section, the assigned resource, role or team will also be selected in the utilization view. 

7.12.7 Assigning a Resource, Role or Team via Drag-and-Drop 

Drag a resource, role or team from the utilization view onto a task or non-project investment to 

create a new assignment. 

Hold the [Ctrl] key while dragging a resource, role or team to an existing assignment of another 

resource, role or team to duplicate that assignment in the same task or non-project investment. 

For projects, the Assignment Pool settings are applied when creating new assignments: 

> With the Team only setting, you can add only project members as resources, roles and teams. 

> With the Resource Pool setting, you can add any available resources, roles and teams. 

 Team entries and assignments will only be created when saving via the toolbar. You can easily 

identify unsaved assignments via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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7.12.8 Replacing a Resource, Role or Team via Drag-and-Drop 

To replace the resource, role or team in an existing assignment, drag the replacement resource, role 

or team from the utilization view onto that assignment. 

For projects, the Assignment Pool settings are applied when creating new assignments: 

> With the Team only setting, you can add only project members as resources, roles and teams. 

> With the Resource Pool setting, you can add any available resources, roles and teams. 

You can deactivate the replacement of roles in assignments (see "9.12.29 Disable Role Replacement 

for Assignments" on page 170). 

 Team entries and assignments will only be created when saving via the toolbar. You can easily 

identify unsaved assignments via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

7.12.9 Copying Assignments 

You can copy any assignment by dragging a resource, role or team displayed in the hierarchic list 

onto any other project task or non project investment object. 

This has the advantage that some information will be copied from the original assignment and 

associated team entry: 

> Assignment: Assignment Role, Loading Pattern 

> Team: Staff OBS Unit, Investment Role, Teamname 

Team entry fields will only be copied if a new team entry is created. 

When you copy a resource assignment to an investment in which the selected resource already has 

a team entry, the existing team entry will be used. 

When you copy a role assignment from one investment to another one in which the selected role 

already has a team entry, you will be asked whether to create a new team entry for the role or 

whether to use the existing team entry. This is only possible for roles; resources may not have more 

than one team entry in any investment. 

For projects, the Assignment Pool settings are applied when creating new assignments: 

> With the Team only setting, you can add only project members as resources, roles and teams. 

> With the Resource Pool setting, you can add any available resources, roles and teams. 

 Team entries and assignments will only be created when saving via the toolbar. You can easily 

identify unsaved assignments via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 



itd Advanced Resource Planning 12.2.0 

Assignments by Investment 

 111 

7.12.10 Creating Multi-Role Assignments 

In Assignments by Investment mode, you can assign roles to tasks and non-project investments 

multiple time by creating an indexed copy of the role, (e.g., "Architect" becomes "Architect (2)".) 

> Drag the role from the resource list onto a task or non-project investment. 

> If the role already has an assignment in the task or investment, you will be prompted to create a 

new team entry for a copy of the role with a name or your choice, which will be the role's original 

name with an index by default. 

 

You can deactivate this dialog, such that a multiple role allocation will automatically create a new 

team entry for a copy of the role (see "9.12.28 Automatically Create New Team Entries for Roles" on 

page 170). 

> Team entries created this way will be retained even if all associated assignments are deleted. 

> Dragging a role onto an investment where it already has a team entry will prompt you to select an 

existing team entry for the new assignment or to create a new team entry for the role. You may 

only select existing team entries without assignments for the task or non-project investment. 

 Team entries and assignments will only be created when saving via the toolbar. You can easily 

identify unsaved assignments via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

7.12.11 Assignments and Allocations in Single Investment Mode 

In single investment mode, you can graphically compare the total estimated effort (Actuals + ETC) of 

assignments to the planned or hard allocation of the associated team entries. 

Select the value to compare in the Layout tab of the Preferences (see "Histogram Comparison 

(Single Investment Mode Only)" on page 124). Hover over the histogram to display units and figures. 

Please note: As opposed to the default mode of the histogram which shows the global utilization of 

all displayed resources, roles and teams, when comparing assignments with the planned or hard 

allocation, only values entered for the current investment will be displayed. 

Use the Team – Team only filter to hide resources, roles and teams that have no team entries in the 

current investment 

Use the context menu for the investment or for any assignment to Allocate from Estimates. 

For each team entry of the selected investment or for the team entry of the selected assignment, this 

will enter the sum of the estimated effort entered for associated assignments as allocation. 

This action will be instantly applied without further confirmation. 
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7.12.12 Open Detailed View (Additional Module Not Available by Default) 

Click on the Detailed view button in the toolbar to open an overview of tasks and assignments of 

resources displayed in the associated list as selected via filters. 
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7.13 Hierarchy Mode 
You can integrate itd Advanced Resource Planning in the Hierarchies module for hierarchies of the 

Investment type. 

Please note that the hierarchy mode feature is only available after adding an itd Advanced Resource 

Planning channel to the hierarchy blueprint (see "9.7 Planning Modes” on page 152). 

With the hierarchy mode, hierarchies offer an itd Advanced Resource Planning tab. 

 

In this mode, the view is automatically filtered to display only investments included in the hierarchy. 

You can display and sort by the Hierarchy Level field, which displays an investment’s hierarchy level. 

Please note: This mode is currently in the beta phase and is included as a preview. Further features 

are planned. We look forward to receiving feedback on this mode. 
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7.14 Toolbar Features 
In Assignments by Investment mode, you have access to the following features in the toolbar. 

7.14.1 View 

The View menu at the top left displays the active view and allows switching views, saving the current 

view under a new name and editing your favorites and view sharing settings under Manage. 

If you have the right to save changes to the current view, the Save View button is active. If it isn't, you 

can still save a copy of the current view. 

You can find details of the features available here under "3 Views" on page 22. 

7.14.2 Display Period 

To the right of the View menu, you have access to various controls for changing the display period. 

The slice period and number of slices are saved with the view and are synchronized with the 

Timeslices tab of the Preferences (see "7.15.2 Timeslices" on page 118). 

Most options available there are also available in the toolbar, with the exception of fiscal periods as 

slice periods. 

The start date won't be saved. The view automatically starts with the current date. 

 Previous Periods: Here you switch back by the selected display period (e.g., 6 months). 

 Previous Period: Here you switch back by the selected slice period (e.g., 1 month). 

 Slice Period and Number of Slices: Select the slice period (e. g, months) and enter the number of 

slices in the field or use the buttons to raise or lower the number. 

Then click on Show to update the view with the new slice settings. 

 Jump to a Certain Date: Here you select the view's start date in a calendar view. 

 Next Period: Here you switch ahead by the selected slice period (e.g., 1 month). 

 Next Periods: Here you switch ahead by the selected display period (e.g., 6 months). 

7.14.3 Refresh and Save 

Use the Refresh and Save buttons to discard or save your changes. 

 Refresh: This will reload all data. If there are unsaved changes, you will be asked if you want to 

save first. Answering no will discard your changes. 

 Save: This will save all unsaved changes you have made in the current view. 

7.14.4 Export to Excel 

You can export all rows and columns of the upper view to Microsoft Excel. 

 Export to Excel: Here you export the upper view to Microsoft Excel. 

The data will be exported as displayed, with the same filter settings and with all rows and 

columns that are currently displayed. For list entries with sub-elements, these sub-elements will 

only be exported if their parent item has been expanded, such that they are currently visible. 

The Excel export is limited to a maximum of 15,000 rows. 
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7.14.5 Visualization 

In Assignments by Investment mode, you have access to the following options under Visualization. 

 Visualization 

 Show Assignments: Here you toggle displaying of assignments. 

Without assignments, the view will load faster and display only investments, phases, tasks and 

milestones. See section "7.1.2 Displaying Assignments" on page 91 for details. 

 Show Critical Path: Here you toggle displaying of critical paths for projects in the Gantt chart. 

See section "7.11.6 Displaying Critical Paths for Projects" on page 107 for details. 

 Visualization > Cell: Here you toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "7.3 Displaying Trend Arrows" on page 92. 

 Visualization > Gantt Bars: Here you toggle the display of Gantt bars for investments, tasks, 

phases and assignments, see "7.11 Interactive Gantt Bars" on page 105. 

 Visualization > Utilization 

 Show Histogram: Here you switch between the two display modes for the utilization and 

capacity of resources, roles and teams, see "7.12 Utilization and Capacity" on page 108. 

7.14.6 Preferences 

 Preferences: Here you configure other view settings such as display fields and filter fields, see 

"7.15 Preferences" on page 116. Preferences will be saved separately for each view. 

7.14.7 Help 

 Help: Here you can find information about itd Advanced Resource Planning and about asking for 

support. If you do, please always specify your version, which you can find under Info. 

7.14.8 Fullscreen 

 Fullscreen: In full screen mode, the Clarity PPM navigation will be hidden, such that more items 

can be displayed in itd Advanced Resource Planning. 

You can turn the navigation back on using the same button. 
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7.15 Preferences 
Click on the Preferences button in the toolbar to edit view options. 

7.15.1 General 

Settings in the General tab control the display and behavior of the current view. 

 

> Toolbar Only with Icons: select this to hide the captions on buttons with icons, reducing the width 

of the toolbar.  

> Show Utilization: when the histogram isn't displayed, this setting controls whether the global total 

utilization and remaining capacity of roles, resources and teams are displayed per period in the 

resource list. The setting has no effect on the histogram. 

> Calculate Sums: specify here whether totals of the workload fields (in the assignment modes: 

Estimated Effort, Actuals and Total Effort) should be calculated and displayed for all aggregation 

levels (In this mode: task, phase and investment). 

You can choose between On (display global sums), Filtered (apply assignment filter to global 

sums) and Off (don't calculate sums). 

This setting affects the loading time, with Off being the fastest and Filtered the slowest method. 

> Show Phases: specify here whether to display phases between investments and associated 

tasks. If phases are not displayed, tasks associated with phases will be displayed directly under 

their respective investments. 

> Show Milestones: specify here whether milestones should be displayed. 

> Show Assignments of Inactive Resources: display or hide assignments of inactive resources. 

> Update Allocation: specify here whether assignments entered for tasks should automatically be 

entered as allocation in the associated projects as well. 

> Load Data on Startup: specify here whether data is loaded directly when opening itd Advanced 

Resource Planning or only after clicking the filter button. 

> Use Clarity PPM’s Calculated Investment Sums: this option depends on the Calculate Sums 

option and will only take effect if that option is set to On or Filtered. Select this to always display 
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the sums calculated by Clarity PPM for investments, which are also displayed in investment lists, 

instead of letting itd Advanced Resource Planning calculate these sums . 

> Move Successors on Dependency Creation: with this option, new dependencies that are initially 

violated will automatically be satisfied by moving the selected successor and any of its own 

successors ahead. Please note that existing dependencies between the successor and its own 

successors that are already violated won't be automatically satisfied in this process. 

Also, if the selected successor or any of its successors has actuals or the Exclude from 

Autoscheduling property, that task or milestone and its successors won't be moved. 

> Show Investment Hierarchy: in Assignments by Investment mode, select this to display parent 

and sub-investments of investments explicitly selected via your assignment filter (see "4.8.2 

Selecting Investment Hierarchies in by Investment Modes" on page 30). 

Hiding investment hierarchies may speed up loading the view. 
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7.15.2 Timeslices 

Settings in the Timeslices tab control the time axis scale and display period. 

 

> Slice Period: enter the planning period here. Possible settings are Days, Weeks, Months, 

Quarters, Calendar Years and, if configured, Fiscal Period. 

The selection of available slice periods may be limited by Clarity PPM application administrators 

via the itd AE Preferences lookup (see "9.12.3 Restrict Time Slice Periods in the Preferences and 

in the Toolbar" on page 161). In this case, only options enabled via the associated lookup value 

will be available here and in the toolbar of itd Advanced Resource Planning. 

> Fiscal Entity and Fiscal Period: with the Fiscal Period setting, if multiple fiscal entities or periods 

have been defined in your Clarity PPM system, select the desired fiscal entity and period here. 

> Work Effort Unit: specify the unit for efforts here. By default, the System Standard will be applied. 

Alternatively, Hours, Days or full time equivalents (FTE) are available for selection here. 

> Slice Count: enter the amount of slices to be displayed. 

> Decimal Places: enter the desired number of decimals for entering and displaying assignments 

and allocations. 
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7.15.3 Columns 

In the Columns tab, you select the columns to display in the list at the top left of the current view. 

 

The following fields are always displayed in the first column: 

> Name (investment, phase, task, milestone, resource/role/team) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following fields can be selected for display by default: 

> Actuals, Est. Effort, Total Effort (investment, phase, task, assignment): worked, remaining and 

total hours; the Total Effort field displays the sum of Est. Effort and Actuals. 

> Duration (phase, task, assignment): duration in work days according to the base calendar; 

editable 

> Effective Role (assignment): resource/role/team assignment role 

> Effective Role (team entry): resource/role/team investment role 

> Effective Role (role): parent role 

> Effective Role (resource): primary role 

> ID (investment, phase, task, milestone, resource/role/team) 

> Investment Status (investment): editable 

> Investment Type (investment) 

> Loading Pattern (assignment): editable 

> Staff OBS Unit (team entry): editable 

> Start, Finish (investment, phase, task, milestone, assignment): editable for phases, tasks, 

milestones and assignments 

> Display ETC Sums outside of Visible Time Range: see page 94. 

Members of the ARP Admin group may add to the selection and enable editing for other fields 

available for investments, investment sub-types, resources, roles, teams; team entries; tasks and 

assignments. This includes most Clarity PPM standard fields and most custom fields defined for 

these objects. See section "9.11 Configuring List and Filter Fields" on page 156 for details. 
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7.15.4 Utilization – Columns 

In the Utilization – Columns tab, you select the columns to display in the utilization view’s resource 

list at the bottom left and in the capacity popup that opens when clicking on a utilization segment. 

 

The following information is always displayed in the first column of the resource list: 

> Icon (resource/role/team) 

> Name (resource/role/team) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following additional resource list fields can be selected by default: 

> Department (resource/team) 

> Department OBS, Location (resource/team) 

> Is External (resource/role/team) 

> Manager (resource/role/team) 

> Skills (resource/role/team) 

The following information is always displayed in the capacity popup: 

> Type Icon and Name (investment) – first column 

> Segment Utilization (assignments) – last column 

The following additional team entry fields can be selected for the capacity popup by default: 

> Start, Finish (team entry) 

> Staff OBS Unit (team entry) 

> Default Allocation (team entry) 

> Effective Role (team entry) 

> Skills (role team entry) only with skills hierarchy, see "9.12.6 Use Old Skills Hierarchy", page 162. 

Members of the ARP Admin group may add other fields available for resources, roles and teams or 

for team entries to these selections. This includes most Clarity PPM standard fields and most 

custom fields defined for these objects. See "9.11 Configuring List and Filter Fields" on page 156. 
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7.15.5 Filter – Assignments 

In the Filter – Assignments tab, you select filter fields for the assignment filter. This lets you filter the 

current view by investments, resources/roles/teams, team entries, tasks and assignments. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See section "4.8 Default Filter Fields for the Main View" on page 28 for details about the default filter 

fields. 

Members of the ARP Admin group may add to the selection other fields available for investments, 

investment sub-types, resources, roles, teams; team entries; tasks and assignments. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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7.15.6 Filter – Resources 

In the Filter – Resources tab, you select filter fields for the resource panel. This lets you filter the 

displayed resources, roles and teams. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See section "4.9 Default Filter Fields for the Utilization View" on page 35 for details about supported 

default filter fields. 

Members of the ARP Admin group may add to the selection other fields available for resources, roles 

and teams.  

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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7.15.7 Utilization 

Settings in the Utilization tab control the display and calculation of the utilization. 

In Assignments by Investment mode, the utilization will be calculated from assignments. 

 

> The Utilization Rate controls the visualization of low or high utilization. 

• Low Utilization at and Below: upper utilization boundary below which resources, roles and 

teams will be marked as lowly utilized with a grey background in the respective period. 

Utilization between the thresholds for low utilization and utilization warning (e.g., above 80% to 

100% as according to the screenshot) will be marked as optimal with a green background. 

This threshold value has no effect in the histogram. 

• Utilization Warning Above: lower utilization boundary above which resources, roles and teams 

will be marked as slightly over-utilized with a yellow background in the respective period. This 

applies as long as the utilization stays at or below the lower boundary for high utilization. 

In the histogram, workload is colored green up to this threshold value. 

• High Utilization Above: lower boundary above which resources, roles and teams will be 

marked as highly over-utilized with a red background in the respective period. 

In the histogram, workload is colored yellow up to this threshold value and red above. 
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7.15.8 Layout 

Settings in the Layout tab control the additional display value in the right hand side assignment grid 

as well as sorting fields for investments, tasks and assignments. 

In single investment mode, you also select display values for the histogram here. 

 

> Cell Configuration: Here you select a Field to Display on the Left Part of the Cell and enter a 

treshold value for trend arrows, when active. 

In Assignments by Investment mode, the assignment value is always displayed on the right. 

• Field to Display on the Left Part of the Cell: Empty (no field), ETC, Actuals, Capacity or a 

custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

• Tolerance of Deviation: Treshold value for displaying trend arrows to indicate a deviation of 

the left cell value from the right one when activated via Visualization. 

This setting only affects the right hand side assignment grid. The left hand side sum columns 

(Estimated Effort, Actuals, Total Effort or custom time scaled monetary values) can be displayed 

or hidden via the Columns tab (see "7.15.3 Columns" on page 119). 

To display aggregated totals for tasks, phases, and investments in the assignment grid and sum 

columns, set Calculate Sums to On or to Filtered in the General tab (see "Calculate Sums" on 

page 116). 

> Histogram Comparison (Single Investment Mode Only) 

• ETC vc. Capacity: Colored column displays ETC, dotted line displays Capacity. 

• Effort vs. Allocation: Colored column displays total effort (Actuals + ETC), dotted line displays 

Allocation. 

• Effort vs. Hard Allocation: Colored column displays total effort (Actuals + ETC), dotted line 

displays Hard Allocation. 

> Sorting: In addition to the fields listed here, any custom fields without lookups are available. If you 

don't select the respective default field, items will be sorted by that field on the second level. 

• Sort Investments By: Investment Type or Name (Default). 

• Sort Tasks By: Finish Date, Name, Start Date or WBS Sort (Default). 
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Moving, indenting and outdenting tasks is only possible with WBS Sort. 

• Sort Assignments By: Effective Role, Finish Date, Name (Default) or Start Date. 

> Browser Specific Layout Configuration: Here you can select to Use Colors with Higher Contrast. 

This setting will affect all your views in itd Advanced Resource Planning. 
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8 Assignments by Resource 

The Assignments by Resource mode groups investments, tasks and assignments by the assigned 

resources, roles and teams. 

Their utilization and capacity are displayed directly in the right hand side assignment grid view. 

Editing project structures isn't possible in this mode. 

 

8.1 Displayed Data 
In Assignments by Resource mode, the following data will always be displayed: 

> Resources, roles and teams 

> Investments (custom types included) with team entries for displayed resources, roles and teams 

> Associated tasks and assignments 

> Team entries without assignments 

> You can limit the selection of data records via filter conditions (see "4 Filters" on page 25). 

8.1.1 Show Utilization 

With the Show Utilization option selected in the General tab of the Preferences, the utilization and 

capacity of a resource, role or team will be displayed in the associated row (see "8.11 Utilization and 

Capacity" on page 134). 

8.1.2 Assignments to Non-Project Investments 

For each non-project investment, a task with the same name will be displayed under which 

associated assignments are listed. 

8.1.3 Roles with Multiple Assignments 

For roles assigned multiple times to a project task or non-project investment, the associated task will 

be displayed once for each assignment of the role. 

8.1.4 Task and Assignment Fields 

Tasks and associated assignments will be displayed in the same row. All displayed fields that exist 

for assignments as well as the assignment values will be taken from the assignment. Fields only 

existing for tasks (e.g., ID or additional fields only existing for tasks) will be taken from the task. 

8.1.5 Displaying Phases and Parent Investment Hierarchies 

Displaying phases and parent investment hierarchies is optional and can be toggled for each in the 

General tab of the Preferences. 
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8.2 Displayed and Editable Values per Period 
In the Layout tab of the Preferences, you can select an optional display value for assignments per 

period (see "Field to Display on the Left Part of the Cell" on page 144). 

> Field to Display on the Left Part of the Cell (optional): Empty (no field), ETC, Actuals, Capacity or 

a custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

> Field Displayed on the Right Part of the Cell (Assignment): In Assignments by Resource mode, 

the assignment value is always displayed on the right. This is also the base of the displayed 

utilization and capacity (see "8.11 Utilization and Capacity" on page 134). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.8 Show Grid Hints for by Resource Views" on page 162). 

8.3 Displaying Trend Arrows 
Via the Visualization menu, you can display trend arrows comparing the left and right cell values, see 

"Visualization > Cell" on page 137. 

 

For instance, this can help you to easily compare actuals with the originally planned values. 

Wherever both values are present and different, a little arrow at the left cell edge visualizes a negative 

or positive deviation of the left cell value from the right cell value. 

In the Layout tab of the Preferences, you can set a threshold percentage In the Layout tab of the 

Preferences, you can set a threshold percentage for the minimal deviation to visualize via arrow, see 

"Tolerance of Deviation" on page 144. 

8.4 Displaying Investment Descriptions 
Hover over an investment to display its description. 

This feature may be deactivated via the itd AE Preferences Lookup by Clarity PPM application 

administrators (see "9.12.26 Hide Description Tooltips" on page 169). 
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8.5 Estimated Effort, Actuals and Total Effort 
In the Columns tab of the Preferences, you can display or hide the Estimated Effort, Actuals and 

Total Effort (Estimated + Actuals) fields in the left hand side list (see "8.14.3 Columns" on page 141). 

The fields display the respective values for each assignment. 

With Calculate Sums in the General tab of the Preferences, aggregated sums will also be displayed 

per phase, investment and resource, role or team. Depending on your selection, global sums (On) or 

Filtered sums (using the assignment filter) will be displayed (see "Calculate Sums" on page 138). 

You can edit the Estimated Effort for assignments by entering a value (see "8.8.2 Editing the 

Estimated Effort of Assignments" on page 130). 
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8.6 Editing Assignments 
With Show Gantt Bars for Assignments turned off in the Visualization menu in the toolbar, you can 

edit the ETC per period that is displayed in the right half of each cell. Click on the right half of a cell to 

edit its value. The white background of a cell or its right half indicates that the value can be edited. 

The left half of a cell displays Actuals, Capacity or any custom time scaled monetary value (see 

"Field to Display on the Left Part of the Cell" on page 144). 

The configured values will be displayed when hovering over the assignment grid with the associated 

preferences setting (see "9.12.8 Show Grid Hints for by Resource Views" on page 162). 

The Estimated Effort will automatically be updated with the sum of efforts per period you enter.  

Entering workload outside the duration of an assignment will expand it accordingly. If required, 

parent objects will also be expanded, such that they include the assignment. 

Alternatively, enter the total Estimated Effort for an assignment in the associated column (see "8.8.2 

Editing the Estimated Effort of Assignments" on page 130). 

With Update Allocation in the General tab of the Preferences, the new assignment values will also 

be entered as allocation for the same periods. 

8.6.1 Copying Grid Cells via Drag and Drop 

Via drag and drop, you can copy the value of a grid cell to neighboring cells, either horizontally, on the 

timeline, or vertically, to other tasks: 

> Click in the cell you wish to copy, hold the mouse button and drag in the desired direction. 

> Release the mouse button when you're done to copy the selected assignment value to all grid 

cells you touched while dragging. 

> Save your changes via the toolbar or Refresh without saving to revert your changes. 

8.6.2 Display ETC sums outside of visible time range 

Via Columns in the Preferences, you can display ETC sums for assignmens that are before or after 

the visible period. The ETC before and ETC after columns display the total hours before or after the 

visible period. Click on values in these columns to shift the visible period there. 

8.6.3 Display Options 

Use the buttons and menus in the toolbar to select the start date and period and to specify how 

many periods to display at once. Display options for this view are also available in the Timeslices tab 

of the Preferences (see "8.14.2 Timeslices" on page 140). 

8.6.4 Saving or Reverting Changes 

Changes made to assignments won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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8.7 Editing Custom Time Scaled Monetary Values 
Editing custom time scaled monetary values works the same as in Assignments by Investment 

mode (see "7.7 Editing Custom Time Scaled Monetary Values" on page 95). 

8.8 Editing List Fields 
In Assignments by Resource mode, the left hand side hierarchic list supports editing of the Start, 

Finish, Estimated Effort and Loading Pattern assignment fields, of the Staff OBS Unit team entry 

field, of the ID phase field and of most additional fields, if editing was enabled for them by members 

of the ARP Admin group (see "9.11 Configuring List and Filter Fields" on page 156). 

Renaming investments, phases and tasks is not possible in this view mode. 

Click on any field you wish to edit and enter or select the desired value. 

 Changes will only be applied when you save them via the toolbar. You can easily identify unsaved 

changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 

8.8.1 Editing the Start and Finish of Assignments 

You can edit the Start and Finish of assignments in the list while the status is Not started and no 

actuals exist for them. The status check can be turned off (see "9.12.25 Edit Start and Finish of 

Tasks and Assignments Regardless of Status on page 169). 

Changing an assignment this way will redistribute the ETC over the working hours during the 

assignment's new remaining duration (Actuals Thru until Finish) in the same proportions as before 

the change. You can then no longer edit the ETC per period until you save or revert the change. 

With Update Allocation in the General tab of the Preferences, the updated assignment values will 

also be entered as allocation for the same periods. 

Shifting or extending an assignment beyond the Start or Finish of the associated task or non-project 

investment will also extend the task or investment, such that it includes the assignment. Extending a 

task this way will also extend the associated phase and project, if required to include the new task 

duration. Shortening assignments won't shorten the associated task, phase or investment. 

8.8.2 Editing the Estimated Effort of Assignments 

You can edit the Estimated Effort of assignments in the list. The entered value will be distributed 

evenly over the assignment's new remaining duration (between Actuals Thru and Finish), overwriting 

any previous planning. The effort per period can then no longer be edited until the changes are 

applied or rejected. 

With Update Allocation in the General tab of the Preferences, the new assignment values will also 

be entered as allocation for the same periods. 
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8.8.3 Editing a Custom Time Scaled Monetary Value for an Assignment 

You can edit any custom time scaled monetary value displayed as a visible column for an 

assignment in very much the same fashion as for editing the Estimated Effort. 

To do this, click into the field in the associated row and enter the desired value. 

> Changing a custom time scaled monetary value for an assignment will distribute that value over 

the working hours during the assignment, overwriting the previous planning, considering the 

Loading Pattern. 

8.8.4 Editing the Loading Pattern of Project Task Assignments 

You can edit the Loading Pattern of project task assignments. Click in the field to select a value. 

8.8.5 Editing the Staff OBS Unit of Team Entries 

You can edit the Staff OBS Unit field of team entries in the list. To do this, click in the field. Click on 

the magnifier icon to select an OBS unit or the trashcan icon to clear the field. 

8.8.6 Editing the ID of Phases 

If Auto-numbering is disabled for the ID field of tasks, you can edit the IDs of phases. You cannot 

edit the IDs of roles, resources, investments and tasks displayed in this view.  

8.8.7 Editing Additional Fields 

You can edit most additional list fields for which members of the ARP Admin group have enabled 

editing (see "9.11 Configuring List and Filter Fields" on page 156). 

8.8.8 Copying List Fields 

You can copy editable field values up or down via drag-and-drop. This feature supports lookup fields 

and respects restrictions on column values. 

Copying field values this way requires the start and target row to be of the same type, i.e., 

resource/role/team, investment, phase, task or assignment. 

For investments, the investment type must also be the same, e.g., project or idea. All custom 

investment types are considered to be the same type for this feature. 
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8.9 Context Menu for Displayed Objects 
Hover over a resource, role, team, investment or task and click on the three dots that are displayed to 

open the associated context menu. 

The following sections describe the default options available here. 

Members of the ARP Admin group can hide default options and add custom options (see "9.10 

Defining Actions" on page 154). 

8.9.1 Open Properties 

The Open properties option is available in the context menu for roles, resources, investments, 

phases and tasks. Here you open the associated Clarity PPM detail view. 

> Resource, role, team and investment properties open in a new browser tab. 

> Phase and task properties open on top of itd Advanced Resource Planning. 

8.9.2 Add Assignment 

The Add Assignment option is available in the context menu for resources, roles and teams. 

Here you open a selection of available projects with tasks. You can select any number of tasks. Once 

you click on Add to confirm, assignments for the selected tasks will be directly created and 

displayed. 

8.9.3 Allocate From Estimates 

The Allocate From Estimates option is available in the context menu for tasks. 

For the team entry of the task's assignment, this will enter the sum of the estimated effort entered 

for associated assignments as allocation. 

This action will be directly applied without further confirmation. 

8.9.4 Delete 

The Delete option is available in the context menu for tasks with assignments without actuals. 

Here you delete the associated assignment. Before it is deleted, you will be asked for confirmation.  

Assignments with actuals can't be deleted. 

Deleting other objects isn't supported in Assignments by Resource mode. 

8.9.5 Remove Lock 

The Remove lock option is available in the context menu of projects locked due to changes made by 

users in itd Advanced Resource Planning. 

Every user may unlock projects via the context menu that were locked due to their own changes 

made in itd Advanced Resource Planning. 

Members of the ARP Admin group may unlock any projects via the context menu that were locked 

due to changes made by any user in itd Advanced Resource Planning. 

Projects locked due to changes made outside of itd Advanced Resource Planning can only be 

unlocked via the associated button in the project's properties.  

8.9.6 Expand All 

The Expand all option is available in the context menu for roles, resources and phases. 

Select this to expand the full sub-structure of the selected investment or phase. 
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8.10 Interactive Gantt Bars 
In Assignments by Resource mode, you can toggle the display of interactive Gantt bars separately 

for investments, phases and assignments via the Visualization menu in the toolbar. 

In this mode, you can only shift and resize assignments via drag and drop of their Gantt bars. 

Critical paths for projects aren't available in this mode. 

8.10.1 Gantt Bars for Investments 

Gantt bars for investments will be displayed when selecting Show Gantt Bars for Investments in the 

Visualization menu in the toolbar. 

In this mode, you can't edit Gantt bars for investments via drag and drop. 

8.10.2 Gantt Bars for Phases 

Gantt bars for phases will be displayed when selecting Show Gantt Bars for Tasks and Phases in the 

Visualization menu in the toolbar. 

In this mode, you can't edit Gantt bars for phases via drag and drop. 

8.10.3 Gantt Bars for Assignments 

Gantt bars for assignments will be displayed when selecting Show Gantt Bars for Assignments in 

the Visualization menu in the toolbar. 

While Gantt bars are displayed for assignments, you can't edit the ETC values per period directly. 

You can shift and resize assignments via drag and drop of their Gantt bars. 

You can only change the Start and Finish of assignments while the status is Not started and no 

actuals exist for them. The status check can be turned off (see "9.12.25 Edit Start and Finish of 

Tasks and Assignments Regardless of Status on page 169). 

Changing an assignment this way will redistribute the ETC displayed per period for the respective 

assignment over the capacity of the assigned resource, role or team during the new remaining 

duration (between Actuals Thru and Finish) with the same proportions as before the change. 

With Update Allocation in the General tab of the Preferences, the updated assignment values will 

also be entered as allocation for the same periods. 

Shifting or extending an assignment beyond the Start or Finish of the associated task or non-project 

investment will also extend the task or investment, such that it includes the assignment. When a task 

is extended this way, the change will also be applied to the associated phase and project, if required 

to include the new task duration. Reducing the durations of assignments won't reduce the duration 

of the associated task, phase or investment. 

8.10.4 Saving or Reverting Changes 

Changes made to Gantt bars won't be saved directly 

 Your changes will only be applied when you save them via the toolbar. You can easily identify 

unsaved changes via the red triangle in a field. 

 Refresh the view without saving to revert your changes. 

 Projects will automatically be locked for editing by other users while unsaved changes exist. This 

is indicated by a padlock icon. Saving or reverting your changes will unlock the project. If your 

session is interrupted before a project is unlocked, you or any member of the ARP Admin group 

can unlock it via the context menu. Please note that this is only possible for projects that were 

locked due to changes made in itd Advanced Resource Planning. 
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8.11 Utilization and Capacity 
With Show Utilization selected in the General tab of your Preferences, the utilization and remaining 

capacity of resources, roles and teams is displayed per period in color-coded numbers. 

 

8.11.1 Visualization of Low, Optimal, High and Very High Utilization 

Cell colors display whether a role's or resource's utilization is low (white), optimal (green), high 

(yellow) or very high (red) in that period (see "8.14.5 Utilization" on page 143).  

Utilization histogram charts are not available in this mode. 

8.11.2 Utilization and Remaining Capacity 

In this mode, the utilization and remaining capacity displayed for a period are based on remaining 

estimated effort from assignments in that period. 

With Calculate Sums set to Filtered in the General tab of your Preferences, the utilization will only 

include displayed assignments, as selected by your assignment filter. With Calculate Sums set to On 

or Off, the utilization will be based on all assignments in the associated period, visible or not. 

The remaining capacity is always global, based on all assignments in a period. 

8.11.3 Displaying Actuals 

Optionally, the remaining capacity displayed for the current period will consider actuals entered for 

that period (see "9.12.22 Consider Actuals for Remaining Capacity" on page 168). 

8.11.4 Displaying Utilization and Capacity Details 

Hover over a cell to display the utilization mode (Filtered Assignments or All Assignments) and the 

values included in the calculation of the remaining capacity. 
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8.12 Hierarchy Mode 
You can integrate itd Advanced Resource Planning in the Hierarchies module for hierarchies of the 

Investment type. 

Please note that the hierarchy mode feature is only available after adding an itd Advanced Resource 

Planning channel to the hierarchy blueprint (see "9.7 Planning Modes” on page 152). 

With the hierarchy mode, hierarchies offer an itd Advanced Resource Planning tab. 

 

In this mode, the view is automatically filtered to display only investments included in the hierarchy. 

You can display and sort by the Hierarchy Level field, which displays an investment’s hierarchy level. 

Please note: This mode is currently in the beta phase and is included as a preview. Further features 

are planned. We look forward to receiving feedback on this mode. 
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8.13 Toolbar Features 
In Assignments by Resource mode, you have access to the following features in the toolbar. 

8.13.1 View 

The View menu at the top left displays the active view and allows switching views, saving the current 

view under a new name and editing your favorites and view sharing settings under Manage. 

If you have the right to save changes to the current view, the Save View button is active. If it isn't, you 

can still save a copy of the current view. 

You can find details of the features available here under "3 Views" on page 22. 

8.13.2 Display Period 

To the right of the View menu, you have access to various controls for changing the display period. 

The slice period and number of slices are saved with the view and are synchronized with the 

Timeslices tab of the Preferences (see "8.14.2 Timeslices" on page 140). 

Most options available there are also available in the toolbar, with the exception of fiscal periods as 

slice periods. 

The start date won't be saved. The view automatically starts with the current date. 

 Previous Periods: Here you switch back by the selected display period (e.g., 6 months). 

 Previous Period: Here you switch back by the selected slice period (e.g., 1 month). 

 Slice Period and Number of Slices: Select the slice period (e. g, months) and enter the number of 

slices in the field or use the buttons to raise or lower the number. 

Then click on Show to update the view with the new slice settings. 

 Jump to a Certain Date: Here you select the view's start date in a calendar view. 

 Next Period: Here you switch ahead by the selected slice period (e.g., 1 month). 

 Next Periods: Here you switch ahead by the selected display period (e.g., 6 months). 

8.13.3 Refresh and Save 

Use the Refresh and Save buttons to discard or save your changes. 

 Refresh: This will reload all data. If there are unsaved changes, you will be asked if you want to 

save first. Answering no will discard your changes. 

 Save: This will save all unsaved changes you have made in the current view. 

8.13.4 Export to Excel 

You can export all rows and columns of the view to Microsoft Excel. 

 Export to Excel: Here you export the view to Microsoft Excel. 

The data will be exported as displayed, with the same filter settings and with all rows and 

columns that are currently displayed. For list entries with sub-elements, these sub-elements will 

only be exported if their parent item has been expanded, such that they are currently visible. 

The Excel export is limited to a maximum of 15,000 rows. 
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8.13.5 Visualization 

In Assignments by Resource mode, you have access to the following options under Visualization. 

 Visualization > Cell: Here you toggle the display of trend arrows for deviations of the left cell 

value from the right one, see "8.3 Displaying Trend Arrows" on page 127. 

 Visualization > Gantt Bars: Here you toggle the display of Gantt bars for investments, phases and 

assignments, see "8.10 Interactive Gantt Bars" on page 133. 

8.13.6 Preferences 

 Preferences: Here you configure other view settings such as display fields and filter fields, see 

"8.14 Preferences" on page 138. Preferences will be saved separately for each view. 

8.13.7 Help 

 Help: Here you can find information about itd Advanced Resource Planning and about asking for 

support. If you do, please always specify your version, which you can find under Info. 

8.13.8 Fullscreen 

 Fullscreen: In full screen mode, the Clarity PPM navigation will be hidden, such that more items 

can be displayed in itd Advanced Resource Planning. 

You can turn the navigation back on using the same button. 
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8.14 Preferences 
Click on the Preferences button in the toolbar to edit view options. 

8.14.1 General 

Settings in the General tab control the display and behavior of the current view. 

 

> Toolbar Only with Icons: select this to hide the captions on buttons with icons, reducing the width 

of the toolbar. 

> Show Utilization: select this to display the utilization and remaining capacity of roles, resources 

and teams per period. 

In this mode, with Calculate Sums set to Filtered, the assignment filter will also be applied to the 

utilization, such that only assignments matching the filter (i.e., displayed assignments) will be 

included. The remaining capacity is always global and includes any assignments in the 

associated period. With Calculate Sums set to On or Off, the displayed utilization is also global. 

> Calculate Sums: specify here whether totals of the workload fields (in the assignment modes: 

Estimated Effort, Actuals and Total Effort) should be calculated and displayed for all aggregation 

levels (in this mode: task, phase and resource, role or team). 

You can choose between On (display global sums), Filtered (apply assignment filter to global 

sums) and Off (don't calculate sums). 

This setting affects the loading time, with Off being the fastest and Filtered the slowest method. 

In Assignments by Resource mode, On will always display totals for investments and phases, 

including assignments of all roles, resources and teams. 

Filtered will sum up over the displayed assignments and therefore only display sums for the roles, 

resources and teams below which the items are listed. 

With Show Utilization, Filtered also applies to the displayed utilization in this mode (see above). 

> Show Phases: specify here whether to display phases between investments and associated 

tasks. If phases are not displayed, tasks associated with phases will be displayed directly under 

their respective investments. 
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> Update Allocation: specify here whether assignments entered for tasks should automatically be 

entered as allocation in the associated projects as well. 

> Load Data on Startup: specify here whether data is loaded directly when opening itd Advanced 

Resource Planning or only after clicking the filter button. 

> Show Investment Hierarchy: in Assignments by Resource mode, select this to display parent 

investment hierarchies of displayed investments that you have explicitly selected via the 

assignment filter. Sub-investments are only displayed in the by investment modes. 

Hiding investment hierarchies may speed up loading the view. 
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8.14.2 Timeslices 

Settings in the Timeslices tab control the time axis scale and display period. 

 

> Slice Period: enter the planning period here. Possible settings are Days, Weeks, Months, 

Quarters, Calendar Years and, if configured, Fiscal Period. 

The selection of available slice periods may be limited by Clarity PPM application administrators 

via the itd AE Preferences lookup (see "9.12.3 Restrict Time Slice Periods in the Preferences and 

in the Toolbar" on page 161). In this case, only options enabled via the associated lookup value 

will be available here and in the toolbar of itd Advanced Resource Planning. 

> Fiscal Entity and Fiscal Period: with the Fiscal Period setting, if multiple fiscal entities or periods 

have been defined in your Clarity PPM system, select the desired fiscal entity and period here. 

> Work Effort Unit: specify the unit for efforts here. By default, the System Standard will be applied. 

Alternatively, Hours, Days or full time equivalents (FTE) are available for selection here. 

> Slice Count: enter the amount of slices to be displayed. 

> Decimal Places: enter the desired number of decimals for entering and displaying assignments 

and allocations. 
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8.14.3 Columns 

In the Columns tab, you select the columns to display in the list at the top left of the current view. 

 

The following fields are always displayed in the first column: 

> Name (resource/role/team, investment, phase, task) 

> Primary role (resource), parent role (role): for resources, the primary role is displayed next to the 

resource name. For roles, the parent role is displayed next to the role name, if applicable. You can 

turn this off via a feature toggle, see "9.12.5 Hide Primary/Parent Role Name" on page 161. 

The following fields can be selected for display by default: 

> Actuals, Est. Effort, Total Effort (investment, phase, task, assignment): worked, remaining and 

total hours; the Total Effort field displays the sum of Est. Effort and Actuals. 

> Department OBS, Location (resource/team) 

> Duration (phase, task, assignment): duration in work days according to the base calendar 

> Effective Role (assignment): resource, role or team assignment role 

> Effective Role (team entry): resource, role or team investment role 

> Effective Role (role): parent role 

> Effective Role (resource): primary role 

> ID (investment, phase, task, milestone, resource/role/team) 

> Investment Status (investment): editable 

> Investment Type (investment) 

> Loading Pattern (assignment): editable 

> Skills (resource/role/team): editable 

> Staff OBS Unit (team entry): editable 

> Start, Finish (investment, phase, task, milestone, assignment): editable for assignments 

> Display ETC Sums outside of Visible Time Range: see page 129. 

Members of the ARP Admin group may add to the selection and enable editing for other fields 

available for investments, investment sub-types, resources, roles, teams; team entries; tasks and 

assignments. This includes most Clarity PPM standard fields and most custom fields defined for 

these objects. See section "9.11 Configuring List and Filter Fields" on page 156 for details. 
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8.14.4 Filter 

In the Filter tab, you select filter fields for the assignment filter. This lets you filter the current view by 

investments, resources/roles/teams, team entries, tasks and assignments. 

 

Select the available filter fields for the left and right column of the assignment or allocation filter. 

> You can add filter fields to either column as well as determine their order via drag-and-drop: 

• Drag filter fields from the Available Filters list to either column to add them. 

• Drag filter fields from either column to the Available Filters list to remove them. 

• Drag filter fields between columns or within a column to change their position. 

> Alternatively, you can use the buttons to the left of a column list in order to… 

• … add fields selected in its left neighbor list (right arrow). 

• … remove fields selected in the list and add these fields to its left neighbor list (left arrow). 

• … change the field order by moving selected fields up or down in the list (up/down arrow). 

See section "4.8 Default Filter Fields for the Main View" on page 28 for details about the default filter 

fields. 

Members of the ARP Admin group may add to the selection other fields available for investments, 

investment sub-types, resources, roles, teams; team entries; tasks and assignments. 

This includes most Clarity PPM standard fields and most custom fields defined for these objects. 

For details about the required procedure and supported fields and objects, see "9.11 Configuring List 

and Filter Fields" on page 156. 
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8.14.5 Utilization 

Settings in the Utilization tab control the display and calculation of the utilization. 

In Assignments by Resource mode, the utilization will be calculated from assignments. 

 

> The Utilization Rate controls the visualization of low or high utilization. 

• Low Utilization at and Below: upper utilization boundary below which resources, roles and 

teams will be marked as lowly utilized with a grey background in the respective period. 

Utilization between the thresholds for low utilization and utilization warning (e.g., above 80% to 

100% as according to the screenshot) will be marked as optimal with a green background. 

This threshold value has no effect in the histogram. 

• Utilization Warning Above: lower utilization boundary above which resources, roles and teams 

will be marked as slightly over-utilized with a yellow background in the respective period. This 

applies as long as the utilization stays at or below the lower boundary for high utilization. 

In the histogram, workload is colored green up to this threshold value. 

• High Utilization Above: lower boundary above which resources, roles and teams will be 

marked as highly over-utilized with a red background in the respective period. 

In the histogram, workload is colored yellow up to this threshold value and red above. 
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8.14.6 Layout 

Settings in the Layout tab control the additional display value in the right hand side assignment grid 

as well as sorting fields for resources, investments and tasks. 

 

> Cell Configuration: Here you select a Field to Display on the Left Part of the Cell and enter a 

treshold value for trend arrows, when active. 

In Assignments by Resource mode, the assignment value is always displayed on the right. 

• Field to Display on the Left Part of the Cell: Empty (no field), ETC, Actuals, Capacity or a 

custom time scaled monetary value. You can edit the latter, see "7.7 Editing Custom Time 

Scaled Monetary Values" on page 95. 

• Tolerance of Deviation: Treshold value for displaying trend arrows to indicate a deviation of 

the left cell value from the right one when activated via Visualization. 

This setting only affects the right hand side assignment grid. The left hand side sum columns 

(Estimated Effort, Actuals, Total Effort or custom time scaled monetary values) can be displayed 

or hidden via the Columns tab (see "8.14.3 Columns" on page 141). 

To display aggregated totals for roles, resources and teams in the assignment grid and sum 

columns, set Calculate Sums to On or to Filtered in the General tab (see "Calculate Sums" on 

page 138). 

> Sorting: In addition to the fields listed here, any custom fields without lookups are available. If you 

don't select the respective default field, items will be sorted by that field on the second level. 

• Sort Resources by: Name (Default) or Primary Role. 

• Sort Investments By: Investment Type or Name (Default). 

• Sort Tasks By: Finish Date, Name, Start Date or WBS Sort (Default). 

> Browser Specific Layout Configuration: Here you can select to Use Colors with Higher Contrast. 

This setting will affect all your views in itd Advanced Resource Planning. 
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9 Administration 

This chapter describes the administration of itd Advanced Resource Planning: 

> 9.1 Requirements (page 145) 

> 9.2 Supported Locales (page 145) 

> 9.3 User and Administrator Groups (page 146) 

> 9.4 Lookup Access (page 147) 

> 9.5 User Access Rights (page 148) 

> 9.6 Integration and Invocation (page 152) 

> 9.7 Planning Modes (page 152) 

> 9.8 Changing Text Labels (page 153) 

> 9.9 System Settings (page 153) 

> 9.10 Defining Actions (page 154) 

> 9.11 Configuring List and Filter Fields (page 156) 

> 9.12 itd AE Preferences Lookup (page 160) 

> 9.13 itd AE Included Investment Types Lookup (page 171) 

> 9.14 Governors Lookup (Limits and Caches) (page 173) 

> 9.15 Troubleshooting (page 175) 

9.1 Requirements 
itd Advanced Resource Planning 12.2.0 requires Clarity PPM 16.1.1 or newer. 

9.2 Supported Locales 
The following locales are currently supported: 

> Danish, Danish(Denmark) 

> Dutch, Dutch(Netherlands), Dutch(Belgium) 

> English, English(United Kingdom), English(United States) 

> Finnish, Finnish(Finland) 

> French, French(Belgium), French(France) 

> German(Germany), German(Switzerland) 

> Italian(Switzerland) 

> Norwegian, Norwegian(Norway) 

> Spanish, Spanish(Spain) 

> Swedish, Swedish(Sweden) 
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9.3 User and Administrator Groups 
This section describes groups for users and administrators of itd Advanced Resource Planning. 

9.3.1 ARP Users Group 

Add users to this group to grant them access to either of the itd Advanced Resource Planning or the 

itd Allocation Editor applications. 

Please note that users may also be able to use these applications if they have general page and 

portlet access rights. In this case, these users will be added to the ARP Users group when accessing 

either application in order to keep track of who is using the applications in your organization. 

Please also note that, in order to access individual itd Advanced Resource Planning features, users 

also need the required resource, investment and scenario rights listed in section "9.5 User Access 

Rights" on page 148. 

The ARP Users group grants users the following rights: 

> Instance Access Rights 

• Access itd Advanced Resource Planning and itd Allocation Editor pages and portlets. 

9.3.2 ARP Admin Group 

The ARP Admin group grants users the following administrative rights: 

> Instance Access Rights 

• Access itd Advanced Resource Planning and itd Allocation Editor pages and portlets. 

• Edit and define itd Advanced Resource Planning and itd Allocation Editor pages and portlets. 

> Global Access Rights 

• Full rights for itd AE Actions (define menu actions, see "9.10 Defining Actions" on page 154) 

• Full rights for itd AE Attribute Configuration (add list fields, editable fields and filter fields, see 

"9.11 Configuring List and Filter Fields" on page 156.) 

• Full rights for itd AE Attribute Source (add additional Clarity PPM standard fields to the list of 

available fields, please contact us if you wish to do this.) 

> Other Administrative Features in itd Advanced Resource Planning 

• Application: unlock projects locked due to changes made in itd Advanced Resource Planning 

by other users (any user may unlock projects that were locked due to their own changes in itd 

Advanced Resource Planning.) 

• User Preferences: System Settings (see "9.9 System Settings in Preferences" on page 153) 

• URL Parameter: &flushCaches=true (apply newly added fields and changed settings, see 

"9.11 Configuring List and Filter Fields" on page 156, "9.12 itd AE Preferences Lookup" on page 

160, "9.13 itd AE Included Investment Types Lookup" on page 171 and "9.14 Governors 

Lookup (Limits and Caches)" on page 173) 
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9.4 Lookup Access 
Some settings are managed via lookups. Editing them requires the global Administration – 

Application Setup right, which Clarity PPM application administrators have by default. 

9.4.1 itd AE Preferences Lookup 

Some application settings are managed via the itd AE Preferences lookup. 

The ID (code) of this lookup is PL.ITD.AE.LKP.PREFERENCES. 

It is used for both itd Advanced Resource Planning and the itd Allocation Editor. 

See "9.12 itd AE Preferences Lookup" on page 160 for details. 

9.4.2 itd AE Included Investment Types Lookup 

As of version 12.0.0, the installation package of itd Advanced Resource Planning now includes the  

itd AE Included Investment Types lookup. 

The ID (code) of this lookup is PL_ITD_AE_LKP_INCLUDED_INV_TYPES. 

Here you can filter selected view modes by investment type. Modes for which you define no filters 

won't be filtered by investment type. 

> Please note: This configuration works only for the global investment mode. It is neither 

implemented for the single investment mode nor the roadmap mode. 

See "9.13 itd AE Included Investment Types Lookup" on page 171 for details. 

9.4.3 Governors Lookup (Limits and Caches) 

Some database access and memory usage settings may be managed by creating a lookup with the 

ID (code) = PL_ITD_AE_LKP_GOVERNORS. Starting with version 8.3 of itd Advanced Resource 

Planning, this replaces the pl_itd_ae.properties file, which is no longer supported. 

It is used for both itd Advanced Resource Planning and the itd Allocation Editor. 

See "9.14 Governors Lookup (Limits and Caches)" on page 173 for details. 
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9.5 User Access Rights 
This section lists access rights required for application features by view mode. 

9.5.1 Allocations by Investment Access Rights 

Features Resource Access Rights Investment Access Rights 

• View team entries of investments 

and associated allocations 

• None, all team entries for 

all visible investments and 

associated allocations will 

be displayed. 

• View1 

• View resources, roles and teams with 

total utilization and total capacity 

• Resource - Soft Book OR 

Resource – View2 

• None 

• Show team entries (investments) 

when clicking on histogram 

segments 

• Resource - Soft Book OR 

Resource – View OR 

Investment – View2 

• Add new resources, roles and teams3 

• Replace allocation via drag-and-drop 

from the resource/role/team view3 

• Resource – Soft Book • Edit 

• Resource – Hard Book4 • View 

• Edit Allocation 

• Allocate from Estimates 

• Accept Hard Allocation 

• Resource – Hard Book5 • View (no resource right 

required with Edit)5 

• Move team entry without hard 

allocation (change start or finish 

date) 

• Resource – Hard Book5 • View (no resource right 

required with Edit)5 

• Move team entry with hard allocation 

(change start or finish date) 

• Edit Hard Allocation 

• Commit Allocation 

• Resource – Hard Book5 • View5 

• Create Requisition • None • Project – Create/Edit 

Requisition 

 
1 Viewing team entries and associated allocations requires the respective investment type's View 
right (e.g., Project – View). 
2 Required rights may be configured via feature toggles, see items 9.12.10, 9.12.11 and 9.12.12 in 
section ""9.12 itd AE Preferences Lookup" on pages 157ff. 
Role capacities include all associated resources regardless of access rights for these resources. 
3 These actions are available with both combinations of access rights listed here. 
4 Resource – Hard Book includes Resource – Soft Book. 
5 With the Edit right for an investment type (e.g., Project – Edit), no resource right is required for 
editing team entries (except for editing the Hard Allocation, which requires Resource – Hard Book). 
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9.5.2 Allocations by Resource Access Rights 

Features Resource Access Rights Investment Access Rights 

• View resources, roles and teams with 

team entries and associated allocations 

• View total utilization and total capacity of 

resources, roles and teams 

• None, all resources, 

roles and teams with 

team entries for 

visible investments 

will be displayed1 

• View1 

• Edit Allocation 

• Allocate from Estimates 

• Accept Hard Allocation 

• Resource – Hard 

Book2 

• View (with Edit, only 

Resource – View is 

required)2 

• Move team entry without hard allocation 

(change start or finish date) 

• Resource – Hard 

Book2 

• View (with Edit, only 

Resource – View is 

required)2 

• Move team entry with hard allocation 

(change start or finish date) 

• Edit Hard Allocation 

• Commit Allocation 

• Resource – Hard 

Book2 

• View2 

• Create Requisition • None3 • Project – Create/Edit 

Requisition 

 
1 Viewing team entries and associated allocations requires the respective investment type's View 
right (e.g., Project – View). 
Optionally, all resources, roles and teams for which the user has the Resource – View right will be 
displayed instead. In this case, no investment right is required for viewing associated team entries 
and allocations, see item 9.12.13 under "9.12 itd AE Preferences Lookup" on pages 157ff. 
Role capacities include all associated resources regardless of access rights for these resources. 
2 With the Edit right for an investment type (e.g., Project – Edit), only Resource – View is required for 
editing team entries (except for editing the Hard Allocation, which requires Resource – Hard Book). 
3 Resource – View right optionally required, see 1. 
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9.5.3 Assignments by Investment Access Rights 

Features Resource Access Rights Investment Access Rights 

• View assignments including investments, 

phases, tasks, milestones, dependencies 

and assigned resources, roles and teams 

• None, all assignments for 

all visible investments will 

be displayed 

• View1 

• View resources, roles and teams with 

total utilization and total capacity 

• Resource - Soft Book OR 

Resource – View2 

• None 

• Show team entries (investments) when 

clicking on histogram segments 

• Resource - Soft Book OR 

Resource – View OR 

Investment – View2 

• Edit assignments 

• Edit investments (project name, project 

structure with phases, tasks and 

milestones, start and finish of NPIOs) 

• None • Edit3 

• Create assignments for team members 

(assign resources, roles and teams with 

existing team entries in the investment 

via drag-and-drop from the resource 

utilization view to tasks) 

• Resource - View • Edit3 

• Create new team entries with 

assignments (assign resources, roles and 

teams without team entries in the 

investment via drag-and-drop from 

resource utilization view to tasks or 

NPIOs) & multi-role assignments 

• Resource - Soft Book • Edit3 

• Allocate from Estimates • Resource – Hard Book4 • View (no resource right 

required with Edit)4 

 
1 Viewing assignments requires the respective investment type's View right (e.g., Project – View). 
2 Required rights may be configured via feature toggles, see items 9.12.10, 9.12.11 and 9.12.14 in 
section "9.12 itd AE Preferences Lookup" on pages 157ff. 
Role capacities include all associated resources regardless of access rights for these resources. 
3 Editing assignments and investments and creating team entries and assignments requires the 
respective investment type's Edit right (e.g., Project – Edit). 
4 With the Edit right for an investment type (e.g., Project – Edit), no resource right is required for the 
Allocate from Estimates action. 
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9.5.4 Assignments by Resource Access Rights 

Features Resource Access Rights Investment Access Rights 

• View resources, roles and teams with total 

utilization and total capacity 

• None, all resources, 

roles and teams with 

team entries for visible 

investments will be 

displayed.1 

• View2 

• View assignments including investments 

and tasks as well as team entries without 

assignments 

• None1 • View2 

• Edit assignments • None1 • Edit3 

• Create assignments for resources, roles 

and teams with existing team entries in a 

project for associated tasks 

• None1 • Edit3 

• Create new team entries with assignments 

(create assignments for resources, roles 

and teams in tasks belonging to a project 

without team entries for those resources, 

roles and teams) 

• Resource – Soft Book • Edit3 

• Allocate from Estimates • Resource – Hard Book4 • View (no resource right 

required with Edit)4 

9.5.5 Access Rights for Resource Managers 

Please note that while Resource Managers always have the Hard Book and View/View Financial 

resource rights, they still require the listed access rights for viewing and editing investments. 

9.5.6 Access Rights for Scenarios 

In the allocations modes, you can edit scenario data instead of the plan of record with edit rights for 

the respective scenario. Investment rights are not required. Shifting and resizing investments with 

hard allocations in this mode requires the Resource – Hard Book right for all associated resources. 

For details about required access rights for generally accessing scenarios as well as viewing and 

editing specific scenarios, see section "5.11 Scenario Comparison" on page 52. 

 
1 Optionally, the view will only display resources, roles and teams for which the user has the 
Resource – View right. In this case, View rights for associated investments are still required as well, 
see item 9.12.15 in section "9.12 itd AE Preferences Lookup" on pages 157ff. 
Role capacities include all associated resources regardless of access rights for these resources. 
2 Viewing assignments requires the investment type's View right (e.g., Project – View). 
3 Editing and creating assignments requires the investment type's Edit right (e.g., Project – Edit). 
4 With the Edit right for an investment type (e.g., Project – Edit), no resource right is required for the 
Allocate from Estimates action. Please note that the Resource – View right may be required to 
display roles, resources and their assignments, see 1. 
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9.6 Integration and Invocation 
itd Advanced Resource Planning is implemented as a standard Clarity PPM HTML portlet. 

> Name: itd Advanced Resource Planning, ID: pl.itd.ae.prt.assignment.editor 

> The portlet can be added to any portlet page. 

> The portlet is accessible to users with appropriate access rights, similar to any other Clarity PPM 

portlet. Add users to the ARP Users group to grant them access to the itd Advanced Resource 

Planning application (see "9.3.1 ARP Users Group" on page 146). 

9.7 Planning Modes 
itd Advanced Resource Planning supports four planning modes, depending on how it is integrated: 

> The multiple investment mode is evoked when itd Advanced Resource Planning is opened from 

any portlet page that is not an investment portlet page. In this mode, multiple investments and 

associated data will be displayed, depending on your filter settings. 

> The single investment mode is evoked when itd Advanced Resource Planning is opened from the 

portlet page of an investment. This mode displays a single investment and associated data. 

For investments with parent objects, displaying and editing the parent structure is optional, 

depending on the Hide Parent Hierarchy Levels in Single Investment Mode option on the System 

Settings tab of the Preferences, which is only accessible to members of the ARP Admin group 

(see "9.9 System Settings in Preferences" on page 153). 

In the single investment mode, in the Assignments by Investment view mode only, users may 

graphically compare assignments with the planned or hard allocation of associated team entries 

in the histogram instead of ETC and capacity. 

For details about using this feature, see section "7.12.11 Assignments and Allocations in Single 

Investment Mode" on page 111. 

For details about the Preferences for this feature, see "Histogram Comparison (Single Investment 

Mode Only)" on page 124. 

> The roadmap scenario mode is evoked when itd Advanced Resource Planning is integrated as a 

channel in a roadmap blueprint in the Modern UX as follows, replacing [clarity url] by your Clarity 

PPM system’s URL: https://[clarity url]/niku/nu#action:pl.itd.ae.page.assignment.editor& 

puiFullscreen=on& puiHidePPMTabs=on&roadmapId=${_internalId} 

This mode links roadmap scenarios to capacity scenarios in the Allocations modes. Roadmap 

item dates and the In Plan field are automatically applied to the linked investments in the capacity 

scenario. 

Changes made to these investment properties and allocations in itd Advanced Resource Planning 

are automatically synchronized back to the associated roadmap items in the linked roadmap 

scenario. Each roadmap scenario’s capacity scenario is automatically created when the view is 

first opened for that roadmap scenario. When the view is reopened for the same roadmap 

scenario, no matter by which user, the stored capacity scenario will be loaded. This way, multiple 

users may work together on the same roadmap scenario. Any saved changes will be restored. 

See "5.12 Roadmap Scenario Mode” on page 55 for details. 

> The hierachy mode is evoked when itd Advanced Resource Planning is integrated as a channel in 

a hierarchy blueprint in the Modern UX as follows, replacing [clarity url] by your Clarity PPM 

system’s URL: https://[clarity url]/niku/nu#action:pl.itd.ae.page.assignment.editor& 

puiFullscreen=on& puiHidePPMTabs=on&hierarchyId=${_internalId} 
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9.8 Changing Text Labels 
You can change any text labels displayed in itd Advanced Resource Planning and the itd Allocation 

Editor via a custom lookup. 

Please contact us if you wish to do so. 

9.9 System Settings in Preferences 
In the Preferences, members of the ARP Admin group have access to the System Settings tab. 

 

> Hide Parent Hierarchy Levels in Single Investment Mode: this option only applies to single 

project mode and is therefore not available in multi investment mode (see "9.7 Planning Mode" on 

page 152). 

> Hide Warning Dialog for Invalid Start/Finish Data: this option is global and always available. 
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9.10 Defining Actions 
Members of the ARP Admin group may disable standard actions and add custom actions (context 

menu options) available in itd Advanced Resource Planning. 

9.10.1 Accessing the Action Configuration 

In the Classic UI, select Home – Custom Objects – itd AE Actions List. 

9.10.2 Action Overview 

The action list provides an overview of defined actions. 

 

The displayed examples for deactivating standard actions are described on the following page in 

section "9.10.4 Examples for Deactivating Standard Actions".  

> Order ID: determines the order of the actions. The lowest ID will be placed first. To reorder 

standard actions, add them and order them via this field. 

> Process ID and Standard Action: these columns define the type of the action. 

> Objects: object types for which the action will be available. 

> Views: this column shows on which applications and view modes the action will appear. 

> Tool Mode: this column shows on which tool mode the action will appear (single or multiple) 

> Active: use this column to deactivate or activate actions. 

9.10.3 Adding a Custom Action or Removing a Standard Action 

Click New itd AE Actions to create a new action object.  
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> Select a Process ID to add a process action or select a Standard Action to remove. 

> Process Action: invokes a Clarity PPM process when the user invokes the action.  

• The data of the current model is transferred to the process as parameters. 

• To support processes covering different object types, we transfer the OBJECT_TYPE and 

OBJECT_ID of the objects for which the process should be called. 

• Select for which Tool Mode, Objects and Views the action should be visible.  

Consider that each condition has to be fulfilled to make the action visible. 

> Standard Action: remove a standard action completely or for selected tool modes (single or 

multiple investments), object types or views (applications and view modes). 

• Select the action to remove under Standard Action. 

• Deselect the Active option to remove the action altogether. To remove the action for individual 

tool modes, object types and views, select or remove the appropriate items. 

• Please note: although all tool modes, objects and views will initially be selected when adding a 

standard action, most standard actions are only available for some objects (listed under 

Description in the lookup browse window for selecting a standard action) and views.  

You can't add an action for an object or view for which it isn't available by default.  

• You can reset to the default for an action by deleting the associated itd AE Actions item.  

9.10.4 Examples for Deactivating Standard Actions 

The following examples deactivate these standard actions: 

> Autoschedule Project in itd Advanced Resource Planning (Assignments by Investment) in both 

modes (single and multiple investment). 

> Allocate from Estimates for all investment types, team entries and assignments in all views (for 

both modules itd Allocation Editor and itd Advanced Resource Planning) and in both modes. 

 

9.10.5 Updating itd Advanced Resource Planning 

To update itd Advanced Resource Planning after changing the action configuration, simply refresh 

your browser by pressing [F5]. 

Resetting the cache for itd Advanced Resource Planning is not required. 
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9.11 Configuring List and Filter Fields 
Members of the ARP Admin group may add list and filter fields to itd Advanced Resource Planning 

and to the itd Allocation Editor in the attribute configuration list. 

> For list fields, you can also determine whether they are editable. 

> Use the &flushCaches=true URL parameter to update the applications with newly added fields 

(see section "9.11.11 Updating itd Advanced Resource Planning" on page 159). 

9.11.1 Accessing the Attribute Configuration List 

In the Classic UI, select Home – Custom Objects – itd AE Attribute Configuration List. 

9.11.2 Attribute Configuration List View 

The attribute configuration list displays additional list and filter fields. 

Here, you can edit, deactivate or remove fields and add new fields. 

 

The following properties control where each field is available in itd Advanced Resource Planning: 

> Include in Grids: field may be added to displayed Columns or Utilization – Columns. 

Exactly where a field will be available as a column depends on the objects of the associated view. 

For example, only resource fields will  be available under Utilization – Columns. 

> Is Editable: field may be edited in the list. This is only relevant when Include in Grid is selected.  

Attributes configured as Read-Only in the Studio will never be editable, even if selected here. 

Some attribute types don't support editing and will never be editable, even if selected here (see 

"9.11.5 Supported Attribute Types" on page 158). 

This also applies to a small number of Clarity PPM default attributes. 

> Include in Filters: field may be selected as a filter field.  

Some attribute types don't support filtering and will never be available as filter fields even if 

selected here (see "9.11.5 Supported Attribute Types" on page 158).  

This also applies to a small number of Clarity PPM default attributes. 

> Include in Utilization Filter: field is included in the utilization filter. This is currently supported for 

Lookup and Boolean fields of the Investment and Team objects. 

> Resource Type: this only applies to custom time scaled monetary values (time-varying attribute 

type, see "7.7.1 Integrating a Custom Time Scaled Monetary Value" on page 95). 

Defines for which resource types the value will be displayed and editable.  

> Active: deselect this to remove a field from the selection of columns and filter fields without 

deleting the associated configuration. 
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9.11.3 Adding Fields 

Click on New itd AE Attribute Configuration to add a new field. 

 

> Attribute Title: field name to display. This is only required if you don't wish to display the name of 

the field specified as Attribute Label or Source field. 

> Attribute Label: field whose name to display. This is only required if you don't wish to display the 

name of the field specified as Source field, or if you are defining a field with multiple sources. 

Please note: for merged fields (fields with multiple sources), the Attribute Label also determines 

the views in which the field may be added as a Visible Column. See following section for details. 

> Source: field or fields to display. You can merge fields by selecting more than one field here to 

display fields for multiple objects in the associated rows or to filter by multiple objects at once.  

In this case, consider the following:  

• Use no more than one field from each object.  

Additional fields from the same object will be ignored. 

• Use the same data type for all source fields (e.g., String or Number). 

Merged fields with multiple data types won't be selectable as columns or filter fields. 

• Select a field as Attribute Label to display as column header in the list. If you don't specify a 

label field, a random source field will automatically be selected as label field. 

Please note: The label field not only determines the displayed column header but also the 

views in which the merged field will be available for selection under Columns. 

It will be restricted to views where the label field's object is available: 

• Assignments by Investment: investments & sub-types, tasks, assignments 

• Assignments by Resource: resources, tasks, assignments 

• Allocations by Investment: investments & sub-types, team entries 

• Allocations by Resource: resources, team entries 

Examples: 

• A field with label Project.field will be restricted to the by Investment views. 

• A field with label Resource.field will be restricted to the by Resource views. 

Merged fields will always be available as filter fields for all view modes regardless of the 

selected label field. 
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• If you also specify an Attribute Title, that will be displayed as column header in the list instead 

of the Attribute Label. In this case, the Attribute Label will still determine the views in which 

the merged field will be available. 

See previous page for the remaining properties you can configure in this view. 

9.11.4 Supported Object Types 

The following object types are currently supported: 

> Application 

> Asset 

> Assignment 

> Idea 

> Investment 

> Other 

> Product 

> Project 

> Resource 

> Service 

> Task 

> Team 

9.11.5 Supported Attribute Types 

The following attribute types are currently supported: 

> String 

> Large String 

> Number 

> Percent 

> Calculated (see "9.11.6 Restrictions for Calculated and Formula Attributes" on page 159)** 

> Formula (see "9.11.6 Restrictions for Calculated and Formula Attributes" on page 159)** 

> Money 

> Boolean 

> Date 

> Static Lists: 

• Single Value Number, String 

• Multi Value Number, String 

> Static Dependent Lists: 

• Single Value Number, String 

• Multi Value Number, String 

> Dynamic SQL (also with parameters) 

• Single Value Number, String 

• Multi Value Number, String 

> URL* 

> Time-varying (for assignments only, see "7.7.1 Integrating a Custom Time Scaled Monetary 

Value" on page 95) 

* This type doesn't support editing. 

** This type doesn't support editing or filtering. 
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9.11.6 Restrictions for Calculated and Formula Attributes 

Most of the attributes which can be used in a Calculated or Formula attribute are supported.  

Attributes which the custom calculated/formula columns do not support:  

> All Lookup attributes 

> Assignment – Has Guidelines 

> Investments – Business Alignment 

> Investments – Include Sub-Departments 

> Project – Schedule to Baseline 

> Project – Schedule Variance % 

> Resource – Capacity Rate 

> Resource – Show Resources in Sub-departments 

9.11.7 Restrictions for Virtual Attributes 

Virtual attributes are generally supported.  

The following restrictions currenty apply: 

> Virtual attributes on custom investments are not yet supported. 

> Virtual attributes on other virtual attributes are not yet supported. 

9.11.8 Custom Investment Types 

You can’t directly add attributes for custom investment types. However, custom investment types 

automatically inherit any attributes you add on the Investment object level. 

9.11.9 Supported Attributes 

You can add most Clarity PPM standard attributes and any custom attributes of supported objects 

and types (see "9.11.4 Supported Object Types" and "9.11.5 Supported Attribute Types" on page 158). 

9.11.10 Adding Additional Clarity PPM Standard Attributes 

Please contact us if you wish to add a Clarity PPM standard attribute that isn't currently supported. 

9.11.11 Updating itd Advanced Resource Planning 

After adding new attributes, you can need to reset the cache for itd Advanced Resource Planning to 

make them available in the application. 

This requires membership in the ARP Admin group. 

To do so, call the portlet with the &flushCaches=true URL parameter: 

> https://{ca.ppm.url}/niku/nu#action:pl.itd.ae.page.assignment.editor&flushCaches=true 

Please note that the parameter won't be passed to an embedded page in the Modern UI. 

You need to open the portlet in the Classic UI with the &flushCaches=true parameter to reset 

the cache. 
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9.12 itd AE Preferences Lookup 
Some application settings are managed via the itd AE Preferences lookup: 

> The ID (code) of this lookup is PL.ITD.AE.LKP.PREFERENCES. 

> Creating and editing lookups requires the global Administration – Application Setup right, which 

Clarity PPM application administrators have by default. 

> This lookup is used for both itd Advanced Resource Planning and the itd Allocation Editor. Please 

note that not all settings apply to all views in both applications (see Scope). 

> Use the &flushCaches=true URL parameter to update the applications with changed settings 

(see section "9.12.30 Updating itd Advanced Resource Planning" on page 170). 

9.12.1 Hide Preferences Tabs 

Scope: itd Advanced Resource Planning and itd Allocation Editor 

ID (LOOKUP_CODE): hidden_preference_tabs 

Initial Setting: active with Description = query_limits 

Activate: set Active = true AND add elements to Description, separated by commas "," 

Deactivate: set Active = false (will apply default) OR remove elements from Description 

Possible Elements: (default: query_limits)  

> general: General 

> time_slice: Timeslices 

> visible_columns: Columns 

> filter_layout_config: Filter / Filter – Assignments / Filter – Allocations 

> utilization_layout_config: Filter – Resources 

> utilization: Utilization 

> layout: Layout 

> query_limits: Query Limits 

Effect: 

> Hide Preferences tabs listed in Description 

9.12.2 Hide Toolbar Buttons 

Scope: itd Advanced Resource Planning and itd Allocation Editor 

ID (LOOKUP_CODE): hidden_toolbar_buttons 

Initial Setting: active with Description = expand_all, collapse_all 

Activate: Active = true AND add elements to Description, separated by commas "," 

Deactivate: Active = false (will apply default) OR remove elements from Description 

Possible Elements: (default: expand_all, collapse_all)  

> preferences: Preferences 

> visualization: Visualization 

> export_to_excel: Export to Excel 

> scenario: Scenario 

> expand_all: Expand all (this may affect the performance when expanding many items) 

> collapse_all: Collapse all (this may affect the performance when collapsing many items) 

> detailed_view: Detailed view of assignments in Assignments by Investment mode. 

Effect: 

> Hide toolbar buttons listed in Description  
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9.12.3 Restrict Time Slice Periods in the Preferences and in the Toolbar 

Scope: itd Advanced Resource Planning and itd Allocation Editor 

ID (LOOKUP_CODE): preference_tab_time_slice 

Initial Setting: deactivated with Description = timeslice_mode: month, year, quarter 

Activate: Active = true AND add elements to Description, separated by commas "," 

Deactivate: Active = false (will apply default) OR remove elements from Description 

Possible Elements: (default: all) 

> day: Days 

> week: Weeks 

> month: Months 

> quarter: Quarters 

> year: Calendar Years 

> fiscal_period: Fiscal Period 

Effect: 

> Only time slice periods listed in the Description will be available for selection in the Preferences 

and in the toolbar. 

9.12.4 Prevent Editing by Work Effort Unit 

Scope: itd Advanced Resource Planning and itd Allocation Editor 

ID (LOOKUP_CODE): read_only_work_effort_units 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false OR remove elements from Description 

Possible Elements: (default: none) 

> UNIT_SYSTEM: System Standard (configurable) 

> UNIT_HOURS: Hours 

> UNIT_DAYS: Days 

> UNIT_FTE: FTE (full time equivalents) 

Effect: 

> When an entered unit is selected for itd Advanced Resource Planning, it is no longer possible to 

enter, delete or modify workloads. Additionally, it is no longer possible to change the start or finish 

of any object in the list or Gantt view or rename investments or tasks. 

> It is still possible to add, replace or copy assignments and team entries. 

9.12.5 Hide Primary/Parent Role Name 

Scope: itd Advanced Resource Planning 

ID (LOOKUP_CODE): hide_primary_role_name 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, the Name column displays a resource’s primary role or a role’s parent role, if 

applicable, next to their name in all modes. 

> With this setting, primary roles for resources and parent roles for roles won't be displayed. 
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9.12.6 Use Old Skills Hierarchy 

Scope: itd Advanced Resource Planning 

ID (LOOKUP_CODE): use_old_skills_hierachy 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, Clarity system with version 16.2.3 and up use the new skills defined in the modern UX. 

> As the new skills, unlike the Skills Hierarchy, are not supported on team entries at the moment, 

you can switch back to the old Skills Hierarchy with this feature toggle. 

9.12.7 Show Grid Hints for by Investment Views 

Scope: itd Advanced Resource Planning, Allocations/Assignments by Investment 

ID (LOOKUP_CODE): layout_option_tooltip_invest 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> With this setting, hovering over the allocation or assignment grid will show a hint listing the 

displayed values as configured in the Layout tab of the Preferences, such as ETC / Capacity. This 

doesn't affect the hints for the grid in the resource list, which are always displayed. 

9.12.8 Show Grid Hints for by Resource Views 

Scope: itd Advanced Resource Planning, Allocations/Assignments by Resource 

ID (LOOKUP_CODE): layout_option_tooltip_resource 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> With this setting, hovering over the allocation or assignment grid will show a hint listing the 

displayed values as configured in the Layout tab of the Preferences, such as ETC / Capacity. This 

doesn't affect the hints for the grid in resource rows, which are always displayed. 
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9.12.9 Initially Load Investment Structure in Investment Modes 

Scope: 

> itd Advanced Resource Planning, Allocations/Assignments by Investment 

> itd Allocation Editor, Allocations by Investment 

ID (LOOKUP_CODE): calc_inv_has_children_flag 

Initial Setting: active (lookup value doesn't exist) 

Activate: Lookup Value Name = 1 OR Active = false 

Deactivate: create lookup value with Lookup Value Name = 0 AND Active = true 

Effect: 

> By default, in the investment modes, opening or refreshing the view will load the complete sub-

structure of each displayed investment. In Assignments by Investment mode, this includes sub 

investments, phases, tasks and assignments. In Allocations by Investment mode, this includes 

sub investments and team entries.  

The expand icon will then only be displayed for investments with a sub-structure. 

Loading the complete sub-structure of each investment can take considerable time, depending 

on the exact data structure. 

> Create a lookup value with Lookup Value Name = 0, ID = calc_inv_has_children_flag and Active = 

true to prevent loading the full sub-structure of each investment when the view is opened or 

refreshed, saving some loading time. 

The expand icon will then be displayed for all investments without checking whether they do have 

a sub-structure. Clicking this icon will load existing sub-structures or hide the icon where no sub-

structure exists. 

9.12.10 Configure by Investment Resource View Rights 

Scope: itd Advanced Resource Planning, Allocations/Assignments by Investment 

ID (LOOKUP_CODE): check_res_view_right_for_util 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, the resource utilization histogram will display the utilization for any resource, role or 

team for which the user has at least the Resource – Soft Book right. 

> With this setting, the resource utilization histogram will only display the utilization for resources, 

roles and teams for which users have at least the Resource – View right. 
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9.12.11 Configure by Investment Resource View Popup Rights 

Scope: itd Advanced Resource Planning, Allocations/Assignments by Investment 

ID (LOOKUP_CODE): capacity_popup_with_soft_book 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, clicking on utilization histogram slices will only display team entries and investments 

for resources, roles and teams for which the user has at least the Resource – View right. 

> With this setting, clicking on utilization histogram slices will display team entries and investments 

for resources, roles and teams for which the user has at least the Resource – Soft Book right. 

> Depending on the resource_view_right_all_by_inv and resource_view_right_ass_by_inv settings, 

investment rights may apply for team entries of resources, roles and teams for which users have 

no resource rights, see sections 9.12.12 and 9.12.14. 

9.12.12 Configure Allocations by Investment View Resource Rights 

Scope: itd Advanced Resource Planning, Allocations by Investment 

ID (LOOKUP_CODE): resource_view_right_all_by_inv 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false OR remove elements from Description 

Possible Elements: (add both to apply to both modes) 

> SINGLE_INV: apply setting to single investment mode 

> ALL_INV: apply setting to multiple investment mode 

Effect: 

> By default, clicking on utilization histogram slices will display team entries for investments for 

which the user has at least the Investment – View right as well as team entries of any resource, 

role and team for which the user has at least the Resource –View/Soft Book right (see 9.12.11). 

> With this setting, clicking on utilization histogram slices in the Allocations by Investment view will 

only consider resource rights and ignore any additional investment rights. 

> The setting may be activated for single investment mode and multiple investment mode 

independently by adding either or both of SINGLE_INV and ALL_INV to the Description. 
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9.12.13 Configure Allocations by Resource View Rights  

Scope: 

> itd Advanced Resource Planning, Allocations by Resource 

> itd Allocation Editor, Allocations by Resource 

ID (LOOKUP_CODE): resource_view_right_all_by_res 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false OR remove elements from Description 

Possible Elements: (add both to apply to both modes) 

> SINGLE_INV: apply setting to single investment mode 

> ALL_INV: apply setting to multiple investment mode 

Effect: 

> By default, the Allocations by Resource view will display any resources, roles and teams with 

team entries for investments for which the user has the respective View right. 

> With this setting, any resources, roles and teams for which the user has the Resource – View 

right and their team entries will be displayed instead, ignoring investment rights. 

> The setting may be activated for single investment mode and multiple investment mode 

independently by adding either or both of SINGLE_INV and ALL_INV to the Description. 

9.12.14 Configure Assignments by Investment View Resource Rights 

Scope: itd Advanced Resource Planning, Assignments by Investment 

ID (LOOKUP_CODE): resource_view_right_ass_by_inv 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false OR remove elements from Description 

Possible Elements: (add both to apply to both modes) 

> SINGLE_INV: apply setting to single investment mode 

> ALL_INV: apply setting to multiple investment mode 

Effect: 

> By default, clicking on utilization histogram slices will display team entries for investments for 

which the user has at least the Investment – View right as well as team entries of any resource, 

role and team for which the user has at least the Resource –View/Soft Book right (see 9.12.11). 

> With this setting, clicking on utilization histogram slices in the Assignments by Investment view 

will only consider resource rights and ignore any additional investment rights. 

> The setting may be activated for single investment mode and multiple investment mode 

independently by adding either or both of SINGLE_INV and ALL_INV to the Description. 
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9.12.15 Configure Assignments by Resource View Rights 

Scope: itd Advanced Resource Planning, Assignments by Resource 

ID (LOOKUP_CODE): resource_view_right_ass_by_res 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false OR remove elements from Description 

Possible Elements: (add both to apply to both modes) 

> SINGLE_INV: apply setting to single investment mode 

> ALL_INV: apply setting to multiple investment mode 

Effect: 

> By default, the Assignments by Resource view will display any resources, roles and teams with 

team entries for investments for which the user has the respective View right. 

> With this setting, only resources, roles and teams for which the users has the Resource – View 

right will be displayed. In this case, the View right for associated investments is still required in 

addition to the Resource – View right. 

> The setting may be activated for single investment mode and multiple investment mode 

independently by adding either or both of SINGLE_INV and ALL_INV to the Description. 

9.12.16 Disable Resource List Links in Investments Modes 

Scope: itd Advanced Resource Planning, Allocations/Assignments by Investment 

ID (LOOKUP_CODE): disable_link_in_util_panel 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> With this setting, it is no longer possible to open the associated properties by clicking on a 

resource, role or team in the resource list. 

9.12.17 Include Sub-Roles in Role Capacity 

Scope: itd Advanced Resource Planning, Allocations by Investment/Resource 

ID (LOOKUP_CODE): calc_role_availability_option 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, the capacity of a role is calculated based only on associated resources. 

> Activating this lookup value adds the Role Capacity setting to the Utilization tab of the user 

preferences for the Allocations by Investment and Allocations by Resource view modes. 

> Any user can then enable the inclusion of sub-roles in the calculation of role capacities there. 

> The Role Capacity setting will be saved per user. 
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9.12.18 Show Total Role Capacity in Utilization Panel 

Scope: itd Advanced Resource Planning, Allocations by Investment 

ID (LOOKUP_CODE): raw_avail_in_utilization 

Initial Setting: deactivated with Lookup Value Name = 1 

Activate: Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> The utilization panel in Allocations by Investment mode shows the total capacity instead of the 

remaining capacity for roles (in non-histogram mode). 

> The total role capacity is the sum of total capacities of all resources with that primary role. 

> The remaining role capacity is the sum of remaining capacities of those resources. 

> The remaining capacity is calculated by subtracting all allocations (Allocation or Hard Allocation, 

depending on display value) of resources with that primary role as well as direct role allocations 

of that role from the total role capacity. 

> Colors are always based on the remaining capacity. 

> The histogram is not changed by this option. 

9.12.19 Disable Replacement Options 

Scope: itd Advanced Resource Planning, Allocations by Investment 

ID (LOOKUP_CODE): disable_replacement_option 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false (will apply default) OR remove elements from 

Description 

Possible Elements: (default: none) 

> TotalAvailability: Total Capacity 

> RemainingAvailability: Remaining Capacity 

Effect: 

> Deactivated replacement options are disabled when replacing allocations in Allocations by 

Investment mode, with a hint stating they have been deactivated by an administrator. 

9.12.20 Disable Role Allocation Replacement 

Scope: itd Advanced Resource Planning, Allocations by Investment 

ID (LOOKUP_CODE): disable_role_replacement_alloc 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> In Allocations by Investment mode, roles can no longer be replaced in an allocation via drag-and-

drop of other roles, resources or teams from the resource list. 
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9.12.21 Don't Replace Role With Remaining Capacity 

Scope: itd Advanced Resource Planning, Allocations by Investment 

ID (LOOKUP_CODE): keep_role_with_remain_avail_op 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> In Allocations by Investment mode, replacing a role with Remaining Capacity will no longer 

remove the role’s team entry. 

9.12.22 Consider Actuals for Remaining Capacity 

Scope: itd Advanced Resource Planning, Assignments by Investment/Resource 

ID (LOOKUP_CODE): consider_actuals_for_remaining 

Initial Setting: deactivated with Lookup Value Name = 1 

Activate: Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> When the histogram is displayed, actuals entered for a period will be added to the total Effort and 

subtracted from the Remaining capacity displayed for that period. 

> When the histogram isn't displayed, actuals entered for a period will only be subtracted from the 

remaining capacity displayed for that period, and won't be included in the utilization. 

> Example: 20 hrs actuals and 80 hrs ETC entered for a month with total capacity 160 hrs. 

• With this setting, the displayed Remaining capacity will be 60 hours. 

• Without this setting, the displayed Remaining capacity will be 80 hours. 

9.12.23 Filter Utilization by Custom Assignment Field in Assignments Modes 

Scope: itd Advanced Resource Planning, Assignments by Investment/Resource 

ID (LOOKUP_CODE): util_ass_curve_filter 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND Description = 

Attribute_ID: Lookup Value IDs (Attribute_ID must be a custom static string lookup assignment 

field, separate Lookup Value IDs by commas ",") 

Example: request_status: Approved, Booked 

Deactivate: Lookup Value Name = 0 OR Active = true OR remove Description 

Effects: 

> Assignments by Investment: the utilization displayed in the Resources list will be filtered. 

> Assignments by Resource: per resource, role and team, the total utilization will be displayed, but 

the utilization used to determine the remaining capacity displayed per resource will be filtered and 

a resource, role or team will be displayed as under- or overbooked based on the filtered utilization. 
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9.12.24 Editable Resource Types 

Scope: itd Advanced Resource Planning, Assignments by Investment/Resource 

ID (LOOKUP_CODE): editable_resource_types 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true AND add elements to 

Description, separated by commas "," 

Deactivate: Lookup Value Name = 0 OR Active = false (will apply default) OR remove elements from 

Description 

Possible Elements: (default: all) 

> labor 

> equipment 

> material 

> expense 

Effect: 

> ETC column and ETC in assignment grid only editable for resource types listed in Description 

9.12.25 Edit Start and Finish of Tasks and Assignments Regardless of Status 

Scope: itd Advanced Resource Planning, Assignments by Investment/Resource 

ID (LOOKUP_CODE): disable_status_check_for_edit 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, you can only change the Start and Finish of tasks and assignments with the Not 

started status. 

> With this setting, the status check will be disabled. The Start and Finish will still be locked for 

tasks and assignments with actuals. 

9.12.26 Hide Description Tooltips 

Scope: itd Advanced Resource Planning, Assignments by Investment/Resource 

ID (LOOKUP_CODE): hide_description_tooltip 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default, when hovering over an investment name in Assignments by Investment or 

Assignments by Resource views, the associated description will be displayed in a tooltip. 

> With this setting, these tooltips may be deactivated. 
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9.12.27 Keep Task Duration 

Scope: itd Advanced Resource Planning, Assignments by Investment 

ID (LOOKUP_CODE): default_keep_task_duration 

Initial Setting: active (lookup value doesn't exist) 

Activate: Lookup Value Name = 1 OR Active = false 

Deactivate: create lookup value with Lookup Value Name = 0 AND Active = true 

Effect: 

> This setting is active by default. In this case, changing the start date of a task or phase via the 

Start column will also change the Finish, retaining the duration of the task or phas. 

> Create a lookup value with Lookup Value Name = 0, ID = default_keep_task_duration and Active 

= true to deactivate, such that changing the start date of a task or phase won't change the finish. 

9.12.28 Automatically Create New Team Entries for Roles 

Scope: itd Advanced Resource Planning, Assignments by Investment 

ID (LOOKUP_CODE): auto_create_new_team_entry 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> By default (without this setting), dragging a role from the Assignment by Investment view's 

resource list on a project task or an NPIO which already has a team entry for that role will open a 

dialog allowing users to select an existing team entry or create a new one. 

> With this setting, a new team entry will always be created automatically for the role instead. 

9.12.29 Disable Role Replacement for Assignments 

Scope: itd Advanced Resource Planning, Assignments by Investment 

ID (LOOKUP_CODE): disable_role_replacement_ass 

Initial Setting: inactive (lookup value doesn't exist) 

Activate: create lookup value with Lookup Value Name = 1 AND Active = true 

Deactivate: Lookup Value Name = 0 OR Active = false 

Effect: 

> In Assignments by Investment mode, roles can no longer be replaced in an assignment via drag-

and-drop of other roles, resources or teams from the resource list. 

9.12.30 Updating itd Advanced Resource Planning 

After changing settings for itd Advanced Resource Planning via the itd AE Preferences lookup, you 

need to reset the cache to apply the new settings. 

This requires membership in the ARP Admin group. 

To do so, call the portlet with the &flushCaches=true URL parameter: 

> https://{ca.ppm.url}/niku/nu#action:pl.itd.ae.page.assignment.editor&flushCaches=true 

Please note that the parameter won't be passed to an embedded page in the Modern UI. 

You need to open the portlet in the Classic UI with the &flushCaches=true parameter to reset 

the cache. 
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9.13 itd AE Included Investment Types Lookup 
As of version 12.0.0, the installation package of itd Advanced Resource Planning now includes the  

itd AE Included Investment Types lookup. 

The ID (code) of this lookup is PL_ITD_AE_LKP_INCLUDED_INV_TYPES. 

Here you can filter selected view modes by investment type. Modes for which you define no filters 

won't be filtered by investment type. 

> Please note: This configuration works only for the global investment mode. It is neither 

implemented for the single investment mode nor the roadmap mode. 

9.13.1 Configuring Included Investment Types 

To configure an investment type filter, add a lookup value with the following field values: 

> ID equal to the Clarity object code of the investment type you want to include (usually the 

investment type name in lower case, e.g., "asset" for the Asset investment type). 

> Name has no effect other than being displayed in the lookup value list. 

> Description specifies all view modes to include the investment type and needs to be spelled 

exactly as follows, in capital letters: 

• ALLOCATION_BY_INVESTMENT_ASE 

• ALLOCATION_BY_RESOURCE_ASE 

• ASSIGNMENTS_BY_INVESTMENT 

• ASSIGNMENTS_BY_RESOURCE 

If you are specifying multiple view modes, you may choose any separator, such as a space or 

comma, as long as all required view modes are present in the correct spelling. 

> Active can be removed to disable a lookup value, as if it wasn't there. 

9.13.2 Example 

 

This configuration has the following effects on itd Advanced Resource Planning: 

> Allocations by Investment: No investment type filter. 

> Allocations by Resource: No investment type filter. 

> Assignments by Investment: Only Other Work and Asset investments included. 

> Assignments by Resource: Only Asset investments included.  

9.13.3 Filtering in Views 

If an investment type is configured for a specific view mode, the Investment Type filter is effectively 

prefilled with the configured investment types. However, this is not visualized in the Investment Type 

filter control, which can still be used to filter by the configured investment types. 
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9.13.4 Utilization 

The utilization that is calculated and displayed on the resource level isn't affected by the filter. 

Therefore, filtered out investments will still be displayed in the flyout when hovering over associated 

utilization segments in by Investment views. 

9.13.5 Updating itd Advanced Resource Planning 

After changing settings for itd Advanced Resource Planning via the itd AE Included Investment 

Types lookup, you need to reset the cache to apply the new settings. 

This requires membership in the ARP Admin group. 

To do so, call the portlet with the &flushCaches=true URL parameter: 

> https://{ca.ppm.url}/niku/nu#action:pl.itd.ae.page.assignment.editor&flushCaches=true 

Please note that the parameter won't be passed to an embedded page in the Modern UI. 

You need to open the portlet in the Classic UI with the &flushCaches=true parameter to reset 

the cache. 
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9.14 Governors Lookup (Limits and Caches) 
Some database access and memory usage settings may be managed via the governors lookup: 

> The governors lookup doesn't exist by default. To change associated settings, create a new 

lookup with ID (code) = PL_ITD_AE_LKP_GOVERNORS. 

> Starting with version 8.3 of the itd Advanced Resource Planning, this replaces the 

pl_itd_ae.properties file, which is no longer supported. 

> Creating and editing lookups requires the global Administration – Application Setup right, which 

Clarity PPM application administrators have by default. 

> This lookup is used for both itd Advanced Resource Planning and the itd Allocation Editor. Please 

note that not all lookup values apply to both applications. 

> Use the &flushCaches=true URL parameter to update the applications with changed settings 

(see section "9.14.4Updating itd Advanced Resource Planning" on page 174). 

The governors lookup can be used to control the amount of results returned by database queries, the 

amount of data contained in the applications' caches as well as load batch sizes with Calculate 

Sums set to On or Filtered. 

Similar to the preferences lookup, the settings controlled via the governors lookup need to be created 

as lookup values with the ID (code) set to the property name and the name set to the desired value 

(e.g. the resource limit can be shifted from the default value of 250 to 500 by creating a lookup value 

with ID (code) = query.limit.resources and name = 500). 

This section lists all settings controllable via the governors lookup and their defaults. 

9.14.1 Query Limits 

When Investments, Resources and Assignments are retrieved from the database, the query limits 

parameters can limit the number of records held in memory and returned to the client. 

These values may be controlled via the query.limit.* properties: 

query.limit.resources=250 

query.limit.investments=150 

query.limit.assignments=500 

9.14.2 Cache Sizing 

The server-side caching mechanism we use (Guava Caches) allows for the definition of the Cache's 

maximumSize(). 

You can edit these values via the cache.max.* properties: 

cache.max.clarity.system.attrs=1 [system attributes] 

cache.max.loading.pattern.lkp=1 [loading pattern lookup] 

cache.max.investment=10 [investments] 

cache.max.glob.rights.by.user=100 [global rights by user] 

cache.max.object.perm.by.user=40 [object permissions by user] 

cache.max.translation.cache=20 [translation cache] 

cache.max.preference.lkp=300 [preferences lookup] 

cache.max.calender=1 [calendar] 

cache.max.project.hpd.factor=1 [project hours per day factor] 

cache.max.custom.inv=1 [custom investments] 

Please note: Changing these values will not impact the amount of data loaded and used, only the 

amount of data that is cached for later use. Raising these values will take up more working memory. 

Lowering these values will result in reduced performance. 

https://github.com/google/guava/wiki/CachesExplained
http://google.github.io/guava/releases/snapshot/api/docs/com/google/common/cache/CacheBuilder.html#maximumSize(long)
http://google.github.io/guava/releases/snapshot/api/docs/com/google/common/cache/CacheBuilder.html#maximumSize(long)
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9.14.3 Load Batch Sizing 

With Calculate Sums set to On or Filtered in the General tab of the Preferences (see "Calculate 

Sums" on page 116), aggregated values will be calculated and displayed for all visible aggregation 

levels (task, phase, investment, resource/role/team). These data will be loaded from Clarity PPM 

curves. Curves will be loaded in batches to save heap space. 

You can configure the size of these batches. 

You can edit these values via the cache.max.batch.curve.* properties: 

cache.max.batch.curve.task=100 [tasks] 

cache.max.batch.curve.res=100 [resources] 

cache.max.batch.curve.inv.res=100 [investments per resource] 

cache.max.batch.curve.inv=100 [investments] 

Please consider the following when adjusting these numbers: 

> Lower values will cause more frequent requests to the database 

> Higher values will increase the amount of working memory used during these calculations.  

9.14.4 Updating itd Advanced Resource Planning 

After changing settings for itd Advanced Resource Planning via the governors lookup, you need to 

reset the cache to apply the new settings. 

This requires membership in the ARP Admin group. 

To do so, call the portlet with the &flushCaches=true URL parameter: 

> https://{ca.ppm.url}/niku/nu#action:pl.itd.ae.page.assignment.editor&flushCaches=true 

Please note that the parameter won't be passed to an embedded page in the Modern UI. 

You need to open the portlet in the Classic UI with the &flushCaches=true parameter to reset 

the cache. 
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9.15 Troubleshooting 
This section provides solutions for known issues with itd Advanced Resource Planning. 

9.15.1 Failed to load configuration with baseurl - error 403 – Forbidden 

Issue: any user trying to access itd Advanced Resource Planning, including system administrators, 

gets a "403 – Forbidden" error. 

 

Cause: reference to the pl_itd_ae component removed from the components.xml file. 

This may happen when a general patch is installed on the Clarity PPM server (not necessarily for the 

affected customer). 

Solution:  insert line <component id="pl_itd_ae" active="true" type="plugin"/> in 

components.xml file or reinstall the itd Advanced Resource Planning application. 

The latter is the only viable solution for SaaS systems. 


